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STONEX Reconstructor Manual
STONEX and Gexcel have developed and optimized the JRC 3D Reconstructor® software to perfectly
support the survey projects carried on with the Stonex X300 laser scanner.

JRC 3D Reconstructor® is a software to combine 3D information from different sensors, prepare
intermediate representations and extract information. The main advantage is the independency from a
specific sensor and the comprehensive amount of tools and features that enable easy extraction of
quality results in many fields: mining, surveying, construction, architecture, cultural heritage, forensics,
BIM, tunneling, etc.

1. JRC 3D Reconstructor® imports all the most used laser scanner formats in the market. The
workflow begins with the LineUp® Tool, an automatic and very robust wizard that easily allows you
to import, pre-process, and automatically register any amount of data with state-of-the-art speed
and precision. 

2. After that, your data are processed enough to easily extract results: basic measures and
notes, elevations and plans, cross sections, areas and volumes, geometrical check and change
detection, tunnel analyses, flythrough videos, and so on.

3. Furthermore, JRC 3D Reconstructor® has all the features needed to deliver more elaborated
results: tools for models positioning, editing of point clouds, fitting of geometric primitives, model
filtering and clustering, meshing, mesh editing, coloring with calibrated photos, etc.

Please click on one of the following sub-topics:
· Contents
· System Requirements
· Installation
· License Manager
· Disclaimer
· End User License Agreement

Contents
The present online help is organized as follows: 

i. An introduction about  the installation and the applying license procedures of the software 

ii. A Getting Started section to easily learn how to work with  JRC 3D Reconstructor®

iii. The main features of the user interface 

iv.  An explanation of the functionalities of  JRC 3D Reconstructor®, according to the voices in the menu. 
These are therefore the main chapters of this section:

· File
· Navigation
· Outputs
· Tools
· Windows
· Workspaces
· Help

Note: some commands are not available in all the  workspaces (pay attention to your license)!
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System requirements

System requirements - minimal

· OS: Windows (XP SP2, Vista, 7, 8, 10)

· Version: 32 bit

· Graphic card: NVIDIA GeForce with 512MB at least

· RAM: 4GB at least

System requirements - recommended

· OS: Windows (XP SP2, Vista, 7, 8, 10)

· Version: 64 bit

· CPU: multi-core processor (8 Cores at least)

· Graphic card:

o NVIDIA GeForce GTX with 2GB Ram (for a large use of points)

o NVIDIA Quadro (for a large use of mesh and texture)

· RAM: 16GB

JRC 3D Reconstructor® compiled for 32 bit processors can only address 4GB of RAM memory. For
medium/large size projects, we strongly recommend the 64 bit version. The graphics card must be at
least OpenGL 1.3 compliant with ARB_transpose_matrix, ARB_multitexture, ARB_pbuffer extensions.
Other extensions are automatically used if hardware support is found, resulting in better performance
and increased functionality.
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Installation
It's highly recommended both to deactivate all the Antivirus and Antispyware software and to keep closed

any JRC 3D Reconstructor® application before starting the installation. 

1. Run Reconstructor_3.2.1.xxx_win64.exe (the installation file, only given as an example) and follow the

steps.

2. Accept the License Agreement terms and follow the steps.

3. Select the components you want to install. Hardware drivers must be always installed!
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4. Choose Install Location (Default path is C:\Program Files\Gexcel\JRC 3D Reconstructor 3 (64 bit))

5. Choose Start Menu Folder and follow the steps.

Installation starting…..

See also Help → About JRC 3D Reconstructor® to find all the information about the license, expiration date

included.

Multi-licensing (USB licenses)
To activate the multi-seat licenses, you must install the software on all the computers to be used. The
computers can be positioned in different locations, but they must be connected to the same network
(same IP address and subnet mask).
Insert the USB key into one of the computers. Once opened JRC 3D Reconstructor® on a computer, the
license will be deducted from the multi-seat license.

License Manager 
Activation and updating software are performed in different ways, depending on the software license.
· SOFTWARE LICENSE (SL) - FIRST ACTIVATION
· SOFTWARE LICENSE (SL) - UPDATING
· USB LICENSE - ACTIVATION/UPDATING
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SOFTWARE LICENSE (SL) - FIRST ACTIVATION
Here it's possible to learn how to activate the software based license SL (on single computer) by

1. Generating a .c2v file (necessary to get the .v2c file from Gexcel)

2. Applying a .v2c file (necessary to activate your software license)

1. Open the software and select Help → License Manager in order to create a .c2v file.

Click on Create .c2v license file.

Click on Install new SL key.

Type the desired file name and Save the Fingerprint file (.c2v).

Send the .c2v file by e-mail to license@gexcel.it. It's highly suggested to send this file in a zipped

format.

1. Open the software and select Help → License Manager in order to apply a .v2c file.

Click on Apply .v2c license activation.

mailto:license@gexcel.it
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Select the .v2c file (received from license@gexcel.it) and Open it.

SOFTWARE LICENSE (SL) - UPDATING
Here it's possible to learn how to update the software based license SL (on single computer) by 

1. Generating a .c2v file (necessary to get the .v2c file from Gexcel)

2. Applying a .v2c file (necessary to update your software license)

1. Open the software and select Help → License Manager in order to create a .c2v file.

Click on Create .c2v license file.

Click on Update existing SL/HL key.

mailto:license@gexcel.it


Stonex Reconstructor 3

- 12 -

Open the drop-down menu to look at the accessible keys (activations) available on your computer.

Select the SL to update. 

Type the desired file name and Save the Fingerprint file (.c2v).

Send the .c2v file by e-mail to license@gexcel.it. It's highly suggested to send this file in a zipped

format.

2. Open the software and select Help → License Manager in order to apply a .v2c file.

Click on Apply .v2c license activation.

Select the .v2c file (received from license@gexcel.it) and Open it.

USB LICENSE - ACTIVATION/UPDATING
Here it's possible to learn how to activate/update an USB dongle (!) HL (with USB plugged in the computer)

by 

1. Generating a .c2v file (necessary to get the .v2c file from Gexcel)

2. Applying a .v2c file (necessary to activate your USB license)
(!) Pay attention: for USB dongles, the first activation and the updating follow the same procedure.

1. Open the software and select Help → License Manager in order to create a .c2v file.

mailto:license@gexcel.it
mailto:license@gexcel.it
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Click on Create .c2v license file.

Click on Update existing SL/HL key(!).

(!) Click here also for the first activation

Open the drop-down menu to look at the accessible keys (activations) available on your computer.

Select the HL (hardware license): it represents the USB dongle [remember to plug in the USB dongle
before starting the software].
Type the desired file name and Save the Fingerprint file (.c2v).
Send the .c2v file by e-mail to license@gexcel.it. It's highly suggested to send this file in a zipped
format.

2. Open the software and select Help → License Manager in order to apply a .v2c file.

Click on Apply .v2c license activation.

mailto:license@gexcel.it


Stonex Reconstructor 3

- 14 -

Select the .v2c file (received from license@gexcel.it) and Open it.

At the end of the license activation process, reboot JRC 3D Reconstructor®.  

Software Language
JRC 3D Reconstructor® supports the following languages: English (default), Italian, Chinese, Japanese,
Spanish. 
JRC 3D Reconstructor® automatically detects which language to use by looking at your operating system's
properties. If your language is not available, English setting is activated automatically. To change language
just modify the language setting of your computer. 

mailto:license@gexcel.it
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Disclaimer
All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic,

electronic, or mechanical, including photocopying, recording, taping, or information storage and retrieval

systems - without the written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks

of the respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author

assume no responsibility for errors or omissions, or for damages resulting from the use of information

contained in this document or from the use of programs and source code that may accompany it. In no

event shall the publisher and the author be liable for any loss of profit or any other commercial damage

caused or alleged to have been caused directly or indirectly by this document.

See also End User License Agreement.

End User License Agreement
IMPORTANT, READ CAREFULLY.
THIS END USER LICENSE AGREEMENT ("AGREEMENT") IS A LEGAL AGREEMENT BETWEEN YOU ("You", the
licensee, either an individual person or a single legal entity) AND GEXCEL SRL ("Gexcel") and applies to the
computer software with which this Agreement is provided, and includes any accompanying printed
materials and any "online" or electronic documentation ("Software"). This Agreement will also apply to any
Software error corrections, updates and upgrades subsequently furnished by Gexcel, unless such are
accompanied by different license terms and conditions which will govern their use.
BY CLICKING THE "I ACCEPT" BUTTON, OR BY INSTALLING, COPYING OR OTHERWISE USING THE
SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO
THE TERMS OF THIS AGREEMENT, YOU MAY NOT USE THIS SOFTWARE.
Gexcel may change the terms of this Agreement from time to time (and shall upload such updated terms
onto Gexcel website at www.gexcel.it). Your continued access to and use of the Software will be deemed
acceptance of the updated or amended terms. If you do not agree to the changes, you should cease using
the Software.
This Software is protected by copyright laws and international copyright treaties, as well as other
intellectual property laws and treaties. The Software is licensed, not sold.

1. SOFTWARE LICENSE.
1.1. License Grant. Subject to Your compliance with the terms of this Agreement, and any applicable
restrictions set forth on the Purchase Order, Gexcel grants You a non-exclusive, non-transferable license,
without right of sublicense, to install, use and display the Software in a machine-readable form solely for
Your internal purposes, and solely in connection with Your use of the Software. The Software installation is
provided on a digital media (CD, DVD) or as a downloadable file (ISO image or executable file) from the
Gexcel online repository, whose link is communicated by e-mail. You may reasonably copy the Software
to the extent necessary to enable Your permitted internal use of the Software, but You may not copy or
distribute the Software to any third parties.
1.2. Other Rights and Limitations. (1) The Software contains valuable trade secrets proprietary to Gexcel
and its suppliers or licensors. To the extent permitted by relevant law, You shall not, nor allow any third
party to modify, adapt, translate, prepare derivative works from, copy, decompile, disassemble or
otherwise reverse engineer the Software or any internal data files generated by the Software, or attempt
to do so, provided, however, that to the extent any applicable mandatory laws give You the right to
perform any of the aforementioned activities without Gexcel's consent, You hereby agree that, before
exercising any such rights, You shall first request such information from Gexcel in writing detailing the
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purpose for which You need the information. Only if and after Gexcel, at its sole discretion, partly or
completely denies Your request, may You exercise such statutory rights. (2) This Software is licensed as a
single product. You may not separate its component parts for use on more than one computer or device.
(3) You may not rent, lease, lend, or otherwise transfer rights to the Software or the use thereof to any
third party. (4) Concurrent use of the Software is not permitted if not included in the license type.
1.3. Ownership Notices. (1) All right, title and interest (including but not limited to copyright, patent, trade
secret and all other intellectual property and proprietary rights worldwide) in and to the Software
(including but not limited to any images, photographs, animations, video, and text incorporated into the
Software), the accompanying printed materials, and any copies of the Software are owned by Gexcel and
its suppliers or licensors. You shall not remove, cover or alter any of Gexcel's (or its designated suppliers'
and licensors') copyright, trademark or other proprietary notices placed upon, embedded in or displayed
by the Software or on its packaging and related materials. (2) You acknowledge that the Software is
designed to work with, and contains, certain third party software, including without limitation, certain
software licensed by its owners under open source software license (collectively, the "Third Party
Software"). Any Third Party Software, whether distributed with the Software or otherwise obtained by
You, is subject to the terms of the third party software license accompanying or otherwise applicable to
that Third Party Software ("Third Party License"). The terms of the applicable Third Party License will apply
to the Third Party Software independent of the terms of this Agreement. Nothing in this Agreement limits
Your rights under, or grants rights to You that supersede the terms of any applicable Third Party License.
1.4. U.S. Government Restricted Rights. The software and documentation are "commercial items" as that
term is defined at 48 C.F.R.2.101, consisting of "commercial computer software" and "commercial
computer software documentation" as such terms are used in 48 C.F.R. 12.212. Consistent with 48 C.F.R.
12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4, all U.S. Government end users acquire the
software and documentation with only those restricted rights as set forth herein.

2. TERM.
2.1. Effectiveness. "Effective Date" means the date upon which You purchase a license Key from Gexcel,
or issues to Gexcel a valid purchase order for a license Key. This Agreement is effective upon the Effective
Date or, in any event, upon Your installation of the Software and continues unless terminated by Section 8
below.
2.2. Software Activation. The Software activation is provided by software-based protection keys
("Software Key") or hardware-based protection keys ("USB Dongle Key"). Following the receipt by Gexcel
of the applicable Fees for the relevant license, Gexcel will issue to You a key to activate the Software for
the license (a "Key"). You will be responsible for installing the Key to activate the Software. The Key shall
be considered Confidential Information of Gexcel, as that term is defined herein. Gexcel shall provide
temporal activation depending to purchase and payment conditions.
2.3. Evaluation Term. You are granted a limited right to use the Software, in compliance with this
Agreement, free of charge for a period of evaluation commencing upon the date on which You install the
Software. For details about th evaluation time please contact sales@gexcel.it.Within the Evaluation Period,
the Software runs as fully functional Trial except for the ability in exporting items.

3. FEES AND PAYMENT.
3.1. Fees. In consideration for the rights granted hereunder, You shall pay all the license Fees to Gexcel in
the amounts set forth on the Purchase Order on or before the Effective Date specified on the Purchase
Order.
3.2. Terms of Payment. All payments are non-refundable (with an exception for any limited money-back
guarantees that are specified in writing or on the Gexcel website, www.gexcel.it, at the time of purchase
of a license.) You shall be responsible for all sales taxes, use taxes, withholding taxes, value added taxes
and any other similar taxes imposed by any federal, state, provincial or local governmental entity on the
transactions contemplated by this Agreement, excluding taxes based upon Gexcel's net income. When
Gexcel has the legal obligation to pay or collect such taxes, the appropriate amount shall be invoiced to
and paid by You unless You provide Gexcel with a valid tax exemption certificate authorized by the
appropriate taxing authority.
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4. SOFTWARE MAINTENANCE.
4.1. Software Maintenance Services. During the maintenance term and subject to the terms and
conditions hereafter specified, Gexcel shall provide Software Maintenance Services, including both
technical support services and software releases. (1) Technical Support Service is provided through e-mail
Address: support@gexcel.it. (2) As part of its maintenance services, Gexcel may provide periodic Software
Releases, including Updates (generally available releases of Software that provide Bug Fixes, Error
Corrections and Enhancements designated minor by Gexcel) and Upgrades (generally available releases
of Software that provide enhancements designated major by Gexcel as well as minor new Enhancements
and Error Corrections). Available Software releases, periodically issued by Gexcel, may either be
downloaded from Gexcel's web site (www.gexcel.it) or delivered on digital support upon written request
to Gexcel.
4.2. Software Maintenance Limitations. (1) Gexcel shall have no obligation to provide Releases or Support
for the Software except as set forth hereafter. Gexcel shall not have any responsibility to develop
subsequent components for the Software or additional processes for You, except as explicitly set forth
herein. (2) Gexcel shall have no obligation to fix errors in the Software within a specific time duration.
Gexcel will use commercially reasonable best efforts to fix bugs and other Software defects (but not
including viruses or other defects not inherent in the Software when delivered By Gexcel) in a timely
manner during its normal business hours and upon reasonable notice, other than any bugs or defects
caused by unauthorized use or modification of the Software, accident, abuse, misuse or misapplication of
the Software or the magnetic or electronic media containing the Software. (3) You acknowledge that
Gexcel, after using all reasonable efforts, may not be able to resolve an Error and that such inability shall
not be considered a breach or event of default under this Agreement, nor be the cause of any liability to
Gexcel. In the event that Gexcel notifies to You its inability in fixing an Error in the Software, You may at
your option and as your sole and exclusive remedy, terminate the Software Maintenance for the
applicable Software. Upon such termination, neither party shall have any obligation or liability to the other
in connection with such Software Maintenance. (4) Gexcel shall have no obligation to fix Errors in any
version of the Software other than the latest official release. (5) Your rights and obligations concerning the
use of any Releases (Error Corrections, Enhancements, or any other programming provided by Gexcel
relating to the Software) shall be as provided under this End User License Agreement. (6) Maintenance
Services do not include: (a) development of custom computer programs, (b) repairs or service relating to
any Third Party Software or hardware, or (c) hardware modifications or changes to existing hardware
configurations, outside the scope of warranty support. (7) Gexcel may, at its discretion, upon notice to You
and with no additional charge, make modifications to the Software. Such modifications shall not jeopardize
the basic functionality of the Software or invalidate this Agreement.
4.3. USB Dongle Key and Software Key Replacement. (1) For USB Dongle activation, within a period of ten
(10) days from the date of acquisition, Gexcel warrants that the USB Dongle Key will be free from defects
in materials and faulty workmanship under normal use and service. If a defect in the USB Dongle Key
should occur during such 10 days period, the USB Dongle Key may be returned to Gexcel who will replace
the USB Dongle Key without any charge for You, provided that the You have properly used the USB
Dongle. After this period and if the failure of the USB Dongle Key has resulted from unauthorized use,
accident, abuse, misuse or misapplication of the USB Dongle Key, You shall return to Gexcel the damaged
dongle and pay to Gexcel a Replacement Fee of 250,00 Euro (delivery charges excluded), as advised by
Gexcel. In case of USB Dongle Key loss, or stolen, You shall provide Gexcel with a written and signed
declaration, contact Gexcel at sales@gexcel.it and pay to Gexcel 80% of the software price for a new
Dongle Key.(2) The Software Key may be activated on a single computer system. In case of damages
occurred to the installation computer system that do compromise the installed Software Key, You shall
provide Gexcel with a written and signed declaration, contact Gexcel at sales@gexcel.it and pay to Gexcel
80% of the software price for a new Dongle Key.
4.4. Software Maintenance Term. The Software Maintenance Services provided under this Agreement
shall run from the date of First License Activation for a time period of twelve (12) months or until the term
in years for which the Maintenance Services have been purchased by You.
4.5. Software Maintenance Fee. The first Software Maintenance period of twelve (12) months after the
First License Activation is available at a price included in the Software License Fee. The Renewal of
Software Maintenance for the subsequent twelve (12) months may be available at a Renewal Fee of 15%
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of the full price of the purchased Software License, unless otherwise advised by Gexcel.

5. NO WARRANTIES.
THE SOFTWARE IS BEING DELIVERED TO YOU "AS IS" AND GEXCEL MAKES NO WARRANTY AS TO ITS USE
OR PERFORMANCE. GEXCEL AND ITS SUPPLIERS AND LICENSORS DO NOT WARRANT THE PERFORMANCE
OR RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE. YOU ASSUME THE ENTIRE RISK AS TO RESULTS
AND PERFORMANCE OF THE SOFTWARE. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
GEXCEL AND ITS SUPPLIERS AND LICENSORS DISCLAIM ALL WARRANTIES, TERMS, AND CONDITIONS,
EITHER EXPRESS OR IMPLIED, BY STATUTE, COMMON LAW OR OTHERWISE, INCLUDING BUT NOT LIMITED
TO, IMPLIED WARRANTIES, TERMS, AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, TITLE, AND NONINFRINGEMENT WITH REGARD TO THE SOFTWARE, ITS
SATISFACTORY QUALITY, AND THE PROVISION OF OR FAILURE TO PROVIDE MAINTENANCE SERVICES.
GEXCEL IS NOT RESPONSIBLE FOR THE OPERATION OR FAILURE OF OPERATION OF THE LASER SCANNER
OR ANY OTHER HARDWARE INCLUDED WITH OR RELATED TO THE INSTALLATION.

6. LIMITATION OF LIABILITY.
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL GEXCEL OR ITS
SUPPLIERS OR LICENSORS BE LIABLE FOR ANY LOST PROFITS OR COSTS OF PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES, OR FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL OR
PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY (INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF
BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS), ARISING OUT OF THE USE OR INABILITY TO
USE THE SOFTWARE, OR THE PROVISION OF OR FAILURE TO PROVIDE MAINTENANCE SERVICES, EVEN IF
GEXCEL OR AN AUTHORISED GEXCEL'S REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES, AND NOTWITHSTANDING ANY FAILURE OF ESSENTIAL PURPOSE OF ANY EXCLUSIVE
REMEDY PROVIDED IN THIS AGREEMENT.
IN NO EVENT SHALL GEXCEL'S TOTAL LIABILITY IN CONNECTION WITH THIS AGREEMENT AND THE
SOFTWARE, WHETHER BASED ON CONTRACT, WARRANTY, TORT (INCLUDING NEGLIGENCE), STRICT
LIABILITY OR OTHERWISE, EXCEED THE AMOUNT PAID TO GEXCEL FOR USE OF THE SOFTWARE GIVING
RISE TO THE CLAIM, IF ANY. BECAUSE SOME STATES AND JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE
LIMITATION MAY NOT APPLY TO YOU.
GEXCEL SHALL HAVE NO LIABILITY TO YOU FOR ACTUAL DAMAGES FOR ANY CAUSE WHATSOEVER,
REGARDLESS OF THE FORM OF THE ACTION.

7. CONFIDENTIALITY.
The term "Confidential Information" shall mean any information disclosed by either party (the "Disclosing
Party") to the other party (the "Receiving Party") in connection with this EULA which is disclosed in writing,
orally or by inspection and is identified as "Confidential" or "Proprietary." Notwithstanding the foregoing,
the following is "Confidential Information" of Gexcel: (a) any information, in whatever form, disclosed by
Gexcel that relates to the Software and that is not publicly known; (b) any benchmark tests pertaining to
the Software; and the Software license Key provided by Gexcel to You hereunder. The Receiving Party
shall treat as confidential all Confidential Information received from the Disclosing Party, shall not use
such Confidential Information except as expressly permitted under this Agreement, and shall not disclose
such Confidential Information to any third party without the Disclosing Party's prior written consent. The
Receiving Party shall use the same degree of care to protect the Confidential Information of the
Disclosing Party against unauthorized use or disclosure that it takes with its own confidential information
of like nature, but in no event less than a reasonable degree of care. Notwithstanding the above, the
restrictions of this Section shall not apply to information that: (a) was independently developed by the
Receiving Party without any use of the Confidential Information of the Disclosing Party; (b) becomes
known to the Receiving Party, without restriction, from a third party without breach of this Agreement and
who had a right to disclose it; (c) was in the public domain at the time it was disclosed or becomes in the
public domain through no act or omission of the Receiving Party; or (d) was rightfully known to the
Receiving Party, without restriction, at the time of disclosure. Without terminating any restrictions or
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obligations of this Section, a Receiving Party is not prohibited hereunder from disclosing Confidential
Information of the other party if such information is disclosed pursuant to the valid order or requirement
of a court, administrative agency, or other governmental body of competent jurisdiction; provided,
however, that the disclosure is strictly limited to the extent necessary to comply with such order and,
provided further that, the Receiving Party shall provide prompt notice thereof to the Disclosing Party and
shall use commercially reasonable efforts to obtain a protective order or otherwise prevent public
disclosure of such information.

8. TERMINATION.
This Agreement is effective until terminated. Without prejudice as to any other of its rights, Gexcel may
terminate this Agreement immediately and without notice if You breach any provision of this Agreement
or of any other agreement between You and Gexcel. Upon termination or expiration of this Agreement:
(a) any fees owed to Gexcel under this Agreement before such termination or expiration will be
immediately due and payable; (b) all licenses granted to You in this Agreement will immediately cease;
and (c) You must promptly discontinue all use of the Software, uninstall and erase all copies of the
Software from Your computers, and return or, at the option of Gexcel, destroy all copies of the Software
in Your possession or control. Sections 1.3, 1.4, 4, 5, 6, 7, 8 and 9 will survive termination or expiration of
this Agreement for any reason.

9. EXPORT RESTRICTIONS.
You shall not export, directly or indirectly, the Software (or any component part or output thereof) to any
country in violation of any law or regulation, including without limitation any law or regulation of the U.S.
Government or any agency. You are solely responsible for complying with all applicable export and import
regulations and obtaining all necessary export and import licenses or permits for the Software. You agree
to defend, indemnify and hold Gexcel harmless against any liability (including attorneys' fees) arising out
of Your failure to comply with the terms of this paragraph.

10. USE OF CUSTOMER'S NAME.
You acknowledge that Gexcel may use Your company name on Gexcel's customer list provided to third
parties.

11. GENERAL.
This Agreement shall be governed by the laws of Italy without regard to conflicts of law principles. The
Courts of Italy will have exclusive jurisdiction over any disputes arising under this Agreement and the
parties hereby irrevocably consent to the personal jurisdiction of such courts. In the event any proceeding
or lawsuit is brought by the parties in connection with this Agreement, the prevailing party in such
proceeding or lawsuit will be entitled to receive its costs and reasonable attorneys' fees. If any provision
of this Agreement is held to be unenforceable, that provision will be modified so as to be enforceable, or
if such modification is not possible, will be removed and the remaining provisions will remain in full force.
No failure or delay by either party in exercising any right, power, or remedy under this Agreement, except
as specifically provided herein, shall operate as a waiver of any such right, power or remedy. Without
limiting the foregoing, terms and conditions on any purchase orders or similar materials submitted by You
to Gexcel shall be of no force or effect. Neither this Agreement nor any rights or Your obligations under
this Agreement may be assigned by You in whole or in part without the prior written consent of Gexcel
(except in connection with a merger or acquisition, or the sale of all or substantially all of such party's
assets), and any attempted assignment or transfer by You in violation of the foregoing will be null and
void. This Agreement, is the complete and exclusive statement of the agreement between the parties
and supersedes any proposal or prior agreement, oral or written, and any other communications
between the parties in relation to the subject matter of this Agreement. The parties agree that the United
Nations Convention on Contracts for the International Sale of Goods is specifically excluded from
application to this Agreement. This Agreement is in the English language only, which language will be
controlling in all respects.

(C) 2014 Gexcel srl. All rights reserved.
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Getting Started
The aim of this section is to suggest a simply and fast workflow to work with JRC 3D Reconstructor®.
First you need to create a New project or Open an existing project.
Each project has its own folder called with the same name. JRC 3D Reconstructor® projects contains at
least some of the following subfolders: Imports/ Exports/ Unstructs/ Grids/ Meshes/ Polylines/ Trash/
Images/ Movies/. These folders are automatically created when the project gets populated.
Then, starting  from importing, preprocessing, registering and georeferencing steps you can navigate
through point clouds editing, meshing, coloring tools until the main features extraction.

The main Workflow 

Most of the operations in the first part of the main

workflow can be performed in LineUp® environment. 

What's LineUp®?
LineUp® is a tool in JRC 3D Reconstructor® that easily allows you to:
· Import 
· Preprocess
· Register 
· Georeference 
any set of points clouds (both unstructured and structured -grid- point clouds).

Note that you can also register and georeference not only point clouds but also 3D mesh models.

See at the below voices for all just mentioned processes:
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1. Import
2. Register
3. Georeference
4. Edit Point Clouds
5. Create&Edit Meshes
6. Photo&Color
7. Main features extraction (analysis tools)

Import
To quickly import data, just drag and drop the files you want to import anywhere in the 3D scene. A wizard
will appear to ask you for import options, depending on kink of data. 

a. If you're importing a point cloud the LineUp® Tool will be opened.
b. If you're importing a different file format (as meshes, polylines, etc…) a wizard window will appear to
guide you through importing steps.

a. Importing Point Clouds…& Preprocessing
· If you're opening one or more

point clouds by drag&drop (or

by Import command) a
LineUp® Scan Processing
Wizard will appear.

You can follow its instructions step by step, in order to import raw data and to preprocess the scans. 

Note: it's also possible to register (both preregistration and fine registration) the imported point clouds
using the same wizard.

Clicking on More Settings button a LineUp Settings Dialog will appear.



Stonex Reconstructor 3

- 23 -

In this phase you have to pay attention to Importing and Preprocessing folders:

You have simply  to choose the subsampling rate.
 Depending on your data format you can evaluate
several import options, as color or multi echoes. 

Start
LEVEL

You have only to identify your data
import format (look at your sensor)
and use the default parameters to
preprocess (clean and filter) the
scans. 

Advanced
LEVEL

Depending on your data format
and on your survey you can
evaluate several options.

· After closing this setting dialog click on Next and then on Process button.
· The Stonex Data Importer window help you to colorize your scans during importation.

b. Importing “Other Formats”
· If you're opening one or more of these objects:

o Triangle meshes
o Polyline/trajectory
o CAD Models

a specific recipe window will guide you in the importing step (advanced settings are used for IFC files).

· If you're opening a
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Reconstructor project

all the scans inside it (and other items, as in JRC 3D Reconstructor® projects) will be loaded in your current
project.

At the end of both of these import phases, your models will be loaded in your project and saved in JRC 3D
Reconstructor® internal format.

See details in Import section.

See Register step to know how align the scans.

Register
The LineUp® tool includes a comprehensive suite of tools for coarse and fine registration of any amount
of scans (and not only). The registration process is composed by several steps, depending on adopted
survey techniques.

The general flow, here illustrated

starts from a  preregistration step that allows you to compute a rough alignment between the imported
models. The alignment can be later refined using ICP registration and Bundle Adjustment to choose and
refine the good ICPs and discard the wrong ones, in order to reduce the global registration error. 

Start
LEVEL

You can simply use the Scan
Processing Wizard (also
simultaneously with the import
phase) and check all the steps,
using default parameters.

Advan
ced

LEVEL

You can manage the registration
parameters for your purpose in
the LineUp Setting Dialog or you can
separately carry out the processes
(with Register commands in the
LineUp® main window). 
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In the following paragraph several customized workflows are illustrated. The user can choose the way,
depending both on survey techniques adopted and on desired output accuracy. Then the main processes
(algorithms) are briefly illustrated.

WF
1

After importation of a pre-registered project

If you pre-registered your scans with a third part software (as the owner laser scan) you can
import the just aligned scans and simply make a fine registration, in order to further reduce the
registration error. 

WF
2

Automatic registration without targets (only with LineUp® Pro)
If you made a survey not using targets or markers, with a good overlapping (the minimum
overlap of two scans is 20-30% of their surface), the automatic preregistration algorithm permits
you to register all the point clouds you want. 
Then you can decide if you want only to make a cloud to cloud registration 

or also a bundle adjustment

WF
3

Automatic registration using targets
If you made a survey using Gexcel's targets, a special function
automatically register a set of scans by detecting and matching
targets. 

Then you can decide if you want only to make a cloud to cloud
registration 

or also a bundle adjustment
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WF
4

Automatic preregistration failed? Make a manual preregistration
If you don't achieve a good error of alignment using automatic techniques, the manual
registration helps you to align two scans (or two generic models) by finding 3 couples of
corresponding points among the models.  
Then you can decide if you want only to make a cloud to cloud registration 

or also a bundle adjustment

You can also choose to follow an alignment per groups procedure.

See in the following links how to implement: 
1. Preregistration
2. Fine registration

See Georeference step to know how georeference the registered models.

1. Preregistration
1a. Automatic Preregistration

Target-free (only in LineUp® Pro)

This function is a very effective and fast procedure that preregisters a set of scans automatically,
without using targets or markers.
Target-based

This function automatically registers a set of scans by detecting and matching targets. The user can
start the automatic target detection, otherwise can manually add, move and remove targets.

1b. Manual Preregistration (among models)

This function allows you to manually compute a rough alignment between two generic models. The
procedure works by finding three couples of corresponding points among the reference and
moving models.
A particular case of this command is the registration between two  grid point clouds (see Manual
Pre-registration among grid point clouds). If needed, you can register one moving grid to more
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reference grids.

Note: in the preregistration
process there's a possibility to
use a sketch to aid the
computation, suggesting the
relative position of the scans
(see Sketch Window)

2. Fine registration

2a. ICP Registration (cloud to cloud)
ICP Registration is an algorithm to automatically perform fine registration of a moving point cloud
against one or more reference clouds. The moving cloud must be roughly close to the reference
cloud.

2b. Bundle Adjustment
This algorithm allows to register many point clouds, distributing evenly the registration error. The
user specifies which point clouds are reference clouds (they are locked during the registration) and
which are moving; the moving clouds will move and align on the reference clouds and between
them during alignment.

At the end of the processes you should see your scans well aligned.

Georeference
The LineUp® tool includes a procedure to geo-reference the imported point clouds: 

Georefe
rence

Point clouds georeferencing

Pick reference points

This process allows you to georeference multiple scans using both targets (or other points) and the
centers of the scans (if geo-referred).
You can georeference one or more scans by selecting at least 3 points from different scans, known also in
another reference system (for example from topography). In the same way a georeferentiation of 
generic 3D models (i.e mesh models from BIM) is possible (see 3D Model georeferencing).
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These steps will be illustrated in the following:
1. Reference points selection
2. Scans georeferencing
3. 3D Model georeferencing

1. Reference points selection 
When you select the Point clouds georeferencing command and at least one point cloud (grid or
unstructured) the Reference points Selection window appears. This dialog allows the selection of multiple
reference points from the point clouds target and center points. Target points can be automatically or
manually set using the targets registration dialog or targets editor dialog.

Note
To pick reference points on the point clouds in the project - if you haven't yet made it -  you can use the
command:

Pick reference points

The reference points taken with this procedure will be automatically loaded in the Reference Point
Selection.
 See all the details in Target-based pre-registration.
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2. Scans geo-referencing
After the reference points selection, using Georeferencing from point list dialog allows you to load external
reference points for geo-referencing scans using previous selected target points (or georeferenced scan
centers). 

The Compute Registration command automatically finds the best matching points from the right and left
lists and computes the alignment between them. 

3. 3D Model georeferencing

Using the Tools-> Pose&Registration -> Point list registration command in JRC 3D Reconstructor®

environment, you can register a list of points, named moving points, against another list of points that you
consider as reference (these last points can be geo-referenced). So you can take some points on the model
and register it using geo-referenced coordinates of the same points.

Here the process:
· Moving points (in the left half of the dialog):  you can load a text file with listed points or you can

copy the points listed in the project 
· Reference points: (in the right  half of the dialog): you can load the reference points from a text file
· press Compute  to register the points by coupling them. A dialog appears, asking whether you want

to register the points by coupling them according to their labels, or by trying out all the possible pair
combinations to find the best. The first option is much faster but it assumes that you are sure about
how to match your points. After you have selected either Match names or Best fit, you can refine
and make use of the results of the registration, in the Registration report dialog.
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Note: to start the registration, the left table has to contain as many points as the right table.

It's suggested to save the scans position before to move them in the 3D space, so it will be easy to recover
the previous position in case of a bad displacement or alignment (see also Restore a Pose).

Edit Point Clouds
In this section you can learn how to manage the point clouds to obtain a better use of the extractable
information.

The two main operations that you can apply on the point clouds are:
1. Point filtering and clustering
2. Selection and Fitting

1. Points Filtering and Clustering
This category of tools includes functions dedicated to work with point clouds, to enable other processes
and further results. Most of these tools work on any point clouds, some of them work only on grid point
clouds.
You can access to these procedures by the Tools-> Points Filtering & Clustering command or by the point
cloud contextual menu.
The filtering tools include also the point cloud Pre-process filters: JRC 3D Reconstructor® applies  a set of
algorithms to the scans which extract information that is needed during further processing of the data.
You can access this command through the point clouds contextual menu,   the Tools->Point
Filtering&Clustering  command and  LineUp Setting Dialog -> Pre-processing dialog.
All the other commands can be activate through the point clouds contextual menu or  the Tools->Point
Filtering&Clustering  command.

Processes
On

Grid

Point Clouds

On

Unstructured

Point Clouds

Filtering

Pre-process
clouds

· Noise Removal (Range &
Reflectance Gate, Outlier
Removal, Median Filter, Mixed
Point Filter)

· Compute Normals
· Edge Detection (Depth &

Orientation Discontinuity)
· Compute Confidence

ü
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· Noise Removal (Outlier Removal)
· Compute Normals
· Compute Confidence

ü
Restore raw
data

To undo any operation
of preprocessing, deletion and editing
that may have been performed on the
clouds.

ü ü

Restore deleted
points  

To undelete all the points earlier
deleted. ü ü

Edit 2D  A grid point cloud is shown in its 2D
representation. Here you can select,
delete and undelete points with several
functions.

ü

Fill holes  To replace any invalid point in the cloud
with a value averaged from the point's
neighbourhood in the cloud's structure.

ü
Hide black
points

To invalidate all the points in the cloud
that are colored in full black.  ü ü

Remove
duplicated
points

To invalidate any point that has exactly
the same coordinates of another point
in the cloud.

ü ü

Resample To resample a point cloud, subsampling
it. ü ü

Simplify points  To determine the most relevant points
from a point of view of shape
description, and save them into the
new unstructured point cloud. These
resulting clouds work as compact
representations of the original
structured ones.

ü

Extract edges  To extract the edges of a grid point
cloud, in form of polylines. ü

Level 3D density
of clouds

To cluster clouds excluding duplicated
or unneeded points. The resulting
cloud, however, will not contain all
points from the input clouds, but only
those needed to guarantee a fixed 3D
density of the points.

ü ü

Clustering Level 3D density
of clouds

To cluster clouds excluding duplicated
or unneeded points. The resulting
cloud, however, will not contain all
points from the input clouds, but only
those needed to guarantee a fixed 3D
density of the points.

ü ü

Make single
cloud

To lump together in an unstructured
point cloud an arbitrary set of point
clouds.

ü ü
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Virtual scan To resample the scene and generate a
new clustered grid point cloud. ü ü

See Point Filtering & Clustering for details.

2. Selection and fitting tools
This set of tools allows you to:

Selection Select a point clouds portion (to delete or
sample it)

Make a Point selection with polyline

Sample to new cloud starting from a Selection

Fitting Fit a plane from a selection of points

Fit a cylinder from a selection of points

Fit a sphere from a selection of points

Create & Edit Meshes
A triangle mesh is a 3D model represented by a set of triangles connected by common edges and
common vertices. A triangle mesh therefore defines a surface in the 3D space. 

In this section an overview of the techniques to create and edit meshes will be presented:
1. Creating meshes
2. Editing meshes 

1. Creating meshes

JRC 3D Reconstructor® provides 4 typologies of mesh techniques. Different number and type of point
clouds can be used as a basis to create a mesh, depending on the meshing technique:

On
Grid

Point Clouds

On
Unstructure

d Point
Clouds

Suggested for…

Multiresolution Mesh
Fast meshing technique that give back light
meshes that may have holes in some
situations.

ü
(one or
more)

To obtain a well
defined and fast

mesh from a single
structured point

cloud, with a good
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quality/
computational time

ratio
Mesh from predefined view
Relatively slow meshing technique that gives
back convex meshes without holes. It's a view
dependent, high defined  mesh (each point is
a vertex)

ü
(one)

ü
(one –

single or
clustered

point
cloud)

Useful for façades
(using orthocamera)
and tunneling (using
cylindrical camera)

3D Mesh
Approximative 3D meshing not view-
dependent and taking as constraints the
points' positions and orientations (normals)

ü
(one)

ü
(one –

single or
clustered

point
cloud)

Useful for convex
surfaces. 

Topographic Mesh
Fast meshing algorithm designed for DTM
models. It gives back a watertight, light,
smoothed mesh useful for isolines and
volumes calculation.

ü
(one or
more)

ü
(one or
more)

Useful for land
survey and mining

These commands are achievable from Tools→Meshing, from Mesh tools in the top toolbar or from the
context menu of point clouds.

2. Editing meshes
JRC 3D Reconstructor® provides several functions for editing meshes.

In Tools→Meshing and/or in the meshes' contextual menu (right mouse button click) you find all the
commands able to manage and edit meshes:

Mesh Editor An editing environment to perform advanced operations such
as hole-filling, borders detection, editing triangles and vertexes,
smoothing surfaces, decimating, ridges and valleys extraction.

Mesh selection from
current view point

To cut a portion of a mesh using 2D video selection tools on the
current view.

Mesh selection  with 3D
polyline

To cut a portion of a mesh using an input mesh, a 3D polyline
and a viewpoint

Make single mesh… This dialog allows to lump together in a single mesh an arbitrary
set of triangle meshes

Convert to point cloud To create an unstructured point cloud from the vertexes of the
mesh using the color attribute of the mesh

Get mesh borders as polyline To create a new polyline containing the mesh's borders and add
it to the project

Compute normals To compute or update the triangles' normals for the mesh.
Invert winding This command inverts the ordering of the vertexes for each

triangle, so the surface is flipped to the opposite side and also
the normals are inverted.

Compute area This command returns the mesh area as sum of the areas of all
the mesh's triangles

Compute volume from Z=0 plane This command returns the volume resulting from integrating
the mesh on the XY plane of the current UCS. Mesh triangles
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below the XY plane will result in zero volume 

See the above linked voices for more details.

Photo & Color
JRC 3D Reconstructor® provides several coloring tools to effectively manage the colorization of point
clouds and meshes. 
These tools can be classified according to the objects you want to color and the procedures you need to
apply: 

· Some color information is item intrinsic of point clouds and saved as a color layer (see 1.Colors
mapping). 

The coloring tools are accessible from the Tools->Photo&Color  menu or from the point clouds' contextual
menu Photo&Color. See also Photo and Color in the Top Toolbar.

To look at point clouds' color layers, select the point
cloud from the project window and set the Color Mapped
option in the Property Browser. 

See also our video tutorials on point clouds coloring. 

1. Colors mapping
The following commands help the user to manage the color layers of point clouds:

Histogram To optimize the point clouds color's contrast by histogram
stretching

Colors mapping To create an artificial colorization for a given color layer of
a point cloud. Color information can be scalar (e.g.
reflectance, range, confidence) or vectorial (e.g. inclination).
It's also possible to add layers from external images.

Color with altitudes To add to the selected point cloud(s) an extra color layer,
representing the altitude of the points with respect to one
of the tree axes of the current UCS. 

Inclination from plane To add to the point selected cloud(s) an extra color layer,
representing the inclination of the points' normals with
respect to a given plane that exists in the project. 
Suggestion: use it to classify points for a further vegetation
removal.

https://www.youtube.com/watch?v=aDrWCg9SoNk&index=12&list=PL3PJ9b9USDYR0kkBSWne8p1oBeodi4req


Stonex Reconstructor 3

- 35 -

2. Camera calibration, color point clouds & meshes
Among the coloring tools, there are some dedicated to colors related to photos:

Create Projector To create a Perspective, Orthographic, Spherical , Cylindrical
projector or from a calibration (by importing a camera
calibration file) using a valid image.

Import georeferenced tif This function imports a geo-referenced TIFF as
an orthographic camera. 

Main features extraction
Until here you imported, preprocessed, registered and georeferenced your scans, created meshes… to
obtain your  3D model.
And now?
Which kind of data you can extract from JRC 3D Reconstructor®? 
How you can export them?

Measures & notes

Area&Volume

To take annotations and measures as:
· Distances (linear and angular) 
· Area
· Volume
· Compute cut&fill volume

Elevation&Plans

(Orthophotos)

To create:
· Orthophoto
· Cameras
· Virtual scan

Cross Sections To create planes and extract single or multiple cross sections

Inspections To create an artificial colorization for a given color layer of a point
cloud. Color information can be scalar (e.g. reflectance, range,
confidence) or vectorial (e.g. inclination). 
· Analysis deviation
· Planarity&verticality maps

Tunneling

Videos & snapshots

See Outputs menu.
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User Interface Layout
The JRC 3D Reconstructor®'s interface is simple and user-friendly, so most of the main commands are  in 
the ribbon Top Toolbar.

The user interface is composed by:

· The menu bar on the uppermost part of the window: contains all the command and software
functions

· The Top Toolbar with shortcuts to the most useful and relevant commands (for each workflow); it's
composed of hoverable buttons, just hover with the mouse on any icon of the top toolbar, and the
commands of that category will pop down for you to activate. The top toolbar changes when the user
changes the current workspace

· The main rendering window
· The project window (dockable), which lists the objects that make the 3D scene (imported or created

during the processing)
· The property editor (dockable), which allows to view and edit the properties of the selected objects
· Other dockable windows

Furthermore, by right-clicking on an item in the project window, a contextual menu is displayed where
only the commands that apply to the given item type are shown. Commands can therefore also be issued
from that context menu: this is useful in particular to load/unload a model, to set an hyperlink to an item
or to open the hyperlink, to move the item to another group in the project.

Workspaces
A workspace is a particular configuration of JRC 3D Reconstructor®'s interface, aimed at satisfying a
particular workflow. In this way, top toolbar and dockable windows are reorganized by showing only the
functions useful for particular tasks and in a meaningful order and place.
Here you can compare the different workspaces, taking in account the main procedures and tools.  

http://gexcel.it/en/software/jrc-3d-reconstructor/full-full-educational/comparative-table
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Workspace Main features

Viewer To only navigate the project (and the objects inside it) and take
distance measures and annotations. Useful for demo and to
show projects to customers.

LineUp To import, pre-process and register point clouds

Survey http://gexcel.it/en/software/jrc-3d-reconstructor/special-
stonex-reconstructor/survey

Mining/Tunneling http://gexcel.it/en/software/jrc-3d-reconstructor/special-
stonex-reconstructor/mining

Construction http://gexcel.it/en/software/jrc-3d-reconstructor/special-
stonex-reconstructor/construction

As an example, if an user has to carry out a task with mining data, he or she can adjust the interface for a
Mining workflow, through this menu. In this way, top toolbar and dockable windows are reorganized by
showing only the functions useful for mining tasks, and in a meaningful order and place. 

Note: the access of each workspace is due to the available licenses!

Menu bar
The menu bar is located on top of JRC 3D Reconstructor®'s main window, and contains the commands and
tools. Some of the commands are also accessible from the top toolbar and the contextual menu. 

The menu bar features the following main voices:

· File: to import/export, load and save data and to manage the project
· Navigation: to interact with the 3D scene and manage rendering settings
· Outputs: to extract results from the project data
· Tools: auxiliary tools to process the data
· Windows: to manage the dockable windows
· Workspaces: changes the current workspace
· R3 software: To direct link to R3 software packages installed in your PC
· Help: to access the online help, the license manager and to display information on the software

version in use.

See also JRC 3D Reconstructor® user interface.

Top Toolbar
The Top toolbar allows fast access to frequently used commands from the File menu, Navigation menu

and Outputs menu.

The toolbar changes heavily when the user changes the current workspace.

http://gexcel.it/en/software/jrc-3d-reconstructor/special-stonex-reconstructor/survey
http://gexcel.it/en/software/jrc-3d-reconstructor/special-stonex-reconstructor/survey
http://gexcel.it/en/software/jrc-3d-reconstructor/special-stonex-reconstructor/mining
http://gexcel.it/en/software/jrc-3d-reconstructor/special-stonex-reconstructor/mining
http://gexcel.it/en/software/jrc-3d-reconstructor/special-stonex-reconstructor/construction
http://gexcel.it/en/software/jrc-3d-reconstructor/special-stonex-reconstructor/construction
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Dockable Windows
JRC 3D Reconstructor®'s GUI (Graphical User Interface) is composed also of many dockable windows. Each of
these windows has a default docking place. However, the user can change it, move the windows and even leave
them floating above the main GUI.

· Project window: its default docking area is on the left side of the GUI

· Property window: its default docking area is on the left side

· Readout window: its default docking area is on the right side

· Log window: its default docking area is on bottom right

· Point list window: its default docking area is on bottom left

· Flythrough editor: its default docking area is on the right side

· Manual positioning: its default docking area is on the right side

The Recipe Window

This window is a particular dockable window, and its default docking area is on the right side. This window is
automatically shown and hidden by JRC 3D Reconstructor® at need. It is shown for the time needed by a
particular procedure to interact with the user.

Therefore, the recipy window doesn't have a fixed content, but hosts a particular dialog for the time that this is
needed to the users. Here is a list of dialogs that are hosted in the recipe window:

· Points selection with polyline

· Mesh from predefined view

· Volume calculation

· Area of cloud portion

· Area of mesh portion

· 2D mesh selection

· 3D mesh selection

· Cut and fill calculation

· Topographic meshing

· Plane creator and editor

The 3D window
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This window is located in the center of JRC 3D Reconstructor®'s GUI and it renders the 3D scene with all
your project items.

In the screenshot above, you can see that the 3D window shows in the bottom left corner a triplet of
coordinate axes. This triplet shows how the current UCS is oriented with respect to your current viewing
direction.

On the right of the axes triplet, a small avatar is shown. If this avatar is present, it means that the system
for human movements while rotating is on. This system is controlled through the Navigation options
dialog, and it is explained also in that help page.

Tip: to easily add models to the scene, drag files from a Windows Explorer window to the JRC 3D
Reconstructor® window.

Navigation
JRC 3D Reconstructor® provides many interaction styles to navigate in the 3D scene. 
See in Navigation menu to learn how to navigate in JRC 3D Reconstructor® environment.

Selection
By pressing the space bar, the 3D window goes from Navigation mode to Selection mode and back. You can
enter the selection mode by clicking Tools->Selection&Fitting tools->Select or by toggling the corresponding
button on the top toolbar.
See Selection&Fitting tools for details.

Coordinate system
The renderer draws with a right-handed coordinate system with
The X-axis pointing to the left
The Y-axis pointing up and
The Z-axis out of the screen

The key concept is the “current camera global reference” (CCGR), i.e. its latitude, longitude and altitude
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(LLA). All the items of the current session are rendered with a relative transform of their own global
reference from the CCGR. The only way to move the CCGR is going to (“Go to” command) a different item.
Until then, the coordinate system is centered in the CCGR, with the XY plane tangent to the earth' surface,
X pointing to North, Y pointing to West and Z is the height above the earth, as a right-handed coordinate
system. Going far away from the origin of the CCGR the accuracy of the LLA coordinates decreases
(shown in the lower right panel), since it's an approximation from the CCGR tangent plane. Thus, if
accurate measurement is a concern, better change the CCGR.

Project Items
JRC 3D Reconstructor®'s 3D world can be populated with several kinds of items. Items are listed in a tree
view in the project window.

Models
The supported model structures are:
Unstructured Point Clouds: a list of points with no relationship with each other
Grid Point Clouds: a list of points organized in a 2D grid, like an image
Triangle Meshes: a list of meshes, where each mesh is a collection of triangles with adjacency
information

Other project items
Polylines: created by contour algorithms or cross sections (exportable in a .dxf file)
Camera views: preferred view points saved by the user with a definable projection among ortho,
perspective, cylindrical and spherical
Projectors: images registered in the scene that can be projected on the geometry to create a texture
map
Annotations: user comments attached to valid 3D points in the scene. Distance and angle quotations are
considered as annotations
Flythroughs: spline trajectories defined by the user in order to create animations and movies
Planes: useful to calculate volumes and cross sections
Projects: useful to merge in a single location all the items of a sub-project.
User Coordinate Systems: the user can create different coordinate systems with special purposes.

Contextual menu functions
The contextual menu contains, among other functions:
Load/Unload model: each model can be loaded or unloaded to free main memory
Save: this command is available only if the data or properties has been modified
Save copy as: save a copy of the model or export to another file format. The following dialog allows to
browse for the file location and format (Files of type combo box)
Go to: center the 3D window to the bounding box of the model. The view point is computed so that to
contain the whole bounding box in the viewport. Warning: this could place sometimes the model far away,
with the effect that it seems not visible. Therefore increase the max depth in the Options.
Center to local origin: the view point is aligned to local coordinate frame of the model, with X rightwards,
Y upwards and Z going out of the screen.
Align to bounding box: the view point is aligned to the desired face of the bounding box of the model
Pose: open the pose dialog to view and modify the transformation matrix and geo-referentiation of the
model
{Model specific operations}: list of standard processing functions.

See also project window.
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R³ software menu
This menu allows you to access the JRC 3D Reconstructor® functions needed to run the Gexcel R³
software: 

Point R3 To manage and display 3D data and large dataset of 3D point clouds in a very
simple way.

PixR3 To create 3D models starting from photos.

See also UAV and imaging to learn how to integrate JRC 3D Reconstructor and
PixR3.

 
Note: This menu appears in the Menu bar only if one or more R3 packages are installed!

http://gexcel.it/en/software/pointr3
http://gexcel.it/en/software/pointr3
http://gexcel.it/en/software/pixr3
http://gexcel.it/en/software/pixr3
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File menu
This menu is mainly organised in three main parts:

PROJECT
MANAGEMENT

· New project: every project is organized in a folder that groups data by model

structure and object type, thus the following dialog allows to create and select a

folder for the project

· Open project: open an existing project (*.recprj or *.r2s)

· Save project

· Save project as: save a copy of the project with a different name

· Recent projects: opens one of the project you recently used

· Convert project to efficient format

IMPORT · Import format: import data from third party formats.

· Import Rec Project

· Load item

EXPORT · Export
· Export model as…
· Export polyline as…
· Export cross section as…
· Export UCS to AutoCAD
· Export annotation to .CSV
· Export pose

Exit: quits JRC 3D Reconstructor®. If you have unsaved changes to your projects, JRC 3D
Reconstructor® asks you if you wat to save the changes or not before exiting.

Project Management
In this section you can learn how to efficiently manage your JRC 3D Reconstructor® project by using the
following commands.

New project
This function allows to create a new JRC 3D Reconstructor® project. 
Each project has its own folder called with the same name. JRC 3D Reconstructor® projects contains at
least some of the following subfolders:

· Imports/
· Exports/
· Unstructs/
· Grids/
· Meshes/
· Polylines/
· Trash/
· Images/
· Movies/

These folders are automatically created when the project gets populated.
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The option to create a new project appears also in JRC 3D Reconstructor®'s initial screen, shown below,
and has the same functionality.

Open project
This function opens a JRC 3D Reconstructor® project (*.recprj, *.r2s). Before opening a new project, JRC
3D Reconstructor® asks whether you want to save the current one (if you left unsaved changes).

Compatibility across different JRC 3D Reconstructor® versions
JRC 3D Reconstructor® projects are backwards compatible. For JRC 3D Reconstructor® to be able to
open a project, the project must have been created/saved with a Reconstructor® version with the two
most important version numbers are smaller or equal. For example, JRC 3D Reconstructor® 3.0 can
open projects saved with versions 2.x; however it cannot open projects saved with JRC 3D
Reconstructor® 3.1. However, JRC 3D Reconstructor® 3.0.0 can open projects saved with JRC 3D
Reconstructor® 3.0.1.
Persistence of camera pose
When opening a project, JRC 3D Reconstructor® loads all the project items in the project window, and
sets the 3D scene's current viewpoint to the position and orientation that it had when the project was
saved.
Moving/copying a project
When transferring or copying a project, the whole project folder with all its subfolders must be copied,
and not only the project file (*.recprj).

Save project
This function saves the current project, safley storing all the project items, their load/unload state, their
properties, the current 3D camera pose, etc.
It is advised to save the project frequently, especially before long processing operations.

Save project as
This function saves only the project file (*.recprj) with another name. It is useful for projects with many
items, it is possible to have a project with the clouds, and another with the clouds and more accessory
items like camera, planes or polylines.
It is also useful to create a copy of the project, by using this function to create another project file in
another directory, and then copy all the source project subfolders in the destination project folder.

Recent projects
This function allows you to quickly open one of the projects you recently worked with. JRC 3D
Reconstructor® keeps track of the latest 20 projects used in this menu option.
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Convert project to efficient format
This function converts all data of the current project in the new efficient format, that guarantees faster
reading and writing and better compression ration.
Since JRC 3D Reconstructor® v. 3.0, all new projects are already written in the efficient formats.
Therefore, this function is only useful to convert projects that were created with earlier Reconstructor®

versions.
If you have many old projects to convert, or whole external HDDs with projects to convert, you may want
to use the R2ConvertProjects.exe tool present in JRC 3D Reconstructor® installation folder. Just drag and
drop the root folder of your drive into that executable. R2ConvertProjects will search recursively for all
subfolders containing Reconstructor® projects and convert them to the 3.0 efficient format. Your point
clouds and meshes will be read and written faster, and you will get back many gigabytes of free space.

Import
To quickly import data, just drag and drop the files you want to import anywhere in the 3D scene. A wizard
will appear to ask you for import options, depending on kink of data. 

a. If you're importing a point cloud the LineUp® Tool will be opened.
b. If you're importing a different file format (as meshes, polylines, etc…) a wizard window will appear to
guide you through importing steps.

All imported models' coordinates will be interpreted as referred to the current UCS (User Coordinate
System).

See Getting Started->Import to learn the fast way to import your data.

· Import Format
· Import Rec Project
· Load Item

See also File menu.

Import Format
To import data from third party formats. The formats are grouped by the way adjacency structure is
preserved, so first select the structure of the data that must be imported. The following dialog allows to
browse and filter the directories by file type. The “Files of type” combo box lists the available import
filters. Since the format filters are based on a plugin system, this list is extensible and depends on your
software distribution. After the model structure is chosen, a dialog asks you which files would you like to
import. Please filter the files by the desired format type. Multi selection is possible with shift and control
keys. 
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Grid Point Cloud
Comma Separated Values .csv
DEM ASCII header+matrix .asc
Generic binary raster *.*
Grid Point Cloud Text File .txt
PTX .ptx
Stonex multiple scans .x3m
Stonexpoint cloud  .x3s

Mesh
3DS .3ds
AutoCAD data exchange format .dxf
Collada .dae
IFC (Industrial Foundation Classes) .ifc
PLY mesh .ply
Reconstructor VG3 mesh .vg3
STL Mesh .stl
Triangle Meshes Text file .txt
VRML .wrl, .vrml
Wavefront .obj

Unstructured Point Cloud
E57 unstructured point cloud .e57
Kubit PointCloud .ptc
LAS format .las
PLY point cloud .ply
Unstructured Point Cloud Text File .txt
PTS .pts

Polyline/trajectory
AutoCAD data exchange format  (*.dxf)

List of points (*.txt)

CAD Models
AutoCAD data exchange format .dxf
IFC (Industrial Foundation Classes) .ifc
STL Mesh .stl
VRML .wrl, .vrml

See also the Stonex Data Importer.

Stonex Data Importer
Stonex Reconstructor is able to import the Stonex Cloud files automatically colorized by using pictures
and calibration files.

During the import process the following wizard 
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help you to:

1. Colorize the Point Cloud, importing UP/DOWN camera calibrations and images.

You need to load:
o .x3s and .x3m scans files
o pictures of UP (U) and DOWN (D) cameras (. jpeg) 
o calibration of UP (U) and DOWN (D) cameras (. cal)

It's suggested to keep these files in the same folder.

2. Colorize missing points with reflectance, to colorize points with reflectance where color information
doesn't exist.

3. Import full resolution images: to import also projectors of pictures.  

By clicking on Import all, the prevoius choises will be applied to all the scans you're importing.
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Import CAD models
This function allows you to import in JRC 3D Reconstructor® models from CAD softwares, in order to do
structural analyses or to compare the models with the point clouds.

List of supported CAD formats
You can import CAD models in any of the following formats:

AutoCAD data exchange format .dxf You can import meshes written in DXF format, JRC 3D
Reconstructor® will also read their colors and textures.

IFC (Industrial Foundation Classes) .ifc You can import models e.g. from Autodesk Revit via the IFC
format. JRC 3D Reconstructor® preserves the model colors
(except for the transparency)

STL Mesh .stl When importing STL files, JRC 3D Reconstructor® asks you the
unit of measure in which the STL vertices are written.
Supported units of measure are: meters, centimeters,
millimeters, inches, feet, yards

If the STL file is binary, and if the string “COLOR=” is present in
the first 80 bytes, then JRC 3D Reconstructor® tries also to
import the colors of the STL solid. If not, no color is imported.
The standard STL format does not support colors neither
textures. This is only one of the non-standard formats to write
color into STL files

VRML .wrl, .vrml When you import vrml models as meshes, JRC 3D
Reconstructor® will maintain their colors and textures. JRC 3D
Reconstructor® will also ask you for a scale factor

IFC Import Dialog
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Interoperability with Autodesk Revit
This import tool allows you to import your BIM project realized with Autodesk Revit inside JRC 3D
Reconstructor®. The BIM entities are converted into meshes and can be compared with point clouds via
the inspection functionality, to get accurate deformation and structural analyses.
From Revit, just export your project in the IFC format, and then simply drag&drop your IFC file inside JRC
3D Reconstructor®. The above dialog opens up.

Exclude unneeded entities
BIM projects can be very large and detailed, including furniture elements, railings, windows, etc. For the
sake of inspection, you may want to exclude some project entities because, for example, they are simply
not yet in place in reality. To exclude some entity types, just mark them among the check buttons that
represent the most commonly used IFC entity types. In the screenshot above, for example, all furnishing
elements, railings, ramp flights, sites and “BuildingElementProxy” 's will be excluded from the import
procedure. You can also specify which entity types to include , by selecting the Include only selected
entities radio button. In this case, you have to check at least one entity type to proceed importing.

Entities grouping
In the bottom box of the dialog, you have two grouping options: Group everything in a single
mesh and Separate entities by type into different meshes. The first option will merge all your IFC entities in a
single mesh, resulting in a faster inspection procedure. The second option will split your IFC entities
among many meshes, one by entity type. If you choose the second option, JRC 3D Reconstructor® will
create many meshes and put them under the same parent group in the project. The meshes will be called
with the following convention: <IFC file basename>_<IFC entity type>. For example: “MyBuilding_IfcWall”,
“MyBuilding_IfcRoof”, “MyBuilding_IfcWindow”, etc.

Import sketch from LineUp® Notes
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LineUp® Notes is a Gexcel APP dedicated to:

· Import plan views of your site:  Easily manage
large scanning projects and speed up the
global scans/point clouds registration. When
in few days a huge number of scans are
taken by different surveyors in different
positions. Plan your work in advance, or
while you are surveying, and optimize it.

· Note scan/targets position and properties: For
each scan you can take a note of useful
characteristics or personal data of the
surveyors and insert your comments. You
can insert also more notes like scanning
timing, scanner model (by choosing it among
the most popular ones: Focus3D, Stonex and
Z+F) and all the notes you think can be
necessary.

· Seamlessly, automatically process your data:
Easily connect iPad and PC, to import scans
positions and properties in JRC 3D
Reconstructor®, and seamlessly run
automatic, target-less registration
using LineUp® Pro. LineUp Notes also
organizes your survey projects for efficient
post-processing and sharing.

· Connect your survey positions and data with
your PC using JRC 3D Reconstructor®, to
easily organize your elaboration and
seamlessly run the automatic target-less
registration process using LineUp® Pro.

System Requirements:
· iOS 8.0 or later
· Compatible with iPad mini and iPad retina

You can learn how to:
· install the APP here
· use the APP and import sketch in  JRC 3D Reconstructor® here.

You can free download LineUp® Notes here!

Import Rec Project
These function imports items from another JRC 3D Reconstructor® project. The items data can be copied
or moved from the project to be imported.

See also UAV and Imaging. 

https://vimeo.com/144104175
https://vimeo.com/128989627
http://gexcel.it/en/software/jrc-3d-reconstructor/lineup-notes
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Load item
This function allows you to import in the current project a pre-existing item saved in Reconstructor
internal format. The item is not duplicated, copied or moved from its location. It is just listed as belonging
to the project.

With this function, you can load any of the following item types:
· Unstructured point clouds (*.rup)
· Grid point clouds (*.rgp)
· Triangle meshes (*.rtm)
· Cross sections (*.rcs)
· Polylines (*.rpl)
· Trajectories (*.rtr)
· XML item file (*.xml)

These are all JRC 3D Reconstructor® internal formats for items.

Export
This menu contains a number of options to export JRC 3D Reconstructor®'s entities in various formats, to
be imported in third-party software or CAD tools for further elaboration.

· Export model as…
· Export polyline as…
· Export cross section as…
· Export UCS to AutoCAD
· Export annotation to .CSV
· Export pose
· Export to Autodesk ReCap 360

Click here to browse the complete list of export formats supported by JRC 3D Reconstructor®. When
exporting models or other entities, the coordinates are exported as they appear in the current UCS.

See also File menu.

See Getting Started->Import to learn the fast way to import your data.

Export Model as...
This function allows to export a model (models are all point clouds and triangle meshes) in a third-party
format or in an intermediate format, for further processing in external software tools.

Export workflow
If you want to export a given list of models (clouds or meshes) to the same third-party format, after
selecting this function you are presented with a dialog where you can set format-specific options. Below
you find a table with the supported options by format, and with the known limitations of each format. You
can choose whether to specify different export options for each model, or to adopt the same export
options for all models. In the latter case, select Do not ask again in the subsequent save filename dialog.

Format limitations when exporting global coordinates
Generally speaking, when exporting a model to an external format, JRC 3D Reconstructor® tries to store
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as much information as the format allows. Therefore, models are always exported in global coordinates,
meaning the coordinates that the model has in the current UCS. However, some format do not allow big
coordinates for the models' points. Such formats are STL meshes and PLY meshes. Because of intrinsic
limitations of these formats, models exported in these formats are saved in local coordinates, losing their
global position in Reconstructor project.

Export formats options and limitations

Grid Point Clouds

Export format Supported options Limitations

E57 grid point cloud

E57 unstructured point cloud

Choosing local or global
coordinates.
Choosing whether to export a
color layer and which.

Generic binary raster *.*

Grid Point Cloud .rgp

Grid Point Cloud Text File .txt

PTC Kubit Point Cloud
(unstructured)

Selecting which color layer to
export.
Setting a subsampling factor for
the exported cloud.
Skipping the depth discontinuities
or not.
Skipping the orientation
discontinuities or not

LAS format point cloud
(unstructured)

Choosing local or UCS
coordinates.
Choosing whether to export the
reflectance, also in a way
compatible with Autodesk ReCap.
Choosing whether to export a
color and which.

Optech IXF  scan
(structured)

PLY point cloud
(unstructured)

Selecting whether to export a
color layer and which.
Selecting whether to export local
or UCS coordinates.
Selecting whether to export point
normals or not.
Selecting the storage mode
among ascii, binary little endian,
binary big endian.
Selecting the coordinate precision
between float and double.

If the model to be exported has
too big UCS coordinates (more
than 100 km), Reconstructor will
not export it in UCS coordinates,
because of PLY format limitations.

PTX point cloud
(structured)

Choosing a subsampling factor.
Choosing which color layer to
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export.
Choosing whether to skip depth
discontinuities.
Choosing whether to skip
orientation discontinuities.
Choosing whether to export a
PNG image of the selected color.

Unstructured Point Clouds

Export format Supported options Limitations

E57 unstructured point cloud Choosing local or global
coordinates.
Choosing whether to export a
color layer and which.

Grid Point Cloud Text File .txt

PTC Kubit Point Cloud
(unstructured)

Selecting which color layer to
export.
Setting a subsampling factor for
the exported cloud.
Skipping the depth discontinuities
or not.
Skipping the orientation
discontinuities or not

LAS format point cloud
(unstructured)

Choosing local or UCS
coordinates.
Choosing whether to export the
reflectance, also in a way
compatible with Autodesk ReCap.
Choosing whether to export a
color and which.

PLY point cloud
(unstructured)

Selecting whether to export a
color layer and which.
Selecting whether to export local
or UCS coordinates.
Selecting whether to export point
normals or not.
Selecting the storage mode
among ascii, binary little endian,
binary big endian.
Selecting the coordinate precision
between float and double.

If the model to be exported has
too big UCS coordinates (more
than 100 km), Reconstructor will
not export it in UCS coordinates,
because of PLY format limitations.

Unstructured  Point Cloud Text
File .rup

Unstructured  Point Cloud Text
File .txt

PTS point cloud .pts
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Meshes
3DS Supports mesh textures. It is not possible to save meshes

with more than 65536 vertices or
more than 65536 triangles.

AutoCAD data exchange format
.dxf

Does not support mesh color or
mesh textures.

Reconstructor VG3 mesh .vg3

STL mesh Does not support mesh color or
mesh textures.
Only local coordinates are saved,
the model global positioning is
lost.

PLY mesh Selecting whether to export a
color layer and which.
Selecting whether to export local
or UCS coordinates.
Selecting whether to export point
normals or not.
Selecting the storage mode
among ascii, binary little endian,
binary big endian.
Selecting the coordinate precision
between float and double.

If the model to be exported has
too big UCS coordinates (more
than 100 km), JRC 3D
Reconstructor® will not export it
in UCS coordinates, because of
PLY format limitations.
Does not support mesh color or
mesh textures.

Triangle Meshes .rtm

Triangle Meshes Text File .txt

VRML .wrl, .vrml Supports mesh textures.

Wavefront .obj

Export polyline
This option allows you to export a set of polylines to the DXF format, to be read for example in AutoCAD.
When selecting this function, you are asked to select the output filename. After that, you are asked to
provide the decimal precision that the polyline's points should have.
You can specify a distinct output filename and decimal precision for each polyline. Otherwise, in the select
file dialog you can check Do not ask again and you will set the decimal precision only once for all the
polylines. The filename will be also assigned automatically.

Export cross section as
This option allows you to export a set of cross sections to the DXF format, to be read for example in
AutoCAD. When selecting this function, you are asked to select the output filename. After that, you are
asked to provide the decimal precision that the cross sections' points should have.
You can specify a distinct output filename and decimal precision for each cross section. Otherwise, in the
select file dialog you can check Do not ask anymore and you will set the decimal precision only once for all
the cross sections. The filename will be also assigned automatically.

Export UCS to AutoCAD
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This function exports an User Coordinate System to AutoCAD. The UCS is saved as a .SCR file, a script that
can be loaded in AutoCAD.
To import an UCS in AutoCAD, type _script, enter, select the script file and open it. The imported UCS is set
as current and the top view is applied.

Sample script created by this function
;JRC Reconstructor UCS creation into ACAD
;----------------------------------------script
_ucs _w
_ucs _na _d UCS_from_Site7-Faro_sub1
_ucs _3 1.2316973441870025,-12.792058116493525,0.09258080613814651
2.2311556440494402,-12.759596396830426,0.087163833496514284 1.1992797323578062,-
11.792616050403021,0.10062163768949305
_ucs _na _s UCS_from_Site7-Faro_sub1
_plan _c
_ucs _w
_ucs _na _d UCS_from_Site7-Faro_sub1
_ucs _3 1.2316973441870025,-12.792058116493525,0.09258080613814651
2.2311556440494402,-12.759596396830426,0.087163833496514284 1.1992797323578062,-
11.792616050403021,0.10062163768949305
_ucs _na _s UCS_from_Site7-Faro_sub1
_plan _c
;-------------------------------------endscript
;
;GEXCEL

Export annotations to CSV
This function exports a set of point annotations obtained with the annotation tool. Select a list of
annotations from the project window, and select this function to export them in .CSV format. JRC 3D
Reconstructor® will ask you for a filename and create a .CSV file that you can open in Microsoft Excel or
other spreadsheet programs. In the .CSV file, your annotation data will be organized in six columns, and as
many rows as the annotations are. The first column will contain the annotations' unique IDs. The columns
from second to fourth will contain the annotations' cartesian coordinates. The fifth column contains the
comments, and the sixth and last will host the annotations' hyperlinks, if any.

Export pose
This is a very useful function for registration workflows. It allows to safely store in a separate folder the
positions and orientations of your project items, in order to recover them if and when needed.

When pre-registering, registering, geo-referencing or moving around your models, you may want to
backup the model's positions and orientations (poses) before changing them. If something doesn't work
in the registration algorithm, or in changing the models' poses, you can safely restore the poses as they
were before the action.

When you activate this function, the poses of the selected items are saved in the Exports/ project folder,
in a folder called with the name pattern PoseFiles_aaaa.mm.dd_hh.mm.ss_xxx. This way, you can easily read
the precise date and time of creation of the poses, for future use.

To restore any item's pose, use the pose transform dialog.
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Export to Autodesk® ReCap 360 Pro
Thanks to free Gexcel ReCap plug-in, JRC 3D Reconstructor® can directly export in .rcs and .rcp formats
for a more complete and faster integration with the Autodesk® Recap 360 Pro software.  JRC 3D
Reconstructor point clouds (.rgp, .rup) can also be directly imported in ReCap 360 Pro. 

You can download the free plugin here.

See the videotutorial to learn how to install the plugin and work with it.

http://www.gexcel.it/en/download/download-jrc-3d-reconstructor
https://www.youtube.com/watch?v=T6W2F5p_BQE&feature=youtu.be
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Navigation menu
JRC 3D Reconstructor® provides many interaction styles to navigate in the 3D scene.
The navigation modes are selectable through the Navigation toolbar (placed on the right) or by Navigation
command in the top menu.

Predefined views

Navigation modes

Screen settings

Creation of User Coordinate System

In the contextual menu of items other commands are available:

Go to
To center the 3D window to the bounding box of the model. The view point is computed so that
to contain the whole bounding box in the viewport. Warning: this could place sometimes the
model far away, with the effect that it seems not visible. Therefore increase the max depth in the
Options.
This tool is very useful when you have loaded many objects and want to go quickly and easily to a
specific one.

Center to local origin
The view point is aligned to local coordinate frame of the model, with X rightwards, Y upwards
and Z going out of the screen.

Align to bounding box
The view point is aligned to the desired face of the bounding box of the model.

In View Parameters dialog you can customize advanced parameters of the current view by controlling
how the “virtual eye” sees the 3D scene with all your models. 

Predefined views

Default view

This navigation mode allows the user change the current view so that all the selected items are
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completely visible in the 3D scene.

Bubble view

This navigation mode allows the user to place the current view to the center of an item. Only camera
rotations are allowed in this mode.
See also Bubble mode. 

2D view

This navigation mode opens the Edit 2D Grid Window. Note that this view is supported for grid point

clouds only.

Map view

This navigation mode places the view so that all the selected items can be seen from a top view.

UCS views

This navigation mode places the view so that all the selected items can be seen from an according to

UCS view:

See also here.

In the LineUp® tool other predefined views are available:
· Slice View
· Horizontal Section View

These modes can be used to check the correct alignment along a vertical/horizontal section of the
displayed items.

Slice View (Line Up)

This navigation mode automatically switches the view to orthographic mode and alignes it to
the selected items bounding box vertical plane.

This mode can be used to check the correct alignment along a vertical section of the displayed items.
The depth of the slice can be changed from the options dialog.
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Keyboard/mouse movement Effect

LMB + move mouse Rotate the around the selected
items vertical (z) axis

CMB + move mouse Translate sideways

 Mouse wheel rotation Translation towards point
indicated by the mouse

Horizontal Section View (Line Up)

This navigation mode automatically switches the view  to orthographic mode and alignes it to
the selected items bounding box horizontal plane.

This mode can be used to check the correct alignment along an horizontal section of the displayed items.

The depth of the horizontal slice can be changed from the options dialog.
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Keyboard/mouse movement Effect

LMB + move mouse Rotation the around the selected
items vertical (z) axis

CMB + move mouse Translation sideways

 Mouse wheel rotation Translation towards point
indicated by the mouse

Navigation modes

Pivot mode
Default navigation mode based on translating and rotating around a chosen point of the 3D
scene
Walk mode
Navigation mode that allows you to translate and rotate around yourself, independently of
the models
Bubble mode
Navigation mode in which only rotations around yourself are allowed
Zoom
Narrows down the virtual camera's field of view to concentrate on a particular viewport. It
doesn't move the virtual camera
Move to viewport
Moves the virtual camera so that a particular viewport is in sight, without changing the field of
view

Recent camera positions
Recovers up to 1000 steps you went through during your navigation

Pivot Mode



Stonex Reconstructor 3

- 60 -

In this mode a point can be selected as a rotation pivot. The pivot is set by a left button click on a valid point.

Keyboard/mouse movement Effect

LMB + move mouse Camera rotation (pan and tilt)

CMB + move mouse Camera sideways translation
(tracking and booming)

RMB + move mouse back/forth
Camera dollying, forward and
backward along the current focal
axis

Mouse wheel rotation Translation towards point
indicated by the mouse

Shift + LMB + move mouse left/
right Camera rolling

LMB click on a model's point Selection of rotation pivot

Shift + mouse wheel rotation Zoom in and out (change of field
of view)

Alt + LMB double click Selection of points for point list
window

Shift + CMB + mouse move Draw rectangle to move into

Key 'c' Copy readout window's contents
to clipboard

Walk mode

This mode is designed to simulate a human being walking around the 3D scene. The user can make
translation movements with the keyboard and mouse movements with the mouse.
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Keyboard/mouse movement Effect

LMB + move mouse Camera rotation

w, x, a, d keys Move forward, backward, left,
right

q, z or +, - keys Move up, down

Bubble mode

This mode is designed to simulate a human being walking around the 3D scene. The user can make
translation movements with the keyboard and mouse movements with the mouse.

Keyboard/mouse movement Effect

LMB + move mouse Camera rotation (pan and tilt)

Mouse wheel rotation Zoom in and out (change of field
of view)

Shift + LMB + move mouse left/
right Camera rolling

Alt + LMB double click Selection of points for point list
window

Key 'c' Copy readout window's contents
to clipboard

Zoom Tool
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This tool allows the user to zoom on a specific part of the scene.

The tool can be used by following these steps:
· Press the "zoom" command under the Navigation menu.
· Drag the mouse while pressing the left mouse button to draw a rectangle in the 3D view.
· Release the mouse: the camera zooms into the new defined viewport. The system then changes back

to the last navigation mode used.

Difference with respect to the Move to viewport tool
With the zoom tool the camera is zoomed-in a detail of the scene. Only the field of view (in perspective
mode), or the projection size (in orthographic mode) is changed.
With move to viewport, the camera is translated closer to the detail indicated by the rectangle, leaving
the field of view unchanged.

Move to viewport

This tool moves the viewport to a specific part of the scene.

The tool can be used by following these steps:
· Press the "move to viewport" command under the Navigation menu.
· Drag the mouse while pressing the left mouse button to draw a rectangle in the 3D view.
· Release the mouse: the camera translates the new defined viewport. The system then changes back

to the last navigation mode used.

Difference with respect to the zoom tool
With the zoom tool the camera is zoomed-in a detail of the scene. Only the field of view (in perspective
mode), or the projection size (in orthographic mode) is changed.
With move to viewport, the camera is translated closer to the detail indicated by the rectangle, leaving
the field of view unchanged.

Recent camera positions

When navigating your models in the 3D scene, it can happen that your make mistakes, you lose your
models, or you lose the position you reached. You can use this function to “go back to your steps”.

JRC 3D Reconstructor® keeps in memory the last 1000 camera positions through which you navigated.
Through this dialog, you can browse them and go back to your previous steps, restoring useful views on
your models when you lost them.
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Screen settings

Show axis

To show/hide the coordinate system frame of the current camera global reference (CCGR) in the bottom
left corner of the 3D scene.

Show bounding box

To show/hide the bounding boxes of all items in the 3D scene.

Color by ID
To render all the project entities with their identifying color ID. The color ID of a point cloud can be
changed from the property window.
This option is useful to distinguish the models from each other and to know which model is which in the
3D scene.

Options

To modify current navigation and rendering parameters.
See details here.

Display and navigation options

This dialog is accessible from the Navigation menu, by selecting Navigation->Options or from the
Screen settings -> Options top toolbar menu.The options present in this dialog are described below.

Enable human movements while rotating
When this options is checked, a small human avatar appears in the bottom-left corner of the 3D rendering
window. While you navigate in the 3D scene, you will experience that after doing many rotations, your
viewing direction will still be oriented according to the vertical axis and to the horizontal plane defined by
the current UCS. This is like a human being that, after rotating his head around his neck in many
directions, when relaxing the head will go back into the natural position, which is in line with the spinal
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chord.
When this option is unchecked, while navigating the 3D scene you will experience that after some
rotations the reference to the UCS's horizontal plane is lost, and that you are floating in the space like an
astronaut floats among meteors, without gravity force.

Use scalable quick rendering
When this option is checked, the scalable quick rendering is on. When hundreds of millions of points must
be rendered, this rendering system allows you to still navigate very fast across your models. This is
possible by rendering only 500000 representative points of all the loaded point clouds. After one second
that you have stoped navigating, the rendering of the complete set of points will start.
If this option is unchecked, JRC 3D Reconstructor® will render the complete 3D scene, with up to the
defined maxmimum rendered points, for each refresh of the 3D window. In selection mode, the scalable
quick rendering is automatically disabled.

Set maximum rendered points
This option is used to set a maximum number of point to be rendered in the 3D scene. The limit is
cumulative for all the loaded point clouds.

Set maximum rendered points in Virtual Scan
This option is used to set a maximum number of point to be rendered in the Virtual Scan tool. The limit is
cumulative for all the loaded point clouds.

Dynamic point size
If this option is enabled, the size of the rendered 3D points decreases linearly with the increasing distance
of the points to the “virtual eye”. If this option is disabled, the size of the rendered 3D points is constant
regardless of the distance from the viewing point.

Point smoothing
Enable this option to render 3D points as small circles, disable it to render 3D points as small squares.

Projectors cast shadows
If the graphics card supports shadow mapping, this option allows to render projectors that cast shadows
through the scene geometry. For best quality, render only triangulated models. Although this can be done
also with point clouds by increasing the point size, color projected by the projector could “bleed through”
the occluders.

Use shaders for projectors
If the graphics card supports CG shaders, this option can be enabled, which allows to render
projectors with the highest quality. Nvidia graphics cards always support CG shaders, while ATI graphics
cards don't.

Movement speed
This option sets the translation speed when panning in pivot mode.

Slice views thickness
This option sets depth of a single slice when using the slice view or the horizontal section view.

Set gradient background
Change the uppermost and lowermost color of the background of the 3D rendering window.

Object reference frame size
All models and cameras can draw their local coordinate frame by enabling the property. Here the frame
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size (in meters) is specified to improve its visibility accordingly to the extent of the scene.

Pivot mode controls
Here you can select two options: “Reconstructor” and “Move with 3-button mouse”. These options are two
sets of controls for the Pivot Mode. The second one is the default one and is described here.
 If you  select “Reconstructor”, then in pivot mode the following controls apply:

· Rotate: To rotate the model around the pre-defined centre of rotation (pivot), move the mouse
within the 3D window while keeping the left button pressed.

· Pan:  To pan the model in X and Y, move within the 3D window while keeping the left button and
the Shift key pressed.

· Zoom: To translate the model along the Z-axis, move the mouse within the 3D window while
keeping the left button and the Ctrl key pressed or use Ctrl + mouse wheel to zoom in and out
along the Z-axis. In the latter case, if the mouse pointer hovers a valid 3D point, the zoom
converges to that point.

· Change pivot: double-click the left mouse button plus Ctrl+Shift on a valid 3D point.

Bounding box colored with colorID
When this option is checked, the bounding boxes of the project items are colored based on the item's
colorID. If this option is unchecked, the bounding boxes are colored with the default (yellow) color.

Bounding box edge smoothing
Apply an anti-aliasing algorithm to bounding box edges. It is suggested to leave this option checked unless
the graphic card does not support lines smoothing.

Number of visualized decimals
This option sets the number of decimals do be displayed for measures in JRC 3D Reconstructor®. A restart
of the software is needed in order for this option to take effect.
Please note that this option only affects the visualized values, while the internal computations are carried
out using the full precision.

View Parameters Dialog
This window appears when the user hovers the mouse on the View parameters button in the top toolbar.
Here the user can customize advanced parameters of the current view.

This window allows you to control how the “virtual eye” sees the 3D scene with all your models. There are
two viewing mode: the perspective mode (shown on the left image) and the orthographic mode (on the
right image).

Perspective projection
In perspective mode, the virtual eye uses a perspective projection to see the scene, and you can set the
amplitude of the projection by specifying the “Vertical FOV” (field of view) in degrees. Decreasing
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(increasing) the field of view is equivalent to zooming in (out) with the objective lens of a photocamera.

Orthographic projection
In orthographic mode, you see the 3D scene through an orthographic projection, and you can specify the
“vertical size” in meters of your projection.

Cut planes
Near plane: distance of near clipping plane in meters. Specifies the minimum rendered depth. In
perspective mode only values greater than zero are allowed.
Far plane: distance of far clipping plane in meters. Specifies the maximum rendered depth. Must be
greater than Near plane.

To optimize the depth accuracy try to keep these values as close as possible to the desired scene depth
range. If your model's bounding box is 100 x 100 x 100 m, it is not useful to adopt a far plane of hundreds
of kilometers.

Create UCS from point lists

This command creates a new UCS from two sets of points. Switching to the resulting UCS will show
the points of the first set with the coordinates of the second set.

This function is accessible from the Navigation menu, or from the toolbar of the point list window.

Given two lists of points, this function creates a new UCS such that the points having coordinates in list 1
will assume the coordinates in list 2 after switching to the resulting UCS, except from a controllable mean-
squared error.

Press the buttons Load moving points on top left to load a text file with the first point list, and Load
reference points on top right to load a text file with the “reference” coordinates of the points, the
coordinates that are going to be shown in the new UCS. To parse the text files with the point list, an
appropriate tool is used. You can use as moving points the points listed in the point list window, via the
appropriate button on top left.

After loading the first and the second list of points, press Compute on the bottom right. A dialog appears,
asking whether you want to register the points by coupling them according to their labels, or by trying out
all the possible pair combinations to find the best. The first option is much faster but it assumes that you
are sure about how to match your points. After you have selected either Match names or Best fit, you can
refine and make use of the results of the registration, in the dialog shown below.
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In the dialog above, it is possible to set the error threshold and to exclude outliers in order to improve the
mean registration error. The way to do that is described here ( ICP Registration Dialog). Once you have
refined the mean-squared error (shown on top left), press Create UCS from transform to create the
desired UCS. The resulting UCS will be inserted in the project window.

This procedure uses the same calculations as georeferencing from point list.
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Outputs menu
This menu contains many functions to extract results from the project's data and models. These functions
are organized in the following submenus:

· Measures & notes
· Elevations & plans
· Cross sections
· Areas & Volumes
· Inspection
· Tunnel survey
· Video record
· Drawing tools
· Save snapshot
· Manage units of measure

Measures & Notes
In JRC 3D Reconstructor® some basic measure feature is available:

Readout
window

The readout window allows you to see the 3D coordinates of the points you
are hovering the mouse on in the 3D rendering window.

Distance This button allows you to measure a distance between any two points in the
3D scene. After activating this button, press the Left Mouse Button of the
mouse (LMB) for the first point and keep it pressed while dragging the
mouse to the second point, then release the LMB. A result dialog will pop up
displaying the distance between the two points. You will be offered the
option to save the distance as an annotation in your project.

Angle This button enables you to measure and angle between three points in your
3D scene. After activating this button, click the mouse's left button (LMB) for
each of the 3 points (must be valid 3D points). The angle of the 2nd point
from the 1st and 3rd is computed, and a result dialog opens up to display the
result in degrees. You are also presented with the option to save the angle
measure as an annotation in your project.

Annotation This function allows you to create annotation of 3D points of models in your
project.
After activating this button, double-click with the left mouse button on a
valid 3D point to place an annotation. The annotation gets displayed in 3D
and appears also in the Annotations folder of your project. You can edit the
annotation's comment and set an associated hyperlink in the Property
Editor.

Exporting meaningful points to Excel or other softwares
Using this function, you can annotate the meaningful points of your project
(e.g. topographic targets) and save these annotation as project items.
Successively, you can export in .csv these 3D annotations and import them
in Excel or other external tools for further processing.
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See also Basic measures menu.

See also Areas&Volumes.

Elevations and plans
This submenu contains all the commands and features to create precise, high-resolution elevations and
plans of your models:

· Create Orthophoto
· Create Camera
· Place here survey point
· Virtual scan

Create Orthophoto
With this toolbox you can create an orthocamera from samples, points, axes, UCS directions, etc., edit it
and extract an orthophoto through the Virtual Scan tool.

The recipe window is splitted in two panels:
· Position
· Dimensions and corrections
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Position

The panel of the dialog allows you to
create an orthocamera from selected
samples and a Quick selection (as in
Selection tools) or from a Point list. By
pressing Fit Orthocamera button an
orthocamera is created. Then it's
possible to edit the camera, aligning it to
UCS views, making it horizontal or
vertical.

At the end of this process press Done, set
camera dimension button to swith in the
Dimension and Corrections panel.
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Dimensions and corrections

Here you can set the properties of the 
camera: dimensions, resolution, near
and far plane distance.
By using the shift command you can
translate and rotate the camera in the
space, as you see it in the 3D window.

Orthophoto Preview button helps you to
find the right position of the camera, by
showing you a preview of the final result.

At the end of this process press Done,
make Virtual scan button to enter in the
Virtual Scan window.

See the following videotutorial to learn how to create an orthophoto with an example:
· Orthographic View Extraction Floor
· Orthographic View Extraction Façade

See also Virtual scan andExporting orthophotos to AutoCAD.

Create Camera
This submenu contains functions to create 

prespective

orthographic

cylindrical

https://www.youtube.com/watch?v=wibP8cSWnrM&list=PL3PJ9b9USDYR0kkBSWne8p1oBeodi4req&index=16
https://www.youtube.com/watch?v=VycJ6_LJn1w&list=PL3PJ9b9USDYR0kkBSWne8p1oBeodi4req&index=17
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spherical

cameras with origin in the current point view.

Note: Perspective Camera
A perspective camera can be used to model a common
photographic camera (e.g. a reflex camera), which follows
the rules of perspective projection.
This type of camera can be used to acquire a virtual scan or
to define a point of view in the scene, which can be fixed by
right clicking on the camera item inside the project tree and
selecting the apply projection command.
This camera can be converted into a perspective projector
by setting an image using the set projector image
command. Note that the image to be applied needs to be
undistorted.

See Cameras for more informations regarding perspective cameras properties and associated functions.

Place here survey point
This tool creates a perspective camera  with origin in the current point view. Its properties are the same
of the current View Parameters window settings.

Virtual Scan
This function is called Virtual Scan because you can imagine it like a scanning of the loaded models in the
3D window with a virtual laser scanner.
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It's useful to resample the 3D dataset on a 2D grid from a defined position in 3D space and with a defined
projection (orthogonal, perspective, cylindrical, spherical). Check the models that must be scanned in
the Project Items Window, and the depth range of the scan (near and far clip planes) of the
current camera. Can create snapshots, cube maps or grid point clouds. The virtual scanner can do also
texture blending and mapping for triangulated models.

Parameters:
· Update preview: creates a preview of the scan from the selected view point and projection.

Select the resolution and background color first.

Pick mode:
· Distance: press Left Mouse Button (LMB) for the first point and keep it pressed while dragging the

mouse to the second point, then release the LMB. Both endpoints must be valid 3D points!
· Point: double click LMB to pick a list of 3D points from the virtual scan. If the AutoCAD link is

enabled, the points are sent to AutoCAD. Check Global Coordinates for reading global/local
coordinates.

Save cube map: use this view point to construct a cube map of the scene, i.e. 6 square images (the faces
of the cube) of size Width with perspective projection  (90 degrees vertical field of view) are generated
around the centre of projection and saved to file.
Save image: save the current virtual scanned image to file.
Save grid point cloud: create a grid point cloud from the current virtual scanned color and depth. The
model is automatically added to the project.
The bottom row of the dialog shows the unit scale (depends on the type of projection) of the image and
the computed volume between the plane of projection and the visible 3D data. For best results use
triangle meshes, so no holes are found on the surfaces. Otherwise, try to increase the point size of the
cloud of points in the Property Editor.

Orthophotos
A virtual scan of a plane/ortho camera or projector will be an orthogonal projection and thus an
orthophoto. If the image is saved with Save image, a text file is created along with the image file which
exports registration information of the ortho image in the scene. 
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Simultaneously with saving the image a script for AutoCAD® is generated. It allows, by simply
drag&dropping in the AutoCAD® window, to load the orthophotos in the correct position and scale, (in a
blue layer with the same name dedicated to image). It also creates a UCS having XY drawing plane
coincident with the image plane and positioned in the lower left side of the orthophoto, in order to
facilitate the user in redrawing of vectorial draw.
Press the Export to AutoCAD settings button to choose the options.
Remember that the DWG file (template acadiso) must be saved in the same folder and the script files (*
.scr).
This text file can also be imported in AutoCAD® with the Kubit® plugin.

Gridding: this process computes the optimal estimation for missing points in a grid of size MxN, given K
valid initial points. The algorithms available are: simple kriging (user has to specify the global mean),
ordinary kriging (the mean is computed automatically), kriging with trend (the mean varies smoothly).
Gridding is a demanding process, the time complexity is O(K²MN), so use as few as possible initial points.

See also Create Orthophoto.

Exporting orthophotos to AutoCAD

Several options are available to export your orthophoto to AutoCAD. In this dialog, the first checkbox
allows you to choose whether you want to export to AutoCAD the plain 2D image, or whether also the 3D
position and orientation that the image has in JRC 3D Reconstructor®'s current UCS should be exported to
AutoCAD. Exporting the image's 3D pose to AutoCAD is useful if other items (e.g. polylines) related to the
same model are exported to AutoCAD.

The second checkbox in the dialog gives choice about whether to export the orthophoto in a new
AutoCAD layer or in the current layer. Depending on the number of layers in the AutoCAD project, you
may want to add a new layer or not.

If you selected to export the 3D position and orientation as well, then the third checkbox is enabled. This
allows you to choose whether you also want to create in AutoCAD a new UCS with the same position and
orientation of the image, or not.

Cross Sections
This submenu contains commands and features to create cross sections and isolines of point clouds and
meshes:

· Create/edit plane
· Cross sections
· Cross sections from plane collection

See this videotutorial to learn how to create planes and cross sections from them.

https://www.youtube.com/watch?v=e5qt3gUk8T4&list=PL3PJ9b9USDYR0kkBSWne8p1oBeodi4req&index=14
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Create/edit plane

This window is a toolbox for creating/
editing your plane from points, axes,
objects, UCS directions, etc.
Start by dragging and dropping in the
editor window the plane you want to
edit. If no plane is dropped, a new plane
will be created when you activate any of
the functions.

Creating a plane from points
The superior panel of the dialog allows you to create a plane from, or to make your plane pass by, one to
three points. These points are the center of the plane, the X axis endpoint, and the Y axis endpoint. To
define one of these points, just click on the corresponding select button and Alt + double click on any point
in the 3D scene. Otherwise, select any point from the point list window. When you have defined the
point(s), click on create/edit from specified points. The plane will be adjusted to pass by the specified points,
leaving as much as possible unchanged the other plane's properties.

Creating a plane from an axis
The central panel contains three buttons whose main function is to adjust the plane's spatial orientation.
The first button makes the plane vertical in the current UCS, without moving the central point of the
plane. The second button makes the plane horizontal. The third button rotates the plane around its
normal vector (passing by its center) until the plane's X axis is parallel to the XY plane of the current UCS.
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Creating a plane from model's bounding boxes
The lowest panel of the dialog allows you to create a plane from the faces of the cumulative bounding box
of the currently selected project items. This is useful for example to immediately create the base plane of
a certain church or cave, to make plants or sections later.
When you create/edit a plane from the bounding box of project item(s) (bottom group box), the plane's
direction is determined by the current UCS: frontal, lateral and base plane mean that the plane's normal is
parallel to the UCS' X, Y and Z axis respectively.

Usage tips and tricks
The functions explained before are more powerful if used in combination. For example, first you create a
plane from three points of a façade, then you make the plane vertical, or its X axis horizontal, to create
later an orthocamera from it. Note also that, while you edit your plane, you have the undo/redo buttons
on the bottom of the dialog, to make the editing process easier.
When you are done, just close the window. If you want to start a new plane, click on I'm done, create a new
plane.

Cross sections
To create a cross sections of your models you can access the relative command in the top
toolbar or from the planes' contextual menu.

You can make cross sections of grid point clouds and meshes. However, it is not possible to make cross
sections of unstructured point clouds.

Cross sections are defined with respect to a plane. 
With the default settings, the section is defined as a polyline created by cutting all loaded models with the
plane. However, it is also possible to have multiple cross sections by defining more slices or additional
cutting planes, all parallel to the original plane and lying at a certain distance from it.

In the top left spinbox you can specify how many slices you want, the default is one. The top right spinbox
allows you to specify the default inter-slice distance. By editing these two parameters, you will notice that
the values in the panel on the right in the dialog are changing. These are the list of the slices' distances
from the plane. By double-clicking on a single distance, it is possible to edit individually each distance.
Furthermore, it is possible to add (green “plus” button) and remove (red “minus” button) the currently
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selected slice. There are also two buttons to Save the distances and Load the distances: these are useful
when you have to use the same distances set for many cross sections.

Distances are defined on the plane's Z axis, therefore 0 means “slice lying on the plane”, and the positive
direction is given by the direction of the plane's Z axis. You can invert the plane's direction with the
appropriate command in the plane's context menu. It is also possible to have negative distances, by
double-clicking on them and writing a negative number.

Towards the bottom of the dialog there is the Group polylines by panel, with the option to either group the
output cross sections by Slice or by Model. With the first option, one cross section will be created for each
slice, regardless of how many models the slice crossed. With the second option, one cross section will be
created for each model crossed, regardless of how many slices crossed that model and where. When you
press Ok, the specified cross sections are computed and added to the project under the Cross
sections items group. Cross sections can be exported in DXF for AutoCAD.

Cross sections from plane collection
This command creates a list of cross section starting from a sequence of planes.

Area & Volume
These tools compute area and volume of point clouds and meshes portions.

Area

Volume

Compute cut&fill volume

Area
JRC 3D Reconstructor® provides different ways of computing areas. 

When you press the Area button you
can choose if you want to compute an
area defined by a mesh (1) or by a point
cloud (2)

1. Area of a mesh portion
By using the Sampling tool you can perform a selection of a mesh's portion A new mesh is created using
only the geometry visible from the current view point.

2. Area of a point cloud portion
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· selected with Sampling tools
You can select the point cloud portion
by using Sampling tools on the 3D
window. This selection can span across
multiple point clouds.

· selected with 3D polyline
You can select the point cloud portion
by using the Point selection with
polyline command.

Volume

This procedure enables you to calculate volumes by integrating meshes, or portions of meshes on a
custom plane. You can activate this tool via Outputs->Area & Volume Volume in the main menu, or via the
same button in the top toolbar. On activation, the window above appears in the Recipe window.

You define the mesh, the plane and optionally the polyline to use with the usual drag-and-drop
mechanism. JRC 3D Reconstructor® will calculate the volume of the mesh integrated onto the plane,
regardless of the triangles' normal directions. It should be noted that only the portion of mesh lying in
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the positive semispace of the plane will contribute to the volume. Parts of mesh lying below the plane will
result in zero volume.

Optionally, you can also provide a polyline. The polyline, projected on the plane, defines a closed polygon
on it. If you provide a polyline, only the mesh portion whose projection falls inside that polygon will count
for the volume. It is like if you would cut the mesh with the polyline before computing its volume.

You have three ways to define the reference plane: either using the current view, or dragging a custom
plane, or using the horizontal plane with a given Altitude on the current UCS.

You can Compute the volume above the plane (and under the mesh) or Compute volume below the plane
(and above the mesh).

If you check Preview volume region, then JRC 3D Reconstructor® will show a preview of the 3D region of
which the volume will be computed. This preview refreshes if you change any of the parameters from
inside the recipe window. It may not refresh if you change something from outside the recipe window, for
example if you move the plane or the mesh with e.g. Adjust pose.

Once you have set all the parameters, press Ok. JRC 3D Reconstructor® displays a progress bar showing
the calculation's progress, and at the end visualizes a short report on the volume measure. You have the
options to copy this short report on the clipboard, or to access another window that enables you to
produce an elaborated PDF report, via the option Get PDF report.

Volume PDF Report
This dialog enables you to create a detailed PDF report about your volume calculation.

The dialog allows you to fill in a series of fields with the information you want to appear in the report. The
fields you uncheck or you left blank will not be included in the report.

On top left of the dialog you can fill the fields Site name and Company name. If filled, they will appear as
title/subtitle of your report. Below, check Survey information if you want to include in the report
information about survery operator and survey date. The checkable panel Processing information, below,
works in the same way.

On the top right of the dialog, you can also select whether you want the current 3D view to appear as
screenshot in your report. Finally, on the bottom right you can type additional notes to be included in the
report.

The data you insert are saved also in Windows' registry, therefore the next time you use this dialog you
will be able to reuse the data you filled in before.
When you have inserted the data of your report, click on Save PDF report and select a filename. The PDF
file you specified will be generated.

Compute cut&fill volume
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This procedure implements calculation
of cut and fill volumes. Given
two meshes representing the same
object (e.g. the same terrain) at different
instants in time, the cut volume is the
volume that the objectlost between
instant 1 and 2, the fill volume is the
volume that the object gained between
the two instants.

The simplest way to use this procedure is
to drag in the recipe window one mesh
representing the surface at time 1,
another mesh representing the surface at
time 2, and click OK. Reconstructor will
return the volume of surface 1 integrated
on the Z=0 plane of the current UCS, the
volume of surface 2 integrated in the
same way, the cut volume (by how much
the surface was excavated between time
1 and time 2), and the fill volume (by how
much the surface was filled (has gained
volume) between time 1 and time 2).

Given two surfaces S1 and S2, and a plane P, and assuming
that the projections of S1 and S2 on P share a support C in
common, a third surface Smin can be defined. Since each
point in C, is the projection on P of (at least) one point
of S1 and one of S2, the one of these points that is closest
to P is defined as belonging to Smin. Let V1 be the integral
of S1 on C, V2 the integral of S2 on C, andVmin the integral
of Smin on C. Then the cut volume Vcut is given by V1 - Vmin,
and the fill volume Vfill is V2 – Vmin.

The user can specify several optional parameters, to satisfy special requirements. A set of altitudes can
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be optionally defined, Reconstructor will calculate the contributions to cut and fill volumes for each bench
among two neighboring altitudes. The altitudes can be added and edited manually. Add an altitude by
clicking the plus button, the minus button removes the selected altitude. Double-click on an altitude to
change its value. Otherwise, the altitudes can be generated automatically by specifying a starting altitude
and a fixed bench height. Check automatic creation of regular benches to do that.

These altitudes are by default referred to the Z axis of the current UCS. However, the user can change
this, by dragging and dropping a plane that fills the field Reference plane (optional) and becomes the
reference of all cut and fill calculation and of all altitudes.

The last optional parameter is a polyline that the user can specify to delimit the support C on which the
surfaces are integrated. The closed polyline is projected on the horizontal plane Z=0 of the reference
system and the support C in common between S1 and S2 is intersected with the area delimited by the
projected polyline. Therefore, the volumes are calculated only inside the frustum defined by the polyline
and the horizontal plane.

Once you have set all the parameters, press Ok and the computation starts, monitored by a progress bar
and by messages in the log window.

See also Cut&Fill report.

Cut and fill by altitude report 

This dialog provides you a report of the results of a cut and fill calculation, along with options for managing
and exporting the results.
From top to bottom, the names of the surfaces “before” and “after” are reported, then the volume of the
surface “before” and then “after”, then the cut and fill volumes, then the number of benches considered
for the calculation. Lastly, a table comes with the result displayed for each bench. In fact, you can define
benches (intervals among altitudes) and see how the cut and fill volumes behave for each bench.
On bottom right, four buttons offer you options for exporting the results. You can copy the results in text
form to the system clipboard, you can save the result to an XML file, or you can create a PDF report with
the result. This report can be integrated with more data on company and site name, survey information
and processing information. The button Generate PDF report opens the Volume PDF report dialog.
You can also Change units of measure displayed in the report.

Inspection
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Inspection is a procedure to compare two
different shapes and to measure their
differences.

It is normally used to compare two models of the
same objects surveyed at different moments in
time. For example, it is used for monitoring
barrels of nuclear waste to immediately detect
possible deformations. The
procedure Inspection is accessible from Outputs
→  Inspection  of the top menu bar, from the
corresponding button in the top toolbar, or from
the contextual menu of any point cloud
(structured or not) and any mesh.

The result of the inspection is a new color layer
that will be assigned to the point cloud. This color
layer carries, for each point its measured distance
from the reference model. After performing
Inspection It is possible to use the Colors mapping
dialog function to map these measures with
colors chosen by user and to see the
corresponding color scale and Histogram.

Input models
As inputs, user must provide a model to inspect and a reference model. The model to inspect must be
a point cloud. The reference model must be one triangle mesh.
User can input the desired models by simply dragging and dropping them, or by pressing Load model to
inspect and Load reference model. Press Remove to deselect undesired models from your import.

Parameters
At the center of the dialog there is the Parameters box that takes:

· Max search distance: every point of the model to inspect will be compared with the reference
model only inside a sphere with a radius defined by this parameter.

· Subsampling (factor s): allows to balance speed versus precision.
There are two cases:
- Inspect an unstructured point cloud: the cloud will be divided in s sets of points and only one
point in each set will be inspected. The other s – 1 points will be assigned the same distance
value measured for that point.
- Inspect a grid point cloud: the procedure will scan the points according to their structure. The
grid's structure will be divided in cells of dimension s by s. Only one point per cell will be
inspected and the other points will get the same inspection value measured for the first.

· Inspection name: to define a name for the layer that will be that will be generated
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Inspection types
User can select the Inspection type to be performed by clicking " Change Inspection type" button.

There are three choices:
· Distances as signed values : distances will be

computed with positive sign when measure direction is
oriented in accordance with the normal at the point to
inspect, negative otherwise.

· Distances in absolute values : distances will be
computed in absolute value absolute values.

· Signed distances along one direction
o Cloud's origin direction: is much faster, but on the

other hand less accurate than the former two. For
each point in the input cloud, is cast a ray from the
cloud's origin and is computed where the ray
intersects the reference surface. Finally, is calculated
the distance from the point along the ray. Since this
procedure only looks in one direction, it can measure
infinite distance for a given point while the reference
surface may be very close to the point along another
direction.

o Axis direction: takes each point of the cloud and
computes its distance from the reference model along
a specific axis. User can choose one of the three axes
of the current UCS. This inspection type is faster, is
usable with a great Max search distances(e.g. 50m) and
it provides signed distance values (signs are calculated
using the normals of the reference mesh's triangles).

Finally, press Process to start the inspection. The resulting layer is appended to the color type list of the
inspected point cloud, with the desired Inspection name. Use Colors mapping to optimize the display with
a legend.

See this videotutorial to learn how to mage with change detection tool.

Tunnel survey
Cylinder virtual
scan

The virtual scanning can here be done in cylindrical projection using a 
cylindrical projector as a virtual scanner.
To properly set the metric pixels refer to the spreadsheet
downloaded from the reserved area on gexcel.it site.

Generate cross
sections

To generate a multiple cross section (with a defined spacing between
planes); all of them are normal to a selected flythrough, a trajectory
that describes the elongation of a tunnel.

See also this videotutorial that shows the whole process.

Video Record

Video Record

https://www.youtube.com/watch?v=T8wBRbAhbLQ&list=PL3PJ9b9USDYR0kkBSWne8p1oBeodi4req&index=13
http://gexcel.it/en/software/jrc-3d-reconstructor/full-full-educational/tutorials
https://vimeo.com/73366602
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In   JRC 3D Reconstructor® the creation of a video of your 3D model is possible, by using the Outputs-
>Video Record commands:
· Flythrough Editor (shortcut key Ctrl+F): to define and edit a trajectory that the “virtual eye” of the 3D

world can go through
· Play: to start showing a preview of your video inside the 3D window
· Edit: to manage the key points and the output videos's parameters
· Make movie: to extract a video

Flythrough Window
This window allows to define and edit a trajectory that the
“virtual eye” of the 3D world can go through, to generate a
flythrough video. You can input a sequence of key points
that you want the virtual camera to pass through, to
generate impressive flythrough videos of your models.
A trajectory is made up of a sequence of view points (called
Keys) which are then interpolated. 

The dialog allows to
· Add key: appends the current view point to the list
· Insert key before: inserts the current view point before the selected key in the list
· Delete key: deletes the selected key
· Clear: clears the list
· Update trajectory: if at least 2 keys are defined, a temporary trajectory is computed for the

checked keys (uncheck to skip the key) that can be simulated (Play from) or added to the project
(Add to project)

· Play from: if a valid trajectory exists, an animation of the trajectory rendered, starting from the
selected key, using the desired speed

· Stop: stops the current simulation
· Movie: the Movie dialog is shown to select the parameters to create a movie from the flythrough
· Add to project: adds the current trajectory to the project
· Close: hides the window

Double click with the left mouse button on a Key to jump to the view point.
If a flythrough exists in the project tree, by selecting Edit in its context menu the Flythrough Window is
shown with the Keys that make the trajectory.

See also flythroughs and movie dialog.

Movie Dialog

Movie Dialog
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This dialog allows you to create a movie out of a video trajectory in your 3D scene.
Input the video file name, the movie resolution, the frames per second (FPS) and press Create. Then, a
dialog appears and asks to select the desired video codec (between those present in your PC) and
compression parameters. Subsequently, video encoding starts.

See also flythroughs, and flythrough editor.

Drawing tools
Constrain draw to
plane

To turn on the function to pick 3D points in the scene in a way that
their projections on a formerly chosen plane are selected and shown
in the point list window.

Link to AutoCAD Before activating this function, AutoCAD with the Kubit plugin must be

running. When the link is enabled, all the points selected in Point Pick

mode or in the Virtual Scan dialog or in the Edit 2D grid dialog are sent

to AutoCAD.

Save snapshot

Save
snapshot

This function allows you to capture a snapshot of the 3D scene with its
rendered models. You can save the captured snapshot in a variety of image
formats, including Bitmap, Jpeg and PNGSave snapshot.

Manage units of measures
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This dialog allows you to set the preferred units of
measure for lengths, areas and volumes; and to set
how many decimal digits should appear in JRC 3D
Reconstructor® 's output data. This function,
therefore, gives you a great amount of countrol on
how lengths, areas and volumes should be formatted
in all Reconstructor windows, outputs, PDF reports,
etc.

Presets
On the top of the above dialog, you can activate some presets:

· SI (International system of units) will set meters as length unit, square meters as area unit and
cubic meters as volume unit.

· Imperial system of units will set inches, square inches and cubic inches as length, area, and volume
unit respectively. This button features a popup menu that gives you other two options: to use feet
and to use yards as basic measure unit for length, area and volume.

· U.S. customary units will set the U.S. survey feet as predefined length unit, the U.S. square survey
feet as area unit, and the U.S. liquid gallons as volume unit.

Selecting the units of measure
In the middle box of the dialog, you find three controls to select the length unit, the area unit, and the
volume unit to be used across all Reconstructor dialogs, visualized data and outputs.
You can select among a long list of measure units, belonging to the international system of units, to the
british Imperial system, and to the United States customary units, used for survey. Please see below the
complete table of the units of measure supported by Reconstructor.

Selecting the data's decimal precision
The last option in the dialog allows you to select how many decimals to visualize after the comma for each
output value in JRC 3D Reconstructor®. This gives you a lot of flexibility to format your output reports
according to the precision you desire, but also it asks from you that you know the precision limitations of
your sensor in the particular dataset you are working on.

Units of measure supported by JRC 3D Reconstructor® 

Lenght units
Name Suffix Amount in meters

Meters m 1

Centimeters cm 0.01
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Millimeters mm 0.001

Kilometers km 1000

Thousandths of an inch th 0.0000254

Inches in 0.0254

Feet ft 0.3048

Yards yd 0.9144

Chains ch 20.1168

Furlongs fur 201.168

U.S. links li 0.2012

U.S. survey feet US ft 0.30480061

U.S. rods rd 5.02921

U.S. chains US ch 20.11684

U.S. furlongs US fur 201.1684

Area units
Name Suffix Amount in square meters

Square meters m² 1

Square centimeters cm² 0.0001

Hectares ha 10000

Square kilometers km² 1000000

Square inches in² 0.00064516

Square feet ft² 0.09290304

Square yards yd² 0.83612736

Acres acres 4046.8564224

U.S. square survey feet US ft² 0.09290341

U.S. acres US acres 4046.873

Volume units
Name Suffix Amount in cubic meters

Cubic meters m³ 1

Cubic centimeters cm³ 0.000001

Cubic millimeters mm³ 0.000000001

Liters l 0.001

Cubic inches in³ 0.000016387064

Cubic feet ft³ 0.028316846592

Cubic yards yd³ 0.764554857984

Gallons gal 0.00454609

U.S. cubic feet US ft³ 0.02831685

U.S cubic yards US yd³ 0.764554857984
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U.S. acre feet US acre feet 1233.482

U.S. liquid gallons US fl gal 0.003785411784

U.S. liquid barrels US fl bbl 0.119240471196

U.S. dry gallons US dry gal 0.004404884
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Tools menu
Here the  In JRC 3D Reconstructor® several processing tools are achievable. 
You can find most used tools also in the Top Toolbar.

· Go To LineUp
o File
o Navigation
o Tools

· Pose & Registration
· Selection & Fitting Tools
· Points Filtering & Clustering
· Meshing
· Photo & Color
· UAV & Imaging

LineUp®

LineUp® is a tool in JRC 3D Reconstructor® that easily allow you to:
· Import 
· Preprocess
· Register 
· Georeference 

any set of points clouds (both unstructured and structured -grid- point clouds).

In general, your workflow is assisted by following the steps here illustrated:

By clicking on Go to LineUp, starting from JRC 3D Reconstructor®, you can go in LineUp® environment. 
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The LineUp® menu is subdivide in the following command groups:
· File
· Navigation
· Tools

In the Top toolbar you can find the most used commands, grouped by main processes:

Save Project 
To save the project

Process
To open the Scan Processing Wizard and  import, preprocess, preregister and register any set
of scans
Settings
To change all the setting parameters of the different steps of the workflow (see “More
Settings” in the Scan Processing Wizard)
Register
To register the imported scans. This command includes both pre-registration process (target-
free or target-based) and fine registration
Georeference
To georeference the models using known control points
Measures
To take measures on the point clouds
Go to Reconstructor
To return in JRC 3D Reconstructor® environment
Navigation commands 
To navigate in the LineUp Window
Selection tools
To select a region of point cloud and delete the area inside or outside it



Stonex Reconstructor 3

- 91 -

LineUp® Pro 
LineUp® Pro is a LineUp® extension that includes the same features of LineUp® tool to which is added
the automatic target-less registration.

File in LineUp®

Save Project 
This function saves the current project, safley storing all the project items, their load/unload
state, their properties, the current 3D camera pose, etc.
It is advised to save the project frequently, especially before long processing operations.

Import point clouds
To import every point clouds format supported by  JRC 3D Reconstructor®

Import sketch from LineUp® Notes

Go to Reconstructor
To return in JRC 3D Reconstructor® environment

Scans Processing Wizard

This wizard allows the user to 
· Import
· Preprocess
· Preregister 
· Register 

any set of scans in LineUp® tool.

Navigation in LineUp®
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Navigation in LineUp® tool is very similar to that of JRC 3D
Reconstructor®:
· Predefined views
· Navigation modes
· Screen settings

In addition, other predefined views are available:
· Slice View
· Horizontal Section View
These modes can be used to check the correct alignment along a
vertical/horizontal section of the displayed items.

Also Manage units of measure is here present.

Tools in LineUp®

LineUp® features the following categories of tools.

Point Filtering & Clustering
To filter/edit point clouds and to cluster them
Pose & Registration
To register and georeference point the point clouds and 3D models
Select
To select a region of point cloud and delete the area inside or outside it
Measures & notes
To take measures of distance and screenshot of the 3D window
Settings
To change all the setting parameters of the different steps of the workflow (see “More
Settings” in the Scan Processing Wizard)
Process
To open the Scan Processing Wizard and  import, preprocess, preregister and register any set
of scans

See also at the relative voices in the general Tools command in JRC 3D Reconstructor®.

Points filtering and clustering in LineUp®

This category of tools includes functions dedicated to work with point clouds , to enable other processes
and further results. Most of these tools work on any point cloud, some of them work only on grid point
clouds.
In LineUp® the following filtering and clustering tools are present:

· Pre-process Grids
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· Restore raw data
· Restore deleted points
· Level 3D density of clouds
· Make single cloud
· Remove duplicate points

Pose & Registration in LineUp®

The LineUp® tool includes a comprehensive suite of tools for coarse and fine registration of any
amount of scans (and not only). The registration process is composed by several steps, depending on
adopted survey techniques.

The general flow, here illustrated

starts from a  preregistration step that allows you to compute a rough alignment between the
imported models. The alignment can be later refined using ICP registration and Bundle Adjustment to
choose and refine the good ICPs and discard the wrong ones, in order to reduce the global registration
error. 

See Getting Started -> Register to learn how to use the  The LineUp® registration tools.

Registration
· Automatic, target-free preregistration
· Automatic, target-based registration
· Manual pre-registration
· Manual pre-registration among grid point clouds
· ICP cloud-to-cloud registration
· Global fine registration (Bundle Adjustment)
· Scan alignment per groups

Georeferencing
· Point cloud georeferencing
· Pick reference point

Positioning
· Pose transform
· Determine the cloud's vertical direction
· Manual positioning (adjust Pose)

Automatic Target-free Pre-registration
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This dialog enables a very effective and fast
procedure that preregisters a set of scans
automatically, without using targets or markers.

This dialog enables a very effective and fast
procedure that preregisters a set of scans
automatically, without using targets or markers.

Features
· No limits on the number of scans to preregister. You can preregister 200 scans at the same

time, the software will load at most two of them at a time.
· Easy convergence with automatic search of best overlap. To be registered together, the

minimum overlap of two scans is 20-30% of their surface. However, in most cases you don't have
to care about it, because of the following: given a set of N scans, the algorithm is guaranteed to
find all the scan pairs that match together, and to use the best overlapping N-1 scan pairs to
preregister your dataset. You can customize this behavior via the "Maximum distance in scan
sequence" option.

· No point density requirements. The algorithm adapts to the specific datasets, being it close-
range indoor, or long range territorial data.

· No complicated parameters to input such as cell size or fitting strategy. You only specify if your
dataset contains "construction" or "territorial" data: the algorithm will change accordingly the
surface elements to look for and to match.

· Very fast because of parallel computing: the algorithm is guaranteed to do all computations in
parallel, using all the cores your CPU has (unless you don't tell Windows to assign less cores to JRC
3D Reconstructor®).

· Robust against symmetric datasets. In case of rectangular empty rooms, stairs, or other
symmetric datasets, Line Up Pro is guaranteed to quickly let you browse multiple preregistration
solutions, and therefore to help you quickly find the right preregistration of your scans.

· Easy to set constraints. You can easily set constraints on the scan vertical. If you know that the
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scans are already on their vertical (with a confidence of 2-3°), you can tell the algorithm to leave
the scans' vertical unchanged. If you don't, LineUp Pro will also esteem the scans' vertical, with the
guarantee to correct angles between the given vertical and the correct one of max. 30°. As
additional constraint, you can select which of the input scans is the reference scan during the
preregistration.

· It works for virtually all datasets. This automatic preregistration technique has been tested
with hundreds of different datasets containing from 10 to 200 scans per dataset. It gets your
scans in a state of coarse registration without your intervention, or with very few easy corrections
at the end.

Parameters
Here we give a top-to-bottom description of the parameters that you can set in the dialog.

· Data Type: here you can specify if your datasets relates more to a construction scene, with many
planar surfaces, or if it relates more to a mining/terrain scene, with many irregular surfaces. This
will greatly help the algorithm.

· Speed vs precision: this algorithm is designed to be fast in first place, and to deliver a solution in
minutes or tens of minutes. We advice to leave this option to “Fastest” and to switch to the other
two options only when the first does not work. The other two options indicate the algorithm to
search for more matches between smaller surface elements. This leads in general to better
results, but in some cases it can also spoil the results because it introduces more candidate
matches for the final solution and therefore more ambiguities.

· Preregistration from sketch. By flagging this option, you tell the algorithm that you want to help
it by creating a “sketch”, or a drawing with the approximate relative positions of the scans. To
create or load a sketch, press the Create/Load sketch button. The Sketch Window opens for you to
create the sketch.

· Assume vertical is correct. Some laser scanners feature an internal inclinometer, and therefore
they are able to create raw scan data where the vertical is already correct, with an error of 2-3
degrees. If this is the case, then you can flag this option and the algorithm will match the scans
without changing their initial vertical. If this is not the case, the the algorithm will also esteem the
correct vertical before matching the scans. Please take into account that the maximum error in
the vertical that can be corrected is 30 or 40 degrees.

· Save poses before preregistration. If you flag this option, JRC 3D Reconstructor® will
automatically save the scans' poses in the Export/ project folder before starting the automatic
preregistration. In this way, you will be able to easily go back to those poses before the
preregistration, with the function Tools→Pose and registration → Pose transform → Apply pose
from file.

· All scans are tripod (no hand-held or mobile). Flag this command if you're using tripond laser
scans

· Maximum distance in scan sequence. This parameter determines how many scan pairs the
algorithm will try to match. It specifies the maximum distance in the scan sequence that two
matchable scans may have, and it defaults to 10. For example: given an input sequence of 30
scans, JRC 3D Reconstructor® will try to match scan 5 with all the following, until scan 15. Scan 5
and scan 16 will not be matched because JRC 3D Reconstructor® will assume that they are too far
away in 3D, being far away in the sequence. Generally speaking, given an input sequence
of N scans and this parameter set to M, then JRC 3D Reconstructor® will try to match scan s only
with the M preceeding and the M following it in the input sequence, considered as a circular
sequence (scanN matches scan 1).
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Sketch Window

This dialog enables a very effective and fast procedure that preregisters a set of scans automatically,
without using targets or markers.

This window enables creation, editing and handling of preregistration sketches, created in JRC 3D
Reconstructor® or in LineUp Notes. Preregistration sketches are needed to describe the approximate
relative positions of a set of scans, to give an initial hint to Line Up's automatic target-free preregistration.
However, it is not compulsory to create a preregistration sketch to run the automatic target-free
preregistration.

Usefulness
Creating or loading a preregistration sketch is useful mainly to speed up the automatic target-free
preregistration : in fact, if the scans' approximate relative positions are known, the automatic
preregistration algorithm will match only the scan pairs that belong to the registration graph: the blue
polyline connecting the scans in the upper picture. Therefore, to preregister N scans the algorithm will
match only N – 1 scan pairs instead of trying all the combinations, which can result in N ( N – 1) maches.
Therefore, automatic preregistration will be faster and will aim at the right solution more directly, avoiding
matching the wrong scans with the subsequent ambiguity and confusion.
Another usefulness lies in keeping a sketch of your scans' positions. Yet another advantage of this window
lies in the possibility of setting which scan is the reference scan, and optionally which scans should not be
used during the registration.
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How it works
In the main area of the sketch window, the sketch is shown. If the sketch is loaded from a project created
with Line Up Notes, it may show also a site orthographic plan as background. The scans are represented
as icons on the sketch related to the scanner model. Below each icon, the scan name and the scan
registration role are found. The registration role can be selected among three:

· Reference scan. The scan is not moved during the automatic preregistration.
· Moving scan. The scan will be preregistered against the others during the preregistration.
· Scan not used. The scan will not be preregistered. This is useful if you acquired scans that are not

useful for the preregistration, like hi-resolution scans of small targets, or test scans.
Just drag the scan icons around the sketch to change their position. You can change the scans' registration
roles via the Edit registration roles button on the left.
On the left, some buttons are present.

· Open sketch, save sketch, save sketch as. These buttons manage your sketch files, which have
a “.sketch” suffix. You can create a preregistration sketch from scrath and then save it, otherwise
you can open a sketch that you have imported from the iPad app “LineUp Notes”.

· Show registration graph. Toggle this button to show or hide the blue polyline that represents
the best registration open sequence for your scans. Move the scans so that the registration graph
is the best possible.

· Edit registration roles. Click this button to change the registration roles for each scan, as
explained before.

· Sketch is Ok. Select this option to close the sketch window and to go back to the control dialog for
starting the automatic preregistration taking as input the edited sketch.

· Cancel. Select this option to close the sketch window and go back to the automatic preregistration
dialog without using the sketch.

Automatic Target-based registration 

This function automatically registers a set of

scans by detecting and matching targets. The

user can start the automatic target detection,

otherwise can manually add, move and

remove targets.

For each selected scan, the user can see the number of detected targets. By clicking the eye icon, the user
can open the Target editor dialog for the selected scan.

The Detect Targets button allows the user to perform the target finding stage on the selected scans. The
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targets associated with the selected scan are overwritten.
The Register Scans button performs both the targets detection and scan registration stages. The detection
phase is skipped for scans with already associated targets.

Options
Targets diameters selection: The user can add one or more diameter values by typing the numeric value
and pressing the “plus” button. An inserted diameter can be removed by selecting it from the list and
clicking the “minus” button.
Alignment options: The user can select if the scans vertical is to be assumed known.

Note: it's necessary before to compute the confidence of the point clouds (see Pre-processing Grids) to
help the process algorithm to find the target. At least 5 point cloud's points (on the same polyline) are
needed to fit the contour of the target (an ellipse).



Stonex Reconstructor 3

- 99 -

Target Editor 

The targets editor dialog shows a 2D view of the current scan with its associated target points. The user
can manually add, move and remove targets. 
Additionally the user can also start the automatic target detection by clicking the Find targets button.

The mouse controls are the following:
· double click to add a target point;
· right click to remove an existing target;
· drag the cursor while pressing the left mouse button to move an existing target.

On the right side of the window are listed the current targets with their 3D coordinates and confidence
values. The zoom window can be centered on a specific target by clicking on a target from the list. A
target's label can be edited by double clicking the respective cell in the targets list. Note that a target label
must be unique among the same point cloud.

It's also possible to Export (both in UCS and in Local coordinates) and Import points through the relative
buttons.
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Targets Registration Report

This dialog allows you to refine and exploit the result of a target-based registration.

On top of the dialog, the mean registration error is shown, along with the editable error threshold.

In the central table of the dialog, the matched targets are listed, grouped by scan. Note that each target

can have one or more match with targets from other point clouds. 
You can uncheck a matching target pair, by pressing the checkbox on the right, and press Update

registration on the bottom left. The registration will be recomputed without the outlier and the mean

registration error will improve accordingly. 
Please note that the alignement between clouds might be lost when matches are unchecked. In any case

you can restore the original computed registration by clicking the Reset To Default button in the bottom
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part of the dialog. 
Once you are satisfied with the computed alignment, you can apply the registration and choose to save a
PDF report.

You can also uncheck multiple matches at the same time by selecting an error threshold and clicking

the Remove Above Threshold button in the top right corner of the dialog.

Manual Pre-registration (among models)

Manual preregistration quick guide
1. Select at least two models from JRC 3D Reconstructor®'s project view.
2. Select “Manual preregistration” among the registration tools. The dialog above appears.
3. In the list on the bottom right, select the reference model and the moving model. These two models

are shown in the respective 3D views.
4. Navigate as usual in the 3D views, and
5. Find at least three pairs of corresponding points between the reference and the moving models.

Double-click with the left mouse button on a model to select a point.
Right-click with the mouse on a point to remove it.

6. Press the Compute button on bottom right, and select  Apply transform if the registration error is
satisfactory. The registration error doesn't need to be good, because it can be refined via the ICP
registration.

Introduction
This function is part of LineUp's registration techniques. This pre-registration technique allows you to
manually compute a rough alignment between two models (unstructured point clouds, structured point
clouds, or triangle meshes). The alignment can be later refined automatically, using ICP registration. This
function is useful in the rare cases when the Automatic preregistration function fails.
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Reference and moving models
To use this function, please select from the project view at least two models. The models can be of any
type: point clouds (structured or not) and/or triangle meshes.
When the preregistration dialog opens up, the selected models appear in the Models to register list on the
bottom right. Please select a model as reference and a model to be preregistered against the reference.
When you select a model either as reference or as moving, the model is rendered in the corresponding
3D window. Please use the buttons above each 3D window to switch between a default view and a bubble
view of the model.
You can change the reference and moving models at any time.

Picking pairs of homologous points
To preregister the models, you indicate to JRC 3D Reconstructor® features that the models have in
common, such as building edges, window corners, etc. Double-click with the mouse on a model to select
a specific feature point. The point gets displayed in the 3D view with its label, and gets listed in one of the
point tables on the bottom of the dialog, with its label and its cartesian coordinates shown in the
current unit of measure. Right-click with the mouse on a point in the 3D scene to remove it from the list.
When you have at least three point correspondences, the error table on the bottom of the window
displays the registration error associated with each point, to offer you a way to remove the worst point
pair and select another one to improve the registration.

Finishing the preregistration
When at least 3 point correspondences are found press Compute. A dialog shows you the mean
registration error and gives you the options to immediately apply the registration to the moving model, to
copy the registration transform to clipboard to apply it later, or to cancel if you don't accept the error. You
may want to copy the transform to the clipboard if you want to move more models according to the same
transform. This is useful for example if you have a group of say 10 grids already registered among them,
to be registered against other 10 already registered among them.
To apply “later” a registration transform stored in the clipboard, select in the project window the grids you
want to apply the transform to, right-click on them and select Registration->matrix transform from the
context menu. Then select Apply registration transform in the Matrix transform dialog.
 When the pre-registration is finished, the models are unloaded from the project to free memory. Please
reload them to see them aligned.

Registration constraints
On the bottom right of the dialog, you can also add some registration constraints. You can specify whether
or not the vertical of the moving model is fixed. If you do so, you only need to specify at least two point
correspondences instead of three to compute the preregistration. Additionally, you can specify the
precision of the moving model origin's position, among four levels. If you specify that the moving model's
origin is fixed, then you only need one pair of corresponding points to get a preregistration.

Computing mutual rotation among models
There are cases in which two models just need to be rotated around the vertical by some angle each, to
get into a state of coarse registration. Many laser scanners embark GPS and inclinometers, therefore in
some situation you may already possess the approximate values of the scans' vertical and origin. If that is
the case, you can set the following registration constrains: fixed vertical, fixed center and de-flag the
option reference orientation is correct. If you do so, you only need to select at least one pair of
corresponding points, and JRC 3D Reconstructor® will compute the rotation angles around the vertical for
both the reference and the moving model (the reference model will be moved as well).
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Manual Pre-registration (among grid point clouds)

The pre-registration technique allows you to manually compute a rough alignment between two grid point
clouds. The alignment can be later refined automatically, using ICP registration.

Accessing the preregistration dialog
You can access this dialog from the button Registration in JRC 3D Reconstructor®'s top toolbar.

Defining the reference and the moving grid
From the list of grids in the dialog, choose the reference model and press Set reference grid, then select
the grid to move and press Set moving grid. The two grids appear as range images on the right and left
panel of the dialog respectively.

Finding corresponding points
The preregistration procedure works by finding three couples of corresponding points among the
reference and moving grids. If needed, you can register one moving grid to more reference grids: to do
so, change the reference grid to another from the loaded ones, the image-grid point pairs are stored for
each grid, and are accumulated.

Keyboard/mouse event Effect

LMB double click Selects a point. Selected points are listed in the
tables moving grid and reference grid at bottom of
the dialog

Mouse wheel rotates Zooms the range image in/out centering on the
hovered point

Key 'z' Toggles the Zoom views shown at the bottom of
the screenshot

Ctrl + LMB + move mouse Moves the zoomed region inside the global view
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Space bar Rotates the range image of 90°

Shift + LMB + move mouse Translates the range image

RMB on a selected point Deletes the point

LMB on a point + move mouse Moves the point around

Alt + central mouse button Fit image to window

Alt + RMB Reset image to original size

When three or more couples of points are selected, the table error per point shows the alignment error
per point couple. The mean registration error is instead shown at bottom left of the dialog. In general a
pre-registration error of 2 cm is acceptable. However, this depends on the scale of your project and of the
final output you want to get. If a point couple introduces too much error, you may try to move slightly
around the points after zooming on them, to improve that couple's error.
Try to change the color type of the grid on top of the window to improve the contrast of features. Press
the right arrow to show a menu of available commands for the current color type for better adjustment.
The list of points is shown in the table, where every cell is manually editable to force the values, like for
geo-referentiation.

Finishing the preregistration
When at least 3 point correspondences are found press Compute. A dialog shows you the mean
registration error and gives you the options to immediately apply the registration to the moving grid, to
copy the registration transform to clipboard to apply it later, or to cancel if you don't accept the error. You
may want to copy the transform to the clipboard if you want to move more grids according to the same
transform. This is useful for example if you have a group of say 10 grids already registered among them,
to be registered against other 10 already registered among them.
To apply “later” a registration transform stored in the clipboard, select in the project window the grids you
want to apply the transform to, right-click on them and select Registration->matrix transform from the
context menu. Then select Apply registration transform in the Matrix transform dialog.
 When the pre-registration is finished, the grids are unloaded from the project to free memory. Please
reload them to see them rendered.

ICP Cloud to Cloud Registration
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ICP Registration is an
algorithm to
automatically perform
fine registration of a
moving point cloud
against one or more
reference clouds. The
moving cloud must be
roughly close to the
reference cloud. It is
possible to roughly
align the moving cloud
by pre-registering it.

Accessing the ICP Registration dialog
You can access this dialog from the button Registration in LineUp's top toolbar. 
The ICP algorithm works on both structured and unstructured point clouds. The requirement is that the
point clouds have the normals calculated, i.e. have the Inclination among their colors. If a point cloud
doesn't have the inclination, during processing ICP will issue an error message. Inclination can be
computed for grid point clouds during preprocessing.
Just drag and drop point clouds from the project window to the ICP dialog to register them. The clouds will
appear in the top-left list in the dialog.

Setting the clouds' registration roles
In the top-left list, each cloud is listed with its name and its registration role. By clicking the button at the
right of any cloud's name, you can select its registration role among three: each cloud can in fact be a
reference scan, or a moving scan, or simply not used.
A reference scan will remain still in its position during registration, while a moving scan will be moved to
align it better to the reference clouds. You can have as many reference scans as you want, but you must
have exactly one moving scan to run ICP.
Example:  suppose you need to register 10 clouds together. You may want to drag and drop them all
onto the ICP dialog, then register the first two, then register the third using the first two as reference, and
so on, gradually registering the point clouds on the ones already registered.

Using a preregistration report to finely register a set of clouds
If you have a set of clouds already preregistered using automatic preregistration, you can automatically
run in batch a sequence of ICPs that will register your clouds. Press the button Start from preregistration
report, then select the preregistration report you want to use (usually found in the Results/Reports project
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folder). Below the button, a confirmation message appears ensuring that the report has been correctly
loaded and that you can press Process to register all your clouds. After that you have loaded the
preregistration report, you are not allowed anymore to change the registration roles, since the reference
and moving scans are already defined by the report. This technique will use the minimum number of
pairwise ICPs to register your clouds: if you have N clouds, N – 1 ICPs will be needed, as many as the edges
of the minimum spanning tree that connects all your clouds. The information about which is the minimum
spanning tree is contained in the preregistration report.
Comparison with Bundle Adjustment. JRC 3D Reconstructor® offers two algorithms to finely register a
set of point cloud starting from a preregistration report: the one usable via this dialog, and Bundle
Adjustment. Which one to use? 
As said, the algorithm available here uses the minimum possible number of ICPs to connect your clouds
to each other. Therefore, if your clouds form closed sequence (e.g. a loop around a building, or inside a
hall), you have no guarantees that the first cloud will be aligned with the last. Bundle Adjustment, instead,
is designed to use as many ICPs as possible, to connect each scan with all its neighbours in order to
globally register all your data. 
In conclusion: if your scans are positioned in a strict sequence, you should use the present method,
because bundle adjustment may try to register together clouds that have no significant overlap with each
other. If, on the other hand, your scans form a loop or a closed sequence, you should definitely avoid the
present method and use a bundle adjustment.

Setting the ICP parameters
ICP stands for Iterative Closest Point. The algorithm finds points on the moving cloud that are close to the
reference clouds. These points are called control points or inliers. The algorithm then iteratively moves
the moving cloud to reduce the distance of the control points to the reference models. After each step of
movement, the control points are recomputed.
Once the reference and moving clouds are set, the user can also tune several parameters of the ICP
algorithm, displayed in the Parameters box on top right of the dialog. The default parameters should work
fine for most cases. However, here a full explanation of the ICP parameters is provided.
ICP parameters are divided in three groups: parameters that define how to search for inliers, parameters
that define the convergence criterion, and parameters that define registration constraints.

Inliers search parameters
· Max search distance. If the models have a bad pre-registration, try to increase the Max search

distance, but the process will be slower.
· Number of control points. Tune the number of control points to the size of the models. The

model to register (not the reference) is sampled with Number of control points. At the beginning of
ICP, a search distance S is computed. Control points from the moving cloud are considered only if
they are closer to the reference models than S. S is calculated so that it is betweenMinimum
search distance and Maximum search distance, and so that at least Sufficient control points can be
found in the moving cloud to be closer than S to the reference clouds. If such an S cannot be
found, for example because the clouds are too far away and therefore the control points are too
few, ICP stops and an error message is issued.

· Sufficient control points. See explanation above.
· Minimum search distance. See explanation above
· Min number of control points. During ICP iterations, the control points are recalculated. If at a

certain iteration they are fewer than this value, ICP stops and an error message is issued.
· Max normal divergence [deg]. Two points close to each other are considered not matching if

their normals are diverging more than this angle. This is useful to filter out from the registration
noisy data like vegetation, foliage, or moving objects like cars or people. The assumption is that
points belonging to the same object should have also the same normal direction.

· Min. scan bounding box overlap (%). At the algorithm's beginning, the moving cloud's bounding
box is compared with the bounding box of each one of the reference clouds. If the overlap
between the bounding boxes is lower than this value, the reference cloud is not considered by the
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algorithm.

Convergence criterion parameters
· Registration error [m]. Tune this parameter to select the desired registration accuracy. ICP will

stop iterating if the mean registration error goes below this value. The other parameters that
influence ICP's stop criterion are: Registration delta-change and Maximum number of iterations.

· Registration delta-change (%). ICP stops if the error-delta between three iterations is smaller
than this parameter. Let's call this parameter d. Let's also define e(n) to be the mean registration
error at iteration n. ICP will stop iterating if, at iteration n, [(e(n – 3) – e(n)) / e(n) ] < d.

· Minimum number of iterations. ICP will execute at least this number of iterations, and then will
start checking the break criterion.

· Maximum number of iterations. ICP will do at most this much of iterations.

ICP constraints
· Vertical is fixed. Set it to true if you know that the moving scan is already set on its vertical in the

current UCS.
· Translation is fixed. Set it to true if you want to constrain the origin of the moving cloud to be

fixed. Ths is useful if you know with great precision (e.g. via total station) the coordinates of the
scan's origin.

When the parameters are set, press the button Process on bottom left. ICP begins, showing log messages
in the right-central Result panel of the dialog. Also, the graph on bottom right displays the error histogram
for each iteration. This is useful to see at a glance whether the algorithm is converging.

 Finishing the registration

After finishing the registration, the dialog pictured above shows you the mean registration error and
offers you three options: to immediately apply the registration to the moving grid, to copy the registration
transform to clipboard to apply it later, or to cancel if you don't accept the error. You may want to copy
the transform to the clipboard if you want to move more grids according to the same transform. This is
useful for example if you have a group of say 10 grids already registered among them, to be registered
against other 10 already registered among them.
To apply “later” a registration transform stored in the clipboard, select in the project window the grids you
want to apply the transform to, right-click on them and select Registration->matrix transform from the
context menu. Then select Apply registration transform in the Matrix transform dialog.
 When the registration is finished, the grids are unloaded from the project to free memory. Please reload
them to see them rendered.

Bundle Adjustment
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Solving a puzzle of a thousand
pieces
To understand bundle adjustment, we
can imagine to solve a big puzzle with
many pieces. Each piece matches with
four others, sometimes the match is
easy, sometimes you have to slightly
push a piece inside another, and
sometimes two pieces just don't
match. Often, you need to know the
neighboring pieces to decide whether
two pieces match correctly or not. And
the pieces reach their final, adjusted
positions only when the puzzle is
complete. If ICP registration can be
seen as finding the match between two
pieces, Bundle Adjustment means
completing the whole puzzle by
choosing and refining the good ICPs
and discarding the wrong ones.
This algorithm allows to register
together many point clouds,
distributing evenly the registration
error. The user specifies which point
clouds are reference clouds (they are
locked during the registration) and
which are moving; the moving clouds
will move and align on the reference
clouds and between them during
alignment. While the ICP
registration works only for one pair of
clouds at a time, this algorithm
registers together N clouds at the same
time, diffusing and minimizing the
global registration error. The input
point clouds must be pre-registered.
They do not need to be structured but
they need to have the normals. There
is no upper limit to the number of the
input clouds.

How does it work
Given a set of N scans, the algorithm will create as many connections among pairs of neighboring scans as
possible. For each connection, a pairwise ICP will be executed, using the Settings accessible from the Line
Up top toolbar. From each ICP, the best matching point pairs between the two scans will be saved. In the
end, a final nonlinear minimization step will be run only among these matching point pairs of all the
connections. The global registration error among these point pairs is minimized, having as unknown
variables the scans'poses.

Parameters
Input point clouds
Just drag the poing clouds you want to finely register from the project view, and drop them on the Bundle
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Adjustment dialog. They will appear in the top list. On the right of each cloud, a button appears that can be
toggled among red (reference scan) and green (moving scan). Therefore here you can decide which scans
must remain still during registration and which must be registered.
Preregistration report
If you have previously performed the automatic preregistration of your scans, you can use the results of
your preregistration in the bundle adjustment. Click Start from preregistration report and load the report
of the automatic preregistration, a text file by default saved in the /Exports folder of your project. The
dialog will show in the top list all the clouds that were automatically preregistered, and will adjust the ICP
settings accordingly to the preregistration error contained in the report.
Defining connections among scans
To reach the best global registration possible, this algorithm will use as many connections as possible
among your scans. Knowing the topology of your scans, you can set the Max connections per
scan parameter accordingly. If you scanned the exterior of a building, then it may be that each scan
shares geometry with 3 or 4 neighbors. If, instead, you scanned a room or a hall, then it makes sense to
say that each scan matches with other 5 or 6 scans, therefore all pairwise ICPs between a given scan and
its 5 or 6 neighbors should be launched. However, doing so there is the risk to run ICP between two scans
that have no geometry in common. In this case, the ICP error will be very high.Therefore, the algorithm
will discard bad ICPs and keep the good ones. You can set the Severity in discarding bad ICPs among
three levels as in the dialog. We advice to always select “Strict”, and only if your data are particularly noisy
(e.g. mining data) then select “Coarse”.
Global constraints
You can specify some constraints that must remain valid for all the scans during all the registration. Below
in the dialog, you can flag that all scans have fixed vertical . This is useful for example if you have
imported scans from a scanner with vertical corrector and you trust the vertical to be correct below 1°.
You can also flag that all scans have fixed origin. This means that you know already the coordinates of all
the scans'origin with a precision higher than the point density (~expected registration error), therefore
the scans will only be allowed to rotate during bundle adjustment.
Scan-specific constraints
The top of the window shows the list of scans to be registered. On the right of each scan, a button allows
you to switch between whether the scan should be reference or moving. When the scan is moving, still you
can define scan-specific constraints via theEdit constraints button. Clicking this button, a dialog appears
where you can flag whether the scan has the vertical fixed or not. Moreover, you can constrain the scan's
origin in three levels. The origin can be free to move (unconstrained), can be constrained within a certain
horizontal and vertical interval, and can be held fixed.

Output
Once you have defined the connections among the scans and the additional constraints, press Start to
begin processing. A progress bar appears, and you can also open the log window to have more detail on
what's happening.
At the end, the clouds will be moved to the new positions and their files will be saved. Therefore, you may
want to save the clouds' poses before running bundle adjustment. Moreover, a dialog appears indicating
the number of registered clouds and the global registration error. After you press OK, you can click
on Save PDF report to get a much more detailed PDF report. There also a Save .txt report option to save a
text version of the full report that can be copied to Word or Excel.

Resolution of common problems
I have run bundle adjustment, but scan A didn't match well with scan B
Get the report of the bundle adjustment, and check if the edge between A and B ( or B and A) is listed in
the section “Report by edge, sorted by error”. If it is, most likely the ICP between A and B has converged
bad: you can re-run the ICP only between A and B with different parameters, and then re-launch the
bundle adjustment having A and B among the references.
However, most likely the edge between A and B will be in the “Edges not used” section of the report, or
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even not in the report at all. If the edge (A, B) is among the not used, then try to re-launch the bundle
adjustment decreasing Severity in discarding bad ICPs. If the edge (A, B) is not in the report, then try to
increse the Max connections per scan and re-launch the bundle adjustment.
I have run bundle adjustment, but I see that the scans did not converge well, moreover the global
registration error is 4 cm while it should go down to 2 cm.
Press the Settings button of the Line Up top toolbar, and go to the ICP settings. Set the ICP parameters so
that only the very best inliers are selected. You can lower the min search distance to 0,2 m or to 0,1 m,
lower the sufficient control points to 3000, and lower the max divergence among normals to 10° or even
down to 3°. Then, re-launch the bundle adjustment. Only the best matching points among scans will be
selected, and the error among them will be minimized, resulting in a better convergence and tighter
error. You can repeat the process to improve the results.

Scan alignment per groups
What you can do if the automatic pre-registration fails?
Here the instance of a set of scans (and/or 3D models) that cannot be aligned because of a low overlap
between some scans. 
If it is possible to detect groups of scans already registered and one scan for group that has a good
overlap each other, a manual pre-registration can be run. 

A group is a cluster of items composing the project.
A Registration role for all the scans inside the group can be set: None, Same as parent, Children move
together. These roles are used to carry out a registration through groups.

The workflow is the following. Letting us help by an example...

1. Find the groups of scans already registered.
There are two possibilities to create groups:

a. Automatically
When you automatically register scans  with the LineUp® tool, groups containing just registered
scans are created by default
b.  Manually
you can manually create a group already registered scans with the specific command.

In the example below, we indentified two groups: A and B.
We want to move all the scans of the Group B onto the scans of the Group A, without losing the
alignment of the scans previously done.  

2. Apply the “Children move together” registration role to the groups that you want to align. If a single
scan is moved in the 3D space, all the other scans move together, as a rigid system.
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3. Find, for each group, a scan with a good overlap with one or more scans in other groups [in the
example Scan2(A) and Scan3(B)].

4. Carry out a manual pre-registration among models to align Scan2(A) and Scan3(B).

Since the “Children move together” registration role of the groups permit a rigid and common
movement of all the scans of the groups, this procedure is enough to align all the scans.

Point cloud Georeferencing

This function allows the geo-referentiation of multiple scans. The workflow is divided in two steps:
· Reference points selection
· Scans geo-referencing

Reference points selection dialog
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This dialog allows the selection of multiple reference points from the point clouds target and center
points.
Target points can be automatically or manually set using the targets registration dialog or targets editor
dialog tools.

The buttons in the bottom part of the dialog have the following functions:
· Automatically remove duplicate points: if two or more selected points are within a 0.2 meters

distance between each other, only the higher confidence point is selected. This option can be used
to pick only one target point if the same target was detected in more than one point cloud;

· Import selected: use only checked points for the geo-referencing step;
· Import centers: use only the point clouds center points for the geo-referencing step;
· Import targets: use only the point clouds target points for the geo-referencing step;
· Import points: use all the listed points for the geo-referencing step.

Scans georeferencing dialog
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This dialog allows the user to load external reference points for geo-referencing scans using previous
selected target points.
The buttons in the bottom part of the dialog have the following functions:

· Show points selection: opens the reference points selection dialog;
· Load external points: imports external point from a textual point list;
· Load georeferenced centers: imports the georeferenced center point of the point clouds if

present. Georeferenced coordinates for the center point can be set automatically (depending on
the format) or manually when importing the given point cloud;

· Compute registration: automatically finds the best matching points from the right and left lists
and computes the alignment between them. A registration report is shown at the end of the
process.

Pick Reference point

This function opens the Targets editor dialog.

Determine the cloud's vertical direction

Determine the cloud's vertical direction command is available
in the Pose&Registration tools.

It's used to define a plane that should be horizontal (e.g. a
floor) by double clicking on it and to set the vertical direction
of the point cloud (z axis) as the normal direction of this
plane, by rotating the point cloud.
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Select in LineUp®

You can find the command Select in Tools or in the upper right side of the Top tool bar in
LineUp® environment.

You can switch between navigation and selection mode by pressing the spacebar.

The pick mode is the way to interact with the 3D data displayed in the rendering window
The Select command helps the user to sample points in the current visible frustum from the loaded point
clouds. Both 3D and color is sampled. The shape of the region can be chosen with the selection mode
menu.

Rectangle
To make a rectangular selection of the point clouds in the current view.
Press Left Mouse Button (LMB) for the first point and keep it pressed while dragging the mouse
to the second point, then release the LMB.

Polygon
To make a polygonal selection of the point clouds in the current view.
click LMB for each point of the polygon. Close the polygon by double clicking the LMB.

Lasso
To make a free hand selection in the point cloud view.
Press Left Mouse Button (LMB) to start the polyline and drag the mouse to draw, then release
the LMB to close the polyline.

Complex selections can be performed by holding down special keys:
· Union: Shift
· Difference: Alt
· Intersection: Shift+Alt

There's two ways to delete points just selected:

Delete inside
The points that fall inside the selected region are deleted from the view. They can be
undeleted at a later moment.

Delete outside
The points that fall outside the selected region are deleted, and can be undeleted at a later
moment.

See also Restore Deleted Points to learn how to undelete points.

Measures & notes

Measures & notes in LineUp®

In LineUp® tool you can take:

Distance This button allows you to measure a distance between any two points in the
3D scene. After activating this button, press the Left Mouse Button of the
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mouse (LMB) for the first point and keep it pressed while dragging the
mouse to the second point, then release the LMB. A result dialog will pop up
displaying the distance between the two points. You will be offered the
option to save the distance as an annotation in your project.

Save
snapshot

This function allows you to capture a snapshot of the 3D scene with its
rendered models. You can save the captured snapshot in a variety of image
formats, including Bitmap, Jpeg and PNGSave snapshot.

LineUp® Settings Dialog

In this dialog, the user can specify advanced settings for Line Up®'s scans processing workflow.

See also Point Filtering & Clustering and Pose & Registration.

Process (LineUp®)

This function opens the Scan Processing Wizard.

 
You must simply follow the subsequential instruction to import, preprocess and register point clouds.
By clicking on More Settings the LineUp Setting Dialog will appear.

LineUp Setting Dialog
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The LineUp Setting Dialog is available in the Process
command.

It's splitted in several tabs, concerning:
· Importing
· Pre-processing
· Pre-registration
· ICP registration
· Bundle Adjustment

These processes are managed by properly setting
the parameters for each analysis step.

See details in Import, Point Filtering & Clustering and Pose & Registration.
See also Getting Started to learn how to follow an efficient workflow for your projects. 

Pose & Registration
JRC 3D Reconstructor® includes various registration techniques:

· Define Project Reference System
· Manual Positioning
· Point List Registration
· Pose Transform

Define project reference system
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This dialog allows you to quickly define a new UCS by just specifying one point's coordinates in the old and
in the new coordinate system.
You can input the coordinates in the “old” system in the left part of the dialog, and the “new” coordinates
in the right part. The button Define reference system will create a new UCS for you as desired.

You can simply copy the coordinates of a point (as below written) and paste them with “Paste from
clipboard” button filling the empty spaces.

P25 1511.342 948.368 117.280

For more sophisticated methods of georeferentiation, see also Georeferentiation.

Manual positioning (Adjust Pose)
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This window is enabled only if an item in the Project
Window is selected. Then also the bounding box of the
current item is highlighted in bold yellow. 

It' possible to manually change the pose of an object
by using the Manual Positioning window/Adjust Pose
(press CRTL+A). 

Insert the desired quantity of translation (meters) and
rotation (degrees) and press the positive and negative
buttons

to apply transformation. 

If Object coordinates is enabled, the rotation is around
the origin of the object's coordinate system and the
translation is along the axes of the same system. 

If UCS coordinates is enabled, the rotation is around the
current UCS' origin, and the translation is along the axes
of the same UCS.
A direct changing of the 3D position 

See also the Pose dialog.

Georeferencing from point list
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This dialog allows you to register a list of points, taken from a text file or from the point list window,
against another list of points that you consider as reference. In particular, these last points can be geo-
referenced.
The left half of the dialog regards the moving points. You can load them from a text file with the
button Load moving points; in this case you are invited to select a text file and then the parse point list
dialog appears. Otherwise, you can copy the points listed in the point list window via the button Copy
moving points from point list window. Then, the moving points appear listed in the left table.
The right half of the dialog regards almost symmetrically the reference points. The button Load reference
points on top right is needed to load the points from a text file, the right table hosts these points. To start
the registration, the left table has to contain as many points as the right table.
When you have loaded the points, press Compute on the bottom right. A dialog appears, asking whether
you want to register the points by coupling them according to their labels, or by trying out all the possible
pair combinations to find the best. The first option is much faster but it assumes that you are sure about
how to match your points. After you have selected either Match names or Best fit, you can refine and
make use of the results of the registration, in the Registration report dialog.

This tool registers a list of points against another list of points. For a general overview of  JRC 3D
Reconstructor®'s registration tools, see Registration techniques.

Registration report dialog

Registration report dialog
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This dialog allows you to refine and exploit the result of a registration. This dialog is used as final step of
the following procedures: single-scan georeferencing, georeferencing from point list, and platform
calibration.

· On top of the dialog, the mean registration error is shown, along with the editable error threshold.
· In the central table of the dialog, the point pairs are shown along with their associated registration

errors. Errors above the error threshold are displayed in red, and you could consider the
corresponding pair as outlier. If you uncheck an outlier pair, by pressing the checkbox on the left, and
press Update registration on top right, the registration will be recomputed without the outlier and the
mean registration error will improve.

· In the bottom part of the dialog, there are options on how to make use of the obtained registration.
The option Copy transform in clipboard is useful for having a backup of the registration transform to
use on project entities that will be created at a successive time. The option Make backup of poses of
affected project items before applying the transform will save the poses of the affected project entities
in the Exports folder of the project, these poses can be restored later via the matrix transform tool, to
undo the effects of the current registration. To access this tool, go to the project window, select the
entities you want to register, right-click and choose Registration->Matrix transform from the context
menu.

· The button Apply transform to all project on the bottom extends the effect of the registration to all the
project entities. All your project items (including annotations) will be moved according to the roto-
translation defined by the registration. The button Apply transform to a project selection will pop up a
dialog to select a subset of the project items. Only those selected items will be moved.

Pose Transform
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The Pose transform command allows you to apply to
your project entities the transforms coming from
registration functions.

In pre-registration, registration, and geo-
referentiation, you can copy in the clipboard the
transform that results from the computation.

·  The Apply registration transform button searches the clipboard for such a transform, if found, the
transform is applied to multiple models.

· The  Apply inverse transform button undoes the effect of the first button. It reads from the clipboard a
registration transform and applies its inverse to the selected project entities. It's useful if you don't like
the results of a registration.

· The Define transform matrix button allows you to manually define a transform matrix, that is post-
multiplied to your project entities. The transform must be defined as referring to the current UCS. A
common situation in which this function is needed is when you have done a point list registration and
copied the resulting transform to the system clipboard. In this case, to apply the transform press 
Define transform matrix, then Paste matrix and Commit. The selected project entities will be moved
according to the registration transform matrix in the clipboard. 

· The Apply pose from file button allows you to import the .pose files you export with Export pose. “Export
pose” is a command reachable from the context menu of any project item. It is designed to save the
positions of your project items for backup. With Apply pose from file, you can therefore move your
models to positions you saved in backup files.

Note: The pose matrix exported by export pose is different from the pose matrix displayed in the Pose
Dialog. The "export pose" function is designed to provide to the user the possibility of making a backup of
the items'positions and to restore them at a later time in case something goes wrong. Now, if "export
pose" would save the pose referred to the current UCS (that you see in the Pose Dialog), what would
happen if the user by mistake moves or deletes that UCS? The possibility of restoring the items'positions
would be lost. Therefore, "export pose" exports another pose referred to an internal, hidden, never-
changing Reconstructor global reference system.

Difference between Apply registration transform and Define transform matrix
This dialog has two buttons, Apply registration transform and Define transform matrix, that apparently
do the same thing: getting the data stored in the system clipboard, interpreting them as a “registration
transform” (a description of how move around models) and applying the transform.
The difference is as follows: 
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o Apply registration transform is suited for transforms calculated between JRC 3D Reconstructor®'s
project entities, 

o Define transform matrix is suited for transforms coming from other tools, or transforms
calculated between entities not belonging to JRC 3D Reconstructor®'s project.

That is why you can use Apply registration transform only after pre-registration, registration, and geo-
referentiation. These three tools, in fact, calculate a registration defined on JRC 3D Reconstructor®'s
project entities, and therefore the registration transform is defined in a very precise and error-resilient
way that is internal to Reconstructor. For example, if you do a registration, change UCS, and use Apply
registration transform you will still get the correct result with all the decimal precision of the
registration algorithm, independently of the UCS. On the other hand, after a point list registration you
cannot use Apply registraton transform and you have to use Define transform matrix. This is
because point list registration works with any lists of points, in principle also not coming from JRC 3D
Reconstructor®'s models, but from other sources like a total station or the Internet. In this case, having
lost the relation with the current project, JRC 3D Reconstructor® cannot generate a precise and error-
resilient registration transform of the first type and therefore point list registration returns a generic
4x4 transform matrix whose effect changes if the current UCS changes.
In conclusion, there are two buttons because there are two types of registration transforms: a more
specific and more precise one, and a more general-purpose one.

See also Pose Dialog.

Pose Dialog
In JRC 3D Reconstructor®, the 3D position of each object (except annotations) is described by the POSE
matrix (transformation matrix) that you can open pressing the POSE button in the Property Browser
Window or by using the contextual menu of items (Pose&Registration->Pose).     
                
 You can manage different UCS systems (local or global/geo-referenced).
A transformation matrix defines how a project entity is located and oriented with respect to the
current UCS. Therefore, having knowledge about transformation matrices, it is possible to perform
specific and precise translations and rotations on a project entity. 

A transformation matrix is a 4x4 matrix that specifies how an object O is located and oriented with respect
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to a global coordinate system. The first, second and third column of the transformation matrix contain
respectively the versors of the X, Y, and Z axes of the system anchored with the object O. The fourth
colum contains the translation vector of O's origin with respect to the UCS' origin. The fourth row of the
translation matrix is always (0 0 0 1).

See also Manual positioning (Adjust Pose).

Restore a Pose
You can restore an object position in case of registration and geo-referencing error once the Pose file is
saved.
To save the Pose you have to export it: 

The software automatically creates a folder PoseFiles_2013.09.04_16.29.23_304 that contains the Pose
exported. This folder is saved in the Exports folder and the name contains the date (day and time) of the
creation.
Apply the Pose file by selecting the objects desired → right mouse button → Pose&Registration → Pose
transform.

A window appears. Select Apply Pose from file and select the Pose you want to restore
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Advanced Options

This dialog is designed for advanced users, since it requires specific knowledge of 3D computer graphics,
in particular knowledge about transformation matrices.
In the dialog there is a central 4x4 table displaying the transformation matrix of the current project entity.
On the sides, the buttons Post-multiply and Pre-multiply are located.
If M is the current matrix, a pre-multiplication by matrix P is defined as

M' = M ∙ P
If M is the current matrix, a post-multiplication by matrix P is defined as

M' = P ∙ M
Any number of pre-multiplications or post-multiplications to the current matrix is possible.
Confirm any modification of the matrix by pressing Commit on bottom left of the dialog. Press Revert to
discard any modification. The upper-right Close button (x) has the same effect as Revert and hides the
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dialog.
To speed up the definition of the matrix the following operations are available:

· Copy in clipboard: copies the current matrix in the clipboard, useful for export or to paste it to
another model

· Paste from clipboard: pastes the matrix from the clipboard, confirm by pressing Commit
· Euler form: define the transformation as rotation plus translation. The rotation is defined as a

sequence of rotations along the local coordinate frame axis. The Pitch angle is around X, Heading
is around Y, Roll is around Z, in degrees. If the sequence  is YXZ, then first the rotation around
Z(Roll) is applied, then X(Pitch), then Y(Heading). Press OK and the homogenous transformation
matrix is computed.

· Axis-angle form: define the transformation as rotation plus translation. The rotation is around
the desired axis (X,Y,Z) direction by amount Angle, with the right hand curl rule. Press OK and the
homogenous transformation matrix is computed.

· Zero: clears the matrix to zero
· Identity: defines the matrix to be the identity
· Invert: inverts the current matrix
· Transpose: transposes the current matrix

 For example
Rotation around X axis by 90

degrees 
1 0 0 0
0 0 -1 0
0 1 0 0
0 0 0 1

Rotation around Y axis by 90
degrees

0 0 1 0
0 1 0 0
-1 0 0 0
0 0 0 1

 Rotation around Z axis by 90
degrees

0 -1 0 0
1 0 0 0
0 0 1 0
0 0 0 1

 Move objects with the Roto-translation Matrix

Copy Translation button: To copy the object translation (column 3). 
Use this option to translate an object on these coordinates.
1. Press Copy Translation
2. Open the Pose of the object to move
3. Select Paste translation

To translate an object according to specific coordinates, type the desired coordinates in the column 3
(first line stands for X, second Y, third Z).
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The translation will be made according to the object's UCS reference system.

Selection & Fitting Tools
In this section you can learn how to select portions of point clouds the point clouds and how to fit it with
some features.

· Select
· Point selection with polyline
· Sample to new cloud
· Fitting

Select
In this section you can learn how to select portions of one or more point clouds.

You can find the command Select in Tools-> Selection and fitting tools or in the upper right
side of the Top tool bar.

You can switch between navigation and selection mode by pressing the spacebar.

The pick mode is the way to interact with the 3D data displayed in the rendering window
The Select command helps the user to sample points in the current visible frustum from the loaded point
clouds. Both 3D and color is sampled. The shape of the region can be chosen with the selection mode
menu.

Rectangle
To make a rectangular selection of the point clouds in the current view.
Press Left Mouse Button (LMB) for the first point and keep it pressed while dragging the mouse
to the second point, then release the LMB.

Polygon
To make a polygonal selection of the point clouds in the current view.
click LMB for each point of the polygon. Close the polygon by double clicking the LMB.

Lasso
To make a free hand selection in the point cloud view.
Press Left Mouse Button (LMB) to start the polyline and drag the mouse to draw, then release
the LMB to close the polyline.

Complex selections can be performed by holding down special keys:
· Union: Shift
· Difference: Alt
· Intersection: Shift+Alt

During points selection you can choose how select points:

Deep Selection
To sample the selected region. All points that fall into the current video selection, even if they
are hidden by more prominent objects, are selected.

View Selection
To sample the selected region from the depth buffer. This means that only the visible points
will be selected. The accuracy of the points depends on the current frustum depth range. The
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number of points is exactly the one of the current screen resolution.
Suggestion: get close to the object to select and keep the maximum order of magnitude
between near and far plane in view cut planes under 4.

[See View Parameters Dialog]

Reset samples
To discard all the current samples.

There's two ways to delete points just selected:

Delete inside
The points that fall inside the selected region are deleted from the view. They can be
undeleted at a later moment.

Delete outside
The points that fall outside the selected region are deleted, and can be undeleted at a later
moment.

See also Restore Deleted Points to learn how to undelete points.

Point selection with polyline
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This is a tool for selecting points using a 3D shape, in
particular a polyline.

Drag the point cloud to be used as source of your
selection on the recipe window. Then, drag the polyline
you want to use as contour to select points from your
cloud. Then, you need to specify a planar reference. This
can be the current view or a custom plane.

The procedure works as follows: the polyline is
projected on the planar reference you chose. If the
polyline is not closed, it is automatically closed by
connecting the last point to the first. Then, the polyline
projected on the plane delimits a 2D closed region. The
points of your cloud are also projected on the plane: the
ones falling inside the projected polyline are marked as
selected, the ones falling outside are marked as not
selected.

If no points were selected, Reconstructor gives a
warning message and stops the procedure. If any points
were selected, Reconstructor creates a new
unstructured point cloud called Selection of <input-point-
cloud-name> and stores it as a new item in the project.

Samples to new cloud
You can find the command Samples to a new cloud in Tools-> Selection and fitting tools.

The management of a great project, formed by a large number of scans, can be very difficult.
When it's possible to work on a small region it's more advisable to extract a point cloud's portion to lighten
the processes.

Starting from a selection of points (see Select), the command Samples to a new cloud creates a new point
cloud called Sample and stores it as a new item in the project.

Which type of point cloud?
If you selected the points with Deep Selection command a new Unstructured point cloud is
created. 

If you selected the points with View Selection command a new Grid (structured) point cloud is
created. 

Selection and fitting
After selecting point samples with Selection Tools a surfaces fitting is possible. 
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Fit plane
Fit a plane to the current samples and add it to the project

Fit cylinder
Fit a cylinder to the current samples and add it to the project

Fit sphere
Fit a sphere to the current samples and add it to the project

Points filtering and clustering
This category of tools includes functions dedicated to work with point clouds , to enable other processes
and further results. Most of these tools work on any point cloud, some of them work only on grid point
clouds.

· Pre-process Grids
· Restore raw data
· Restore deleted points
· Edit 2D (Grid point clouds only)
· Level 3D density of clouds
· Make single cloud
· Fill holes (Grid point clouds only)
· Hide black points
· Remove duplicate points
· Resample
· Simplify points (Grid point clouds only)
· Extract edges (Grid point clouds only)

Pre-processing Grids
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During preprocessing JRC 3D Reconstructor® applies a set of algorithms to the range scans, which extract
information that is needed during further processing of the data. Press Load to add an external grid point
cloud or Scan subfolders to find automatically all grids in a folder and its subfolders. 
Press Remove to remove undesired grids. It is possible to process grids present in the current project by
selecting Pre-process from the contextual menu of the grid item in the Project Window. In this case, when
the processing is finished, the grid in unloaded from the project to free memory. Please force the
reloading to refresh the rendering. Press Start to run the processing. This plug-in creates a separate
thread for each grid so if multiple CPUs are available the processing is sped up proportionally.
All steps are applied consecutively to the selected grid by pressing the Select All button.
JRC 3D Reconstructor® never overwrites the original data. The first time the pre-processing begins, a
backup of the data is created. By default the pre-processing pipeline starts from the data in its current
state. If Use backup is checked, the pre-processing reads the backup data.
To modify the pre-processing parameters press Advanced, then select one or more rows in the list of
models with Ctrl or Shift, then select a step of processing. The parameters are updated for all the selected
models. A step algorithm can be changed by clicking the algorithm name, a combo box of available
algorithm is shown. A step can be skipped by unchecking it.
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Noise Removal
Range & Reflectance Gate
Min/Max range [m]: lower/upper threshold of the range. All pixels outside this range will be filtered
Min/Max reflectance [0÷1]: all measurements that have an intensity value outside the given interval will
be filtered.
Median Filter
Mask border [pix]: the kernel of the filter is a square mask (of side 2∙border+1) centered at the current
pixel.
Mixed Point Filter
Useful as a relative depth discontinuity filter. Mask border [pix]: the kernel of the filter is a square mask
(of side 2∙border+1) centered at the current pixel.
Min incident angle [deg]: if the line of sight from the origin of the grid to the point has incident angle to the
local surface less than this value, the point is filtered.

Compute Normals
Local Plane Fitting
Computes the local surface tangent plane for each point, based on the neighborhood of the pixel.
Mask border [pix]: the kernel of the filter is a square mask (of side 2∙border+1) centered at the current
pixel.

Edge Detection
Depth & Orientation Discontinuity
Computes geometrically significant line features from the point cloud data. Two types of edges are
extracted:

· Depth discontinuities (or jump edges) that occur where the scanner hits an occlusion and
therefore the measured range jumps from a foreground to a background value.

· Orientation discontinuities (or crease edges) that occur where the object has a sudden change of
its surface orientation.

The extracted edges are stored as a bit flag for each point.
Mask border [pix]: the kernel of the filter is a square mask (of side 2∙border+1) centered at the current
pixel.
Min depth discontinuity to flag [m]: absolute depth discontinuity to filter.
Min orientation discontinuity to flag [deg]: the current point is marked if its normal differs from the
adjacent ones of at least this angle.

Compute Confidence
Weighted Average
Computes a confidence value for each measurement, which is a measure for the reliability of the given
range measurement. The accuracy does not only depend on the type of scanner used, but amongst
others also on the following factors:

· The incident angle between the laser beam and the tangent plane of the target
· The distance to the target
· The material of the object and therefore the intensity of the reflected signal

The confidence value is computed as a weighted sum of the surface normal, the range value and the
reflectance value.
Min/Max range [m]: the range is weighted by normalizing it within this interval.
Scale factor: the confidence value calculated for each pixel is multiplied with this scale. Thus the user has
the possibility to decrease or increase the weight for a given scan manually, for example because a
scanner with higher accuracy has been used during acquisition.
Weight of range/reflectance/inclination: modify the weight as desired.
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Restore Raw Data
Input data: at least one unstructured point cloud must be selected.
This functions takes as input a set of point clouds and undoes any operation of preprocessing, deletion
and editing that may have been performed on the clouds. Its main usefulness is to guarantee that you
never lose data: if you are not happy with an editing operation or with the result of a filter, you can always
go back to the clouds' raw data, as if they were just imported.

Therefore, when applying this function:
· All deleted points are visible again
· Points “confidence” layer is deleted
· Points' normals are deleted
· Points invalidated by the range and reflectance gate are valid again
· Points invalidated by the outlier remover filter are valid again
· Points invalidated by the mixed point filter are valid again
· The effect of any application of the median filter is undone
· Flags of points as depth or orientation discontinuities are deleted

Restore deleted points
Sometimes happens that any point are deleted for mistake. 
In JRC 3D Reconstructor® there's a method to recover deleted points, even in different times, valid for
both Grid and Unstructured point clouds.
The command Tools → Points Filtering&Clustering → Restore Deleted Points (also available in the
contextual menu of the point cloud) permits to undelete all points previously deleted.

If you want to undelete only the points in a defined area, the command Predefined Views → 2D view (also in
the contextual menu of the grid Filtering&Clustering → 2D view) it's the right way. It runs only For Grid point
clouds. 
Select a region containing the portion before occupied by the deleted points using a pick mode and then
click on Undelete command.
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See also Edit 2D Grid.

Edit 2D Grid Window

This window shows a grid point cloud in its 2D representation. Like in a geographic 2D map of the world,
the grid point cloud is represented as an image where, for each point, the x coordinate is the yaw angle
(longitude) and the y coordinate is the pitch angle (latitude) that the laser had while surveying that point.
In this window you can select, delete and undelete points with several functions.

To interact with the image
· Zoom in/out: Alt + mouse wheel
· Fit the image in the window: Alt + Middle Mouse Button (MMB)
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· Reset to original size: Alt + Right Mouse Button (RMB)
· Translate the image: Shift + LMB drag
· Space bar: rotate image 90 degrees
· Show/hide zoom window: Z key
· Move zoom region inside global view: Ctrl + LMB
· While keeping pressed ...

o Shift: to perform union of regions
o Alt: to perform subtraction of regions
o Shift+Alt: to perform intersection of regions

Pick mode
· Point: pick a point. If the AutoCAD link is enabled, the 3D coordinates are sent to AutoCAD
· Rectangle: press Left Mouse Button (LMB) for the first point and keep it pressed while dragging

the mouse to the second point, then release the LMB
· Polygon: click LMB for each point of the polygon. Close the polygon by double clicking the LMB
· Lasso: press Left Mouse Button (LMB) to start the polyline and drag the mouse to draw, then

release the LMB to close the polylin

Edit operation
· Copy: create a new grid point cloud from the selected region
· Cut: delete the selected region
· Undelete: undelete the points inside the selected region
· Mirror: inverts the grid along the width. Only the ordering of the grid is changed, the 3D points

are untouched
· Flip: inverts the grid along the height. Only the ordering of the grid is changed, the 3D points are

untouched
· Transpose: transposes the grid. Only the ordering of the grid is changed, the 3D points are

untouche

Show
· Color type: display the grid with the selected color type. Press the right arrow to show a menu of

available commands for the current color type
· Histogram: the histogram tool allows to optimize the contrast by histogram stretching (available

only if the model is loaded in memory and if the current color type is 1f or 1d, i.e. a high-dynamic
single-channel point color).

· Colors mapping : point colors can be remapped to a pseudo colored scale to improve the
dynamic range, if the histogram stretching is not sufficient (available only if the model is loaded in
memory and if the current color type is 1f or 1d, i.e. a high-dynamic single-channel point color).
This tool can be also used for range segmentation and inspection.

· Global coordinates: display the 3D global coordinates of the point (i.e. using the pose of the
model). Otherwise, the local model coordinates are used.

· Save image: save the current image to file.

Level 3D density dialog
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This dialog allows to lump together in an unstructured
point cloud an arbitrary set of point clouds, structured or
not. The resulting cloud, however, will not contain all
points from the input clouds, but only those needed to
guarantee a fixed 3D density of the points.

Regularize the density of your clouds
Laser scanner data can have quite irregular 3D densities.
For example, objects very close to the laser scanner may
be sampled at one point each half millimeter, but objects
far away from the scanner may be sampled at one point
each 30/40 cm. This tool allows you to regularize the 3D
density of your clouds. The resulting regularized cloud can
then be used for meshing or for exporting in CAD tools for
further analyses.

To activate this dialog, you can select a set of point clouds
from the project window and select Point
Filtering&Clustering→Level 3D density of clouds from the
contextual menu or from the tools menu.

The selected clouds appear in the top list of the dialog.
Below, the common color layers across the clouds are
found. The cloud that results from the clustering will
contain only the color layers that are present in all input
clouds and that are chosen. Point normals will be
transformed so that they will be correct in the resulting
cloud.

Options
In the lower half of the dialog, some options are present.
The first is of course the desired 3D density, expressed in
minimum point-to-point distance. Then, you can also
select the strategy for choosing the representative point
of each 3D cell.
This procedure will efficiently exploit all CPU cores of your
PC.

Make single cloud
(Single Point Cloud Clustering dialog)
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This dialog allows to lump together in an
unstructured point cloud an arbitrary set of point
clouds, structured or not. If you want to cluster
clouds excluding duplicated or unneeded points,
you may want to take a look at Level 3D density of
clouds.

To activate this dialog, you can select a set of point
clouds from the project window and select Point
Filtering&Clustering->Make single cloud from the
contextual menu or from the tools menu.

The selected clouds appear in the top list of the
dialog. Below, the common color layers across the
clouds are found. The cloud that results from the
clustering will contain only the color layers that
are present in all input clouds and that are
chosen. Point normals will be transformed so that
they will be correct in the resulting cloud.

Below in the dialog, you can specify a subsampling
step if you do not wish to include all points of the
input clouds in a new cloud.

The clustering procedure will efficiently exploit all
CPU cores of your PC.

Fill holes
Input data: exactly one grid point cloud must be selected.

This functions takes as input exactly one grid point cloud, and tries to replace any invalid point in the cloud
with a value averaged from the point's neighbourhood in the cloud's structure. After activating this tool,
Reconstructor asks you the mask border M: the search neighbourhood of each point is defined by the (2M
+ 1) * (2M + 1) points located around the given points in the cloud's structure.

This tool is useful to cover small points in a cloud's structure, in order to get more connected meshes
using the multiresolution mesh.

Hide black points
Input data: at least one unstructured point cloud must be selected.

This functions takes as input a set of point clouds, for each of them takes the current color and invalidates
all the points in the cloud that are colored in full black (RGB components [0 0 0]).

Remove duplicate points
Input data: at least one unstructured point cloud must be selected.
This functions takes as input a set of point clouds and, for each given cloud, it invalidates any point that has
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exactly the same coordinates of another point in the cloud.
Since JRC 3D Reconstructor® 3.2, this function is automatically applied to all point clouds while importing
them. Therefore, you should not need to use it. However, you can run it on clouds imported with previous
JRC 3D Reconstructor® versions. After its conclusion, this function prints to the Log window the number of
removed points per cloud.
Once removed, the duplicated points cannot be restored in any way.

Many laser scanners write raw data files with a lot of points in (0, 0, 0) that, if not removed, risk to
undermine further processes like filtering or mesh creation. When importing clouds into Point R3, all
duplicate points must be removed.

Resampling dialog

This tool allows you to resample point clouds.
It works on any set of grid point clouds or
unstructured point clouds.

On top of the dialog you are asked to input the subsampling factor s. A new point cloud will be created
taking one point each s from the original cloud. If you are resampling grid point clouds, the resampling
operation will take into account the structure of the grid. Therefore, the grid structure will be divided in
cells with size square_root(s) by square_root(s), and one point will be taken for each cell. To clarify this, in
the grid point cloud case the dialog shows you a message with the original and the resulting grid size, as in
the figure above.

Optionally you can hyperlink the subsampled scans with the higher resolution ones. This allows you to
work with a lot of data by doing operation on the light versions of the data.

Simplify points
Input data: at least one grid point cloud must be selected.
Output: a new unstructured point cloud is created for each structured cloud in input.

This functions takes as input a set of structured point clouds. For each of them, it determines the most
relevant points from a point of view of shape description, and it saves them into the new unstructured
point cloud. These resulting clouds work as compact representations of the original structured ones. They
can be hyperlinked to the original clouds, so that you can open the original data on demand.

The function works by creating a mesh in background of each input cloud, and by inserting into the
resulting cloud the mesh's vertices.
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Extract edges dialog

This tool allows you to extract the edges of a
grid point cloud, in form of polylines. You
can activate this function from the top menu
by clicking Tools->Point Filtering & Clustering-
>Extract edges, or by the contextual menu of
any grid point cloud.

You can select which discontinuities in the 3D point cloud you want to mark as edges. These can be
the Depth discontinuities (points that are neighboring in the grid structure but far away in 3D position),
the Orientation discontinuities (points that are neighboring in the grid structure, close to each other in 3D
position, but having normals very different), or both. You can also mark as edges all points previously
marked with the User mask. This is a mask reserved for advanced operations, for example the mask filter.

The parameters Max search distance and Min edge length define the way edges are extracted. Max search
distance is expressed in pixels and refers to distances in the grid's structure (range image).Max search
distance determines how far away in the grid structure two points belonging to the edges must be
connected in the same edge. Min edge length means that all the edges composed by less points than this
parameter will be considered as noise and discarded.

Meshing
In this section you can first learn how to create triangle meshes. 

JRC 3D Reconstructor® provides 4 typologies of mesh techniques.
Different number and type of point clouds can be used as a basis to create a mesh, depending on the
meshing technique(*):

On
Grid

Point Clouds

On
Unstructure

d Point
Clouds

Suggested for…

Multiresolution Mesh
Fast meshing technique that give back light
meshes that may have holes in some
situations. ü

(one or
more)

To obtain a well
defined and fast
mesh from a single
structured point
cloud, with a good
quality/
computational time
ratio

Mesh from predefined view 
Relatively slow meshing technique that gives
back convex meshes without holes. It's a view
dependent, high defined  mesh (each point is

ü
(one)

ü
(one –

single or
clustered

Useful for façades
(using orthocamera)
and tunneling (using
cylindrical camera)
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a vertex) point
cloud)

3D Mesh 
Approximative 3D meshing not view-
dependent and taking as constraints the
points' positions and orientations (normals)

ü
(one)

ü
(one –

single or
clustered

point
cloud)

Useful for convex
surfaces. 

Topographic Mesh 
The algorithm designed for DTM models. It
gives back a watertight
Fast meshing, light, smoothed mesh useful
for isolines and volumes calculation.

ü
(one or
more)

ü
(one or
more)

Useful for land
survey and mining

(*) Follow links for procedure details.

These commands are achievable from Tools→Meshing, from Mesh tools in the top toolbar or from the context
menu of point clouds.

See the section Mesh Editing to learn all the editing meshes techniques.

Multiresolution Meshing 
Multiresolution Meshing is possible only with Grid point clouds. If you want to generate a mesh from an
Unstructured point cloud, first transform it in a Grid point cloud by using:

1. the Virtual scan tool 
2. the Tools→Selection and fitting tools→ Samples to a new cloud after selecting the unstructured

points with Selection tools and the View Selection command

NOTE
Before meshing you need to Preprocess the Grid.
During the meshing the software will use the Edges calculated at the pre-processing stage:
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· Angular discontinuity: set the angle [deg]; the
higher the angle value, the higher the detail of
the calculated edges. Close to the angular
discontinuity you will have more detailed
triangles

· Depth discontinuity: set the minimum distance
[m] two points have to be considered as
belonging to two separate objects à no
triangles are created between two far points.
The lower the distance value the more holes
are filled.

 
The Multiresolution Mesh tool is accessible from Tools→Meshing→Multiresolution Mesh, from
the corresponding button in the top toolbar, or from the context menu of grid items in the
project window.

· Press Load to add an external grid point cloud or Scan subfolders to find automatically all grids in
a folder and its subfolders. Press Remove to remove undesired grids. 

It is possible to process grids present in the current project by selecting Meshing from the context
menu of the grid item in the Project Window. In this case, when the processing is finished, the grid is
unloaded from the project to free memory. Please force the reloading to refresh the rendering. 
· Press Start to run the processing. This plug-in creates a separate thread for each grid so if

multiple CPUs are available the processing is sped up proportionally.
The meshing process is applied consecutively to the selected grid by pressing the Select All button.
· To modify the meshing parameters press Advanced, then select one or more rows in the list of

models with Ctrl or Shift. The parameters are updated for all the selected models. 
· It is possible to Save the meshing parameter and Load them for other scans or projects or Reset

them to default values.

Triangulation
The triangulation algorithm can be changed by clicking (three times) the algorithm name, so a combo box
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of available algorithm is shown.

Uniform
All the 3D valid points are connected with triangle meshes to build the range surface, without
simplification.
The algorithm checks if 2 points are divided by a depth discontinuity, in that case no “false” triangles are
created.

Save as: check the file name of the resulting mesh.
Color mapped: select the color assigned to the vertexes of the mesh (e.g. Reflectance, Color,
Inclination, Confidence, …)

Multi-resolution
Simplified (lighter) triangle meshes are created in “flat” areas and dense triangle meshes are created in
geometrical complex areas (close to edges or curvatures), satisfying an approximation error threshold.

Save as: check the file name of the resulting mesh.
Max triangle size [pix power of 2]: 2 [number of points],, it's the size of initial triangle; the value you can set
is [number of points] you want to skip in the flat area. The higher the value, the more the mesh
gets simplified. As example, a value of 4 means that a triangle will be created for a square wide
2^4=16 pixels. If the approximation error is too high, the triangle will be subdivide in smaller
pieces.
Color mapped: select the color the color layer you want to map.
Use orientation discontinuity: thepre-processed orientation discontinuity is used to drive the
subdivision process in order to preserve features such as edges. Set to TRUE to have more
triangles around the edges.
Min triangle aspect ratio: minimum accepted triangle aspect ratio. If the triangle is too thin it will be
subdivided in smaller pieces. This test is performed only for the initial triangle.

[Note: Aspect ratio of a triangle is the ratio of the inradius to its circumradius). The aspect ratio of a
triangle lies between 0 and 0.5. For triangles with an angle near to zero, the aspect ratio is 0; for
equilateral triangles, the aspect ratio is 0.5.]

Accuracy [m]: max approximation error of the mesh. The higher the value, the lesser triangles you
have.
Create texture for color mapped: a texture is generated from the selected Color mapped on the
mesh. Set to TRUE if you want the color layer not to lose resolution with the mesh simplification.

In the images below an example of the use of two different set of parameters is showed.
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See also other Meshing techniques. 

Meshing from predefined view

This is a meshing technique that provides watertight meshes. It assumes that the desired mesh is such
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that each point of it has one and only one projection according to a predefined view. In other words, it
assumes that a perspective, orthographic, cylindrical or spherical projection exists such that the desired
mesh never hides parts of itself if seen from that projection.

In order to create the mesh you need:
1) An ustructured or structured point cloud: drag from the Project window the point cloud you want to

mesh. 
2) A view: you need to indicate also which view should be used to build the mesh. The current view

can be used, otherwise you can use any camera from your project (see below for some
examples).

Create a mesh from an orthographic view:
a façade

Create a mesh from a predefined cylindrical
view: a tunnel

When the cloud and the viewpoint are selected, press Ok and wait for the end of the meshing. You
can also cancel the meshing while it proceeds. At the end of meshing, a dialog shows you the new
mesh's name and properties.

This algorithm works by projecting all the points of the cloud on a 2D surface: the near plane of the
selected projection. Then, these points in 2D are meshed with a standard 2D meshing algorithm:
Delaunay. The resulting mesh is then projected back into the 3D space.
This meshing technique is interpolative: each point of the input cloud is considered as vertex of the output
mesh. JRC Reconstructor®'s Multiresolution and Topographic meshes are,
instead, approximative meshing techniques: some points can also not be mesh vertices if they don't
significantly modify the surface's shape. For this reason, this interpolative technique is generally slower
than approximative ones, and produces heavier meshes. However, it always produces watertight
meshes. 
Heavy meshes or meshes with wrong shapes can be simplified and edited in the mesh editor.

See also other Meshing techniques. 

3D Meshing (Poisson reconstruction)
After selecting point samples with Selection Tools a surfaces fitting is possible. 

This tool allows you to reconstruct a triangle mesh from any point cloud. Unlike uniform or multiresolution
meshing, this technique does not need the input cloud to be structured. Also, unlike meshing from
predefined view and topographic meshing, this technique is not view-dependent. It reconstructs a
connected, watertight surface taking as constraints the points' positions and orientations (normals). It's
suggested to reconstruct a convex surface.
If you need to work with a set of point clouds (structured or not), it's better to lump them together in an
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unstructured point cloud using the Level 3D density of clouds command.

In the 3D Meshing Dialog you can manage some parameters to obtain a best fitted mesh.

Adding color
In the first parameter box of the dialog, you can select whether the output mesh should be
colored or not, and which of the input cloud's color layers should be used.
Specifying how many details
While meshing from predefined view is interpolative, this reconstruction technique
is approximative: it creates a triangulation that approximates the surface described by the points.
In the second parameter box, you can specify how many triangles you want to use for your output
mesh. The more the triangles, the finer the details that will be reconstructed, and also the heavier
the mesh file and rendering time.
Taking into account cloud smoothness
In the third parameter box, you can take into account the cloud smoothness. If your cloud
represents clean construction data, then select Smooth. If, however, your cloud contains noisy
territorial data, then select Noisy.
Closing holes and removing isolated components
In the last parameter box, you can specify the size of the holes that are going to be closed in the
mesh, and the size of the “islands”, small disconnected components that may have been created.
The size is computed as ratio between the area of the hole/island and the area of the whole mesh.

See also other Meshing techniques. 

Topographic meshing
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This function implements topographic meshing of a set of point clouds. This procedure takes a set of point
clouds and creates a DTM regularly sampling the clouds. The resulting mesh is watertight if the default
parameters are used, and it is colored according to the altitudes: points at minimum height are in red and
points at maximum height are in violet, passing through all hues.

The user can also input a polyline to determine the points to be meshed (seen from a nadiral view or from
a user-specified orthocamera). It is strongly recommended to input a polyline in order to help
Reconstructor to concentrate only on the useful points and to speed up the process.

If the user doesn't specify any orthocamera, one is created so that it is nadiral (oriented towards -Z axis in
the current UCS) and it contains the polyline. Once the user inputs the clouds and – optionally – the
polyline, meshing starts by pressing Ok.

The procedure is composed of the following stages:
· Virtual scan is performed from the (nadiral) orthocamera, to uniformly sample the point clouds.
· Then, spikes in the resulting samples are smoothed using a median filter based either on a

neighborhood of given size, or on a window of fixed size.
· Successively, a polynomial interpolation (ordinary gridding) is used to fill holes. This eliminates holes in

the samples and guarantees the result mesh to be watertight.
· Then, a part of the obtained grid point cloud is selected using the polyline and the orthocamera. The

selection with polyline allows the user to specify the region that he/she wants to be meshed.
· Subsequently, a median is applied to the resulting grid, to smooth it out.
· Finally, the resulting mesh is obtained by multiresolution meshing, filling all holes.

The mesh is saved in the project, under the name Topographic mesh of <n> clouds.
This procedure is relatively fast and useful especially for terrains. It outputs a mesh with nice properties:
watertight, light and smooth (without spikes). The procedure can be customized by clicking the set
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parameters button.

See also other Meshing techniques and Topographic meshing parameters.

Topographic meshing parameters

In this dialog you can set the parameters of the topographic meshing procedure.

This dialog shows from top to bottom the four stages of the topographic meshing procedure. You can
customize the parameters of each stage, and even decide to skip stages 2 and 3 by unchecking the
respective boxes.

· Stage 1: DTM generation. The terrain sampling step is the fundamental parameter of this procedure.
It is important to pay attention that this step is meaningful in relation to the dimensions of the desired
model. If I want a mesh of a terrain of 20 m², I shouldn't use a sampling step of 0,5 m, otherwise I'll get
too few samples. A small step will produce more accurate and heavier meshes. A big step will give less
accuracy and also less memory occupied by the final mesh.

· Stage 2: despiking. Despiking is very useful to delete noisy data (e.g. vegetation) and therefore to
have more precise calculations of volumes and isolines on the resulting mesh. Despiking is done with a
median filter running on the grid point cloud obtained in the former step. As the dialog shows, the
median filter can run on the N nearest neighbors of a sample, or on a window of samples of fixed size,
regardless of how many samples are actually in the window.
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· Stage 3: hole filling. This is performed by taking, for each missing sample in the grid point cloud, the
<neighborhood size> samples closest. Polynomial interpolation is used to decide the height position of
the missing sample. After the hole filling, another median filter is run on a square of samples of fixed
size. The user can save the grid point cloud obtained till here by checking Save grid to project before
meshing. This can be useful for example to mesh the grid using a color not related to the altitudes.

· Stage 4: meshing. In the end, the grid point cloud is meshed using one of the two techniques
described here. Since at this stage the grid point cloud should be smooth, regular and without holes,
there is no reason to change these parameters except for very particular cases.

Use the Reset to defaults button on bottom left if you are not sure of what is happening. However,
topographic meshing is so fast that it is worth to try many combinations of parameters and compare the
results.

Mesh selection from current view point

This function allows to cut a portion of a mesh using 2D video selection tools on the current view. It is
accessible through Tools-> Meshing->Mesh selection from current view point. When you activate this
function, the window above appears in the recipy window, and JRC 3D Reconstructor®'s 3D window goes
in Selection mode.
Drag a mesh from the project window and drop it on the window shown above. The mesh must be loaded
for the procedure to work. Use one of the three video selection tools to select the desired portion of
mesh, and press Select. The dialog shown below appears:
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The dialog above shows the name of the mesh created from the selection, and information about area
and triangles count. After closing the dialog, you may want to go back to Navigation mode by, for example,
pressing the space bar.

Mesh selection  with 3D polyline

The 3D mesh selection works with an input mesh, a
3D polyline and a viewpoint that can be defined by
an orthocamera, by a plane or by the current view.

The polyline, seen by the input viewpoint, determines a
frustum that intercepts the mesh defining a portion of
it. This portion is acquired by doing Virtual scan, and
uniformly meshing the resulting grid point cloud. The
virtual scan is always done with an orthocamera that JRC
3D Reconstructor® creates internally.

When selecting the polyline and the viewpoint, the user
doesn't need to check whether the polyline is contained
in the orthocamera's frustum, or how the polyline is
positioned with respect to the plane. Reconstructor, in
fact, creates an orthocamera whose frustum is
automatically enlarged to include all the polyline. This
automatic expansion, however, does not take into
account the mesh (this is done to fully exploit the
orthocamera's resolution on the selection region).

The resolution of the internal orthocamera is calculated
proportionally to the input mesh's vertices amount, so
that the scanning is precise enough to preserve the
input mesh's features.

If a plane is given as input, JRC 3D Reconstructor®

creates an orthocamera that points in the plane +Z
direction. If the polyline and the mesh are in the -Z
semispace, they will be included anyway in the selection
because the orthocamera will have a negative near
plane. However, the direction of the plane (or of the
orthocamera) influences the winding direction of the
mesh that results from the selection.

Mesh Editing
In this section you can first learn how to edit triangle meshes to select and to filter them and so to obtain a
better result from your data.

JRC 3D Reconstructor®  offers several functions for editing meshes:
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Mesh Editor An editing environment to perform advanced operations such
as hole-filling, borders detection, editing triangles and vertexes,
smoothing surfaces, decimating, ridges and valleys extraction.

Mesh selection from
current view point

To cut a portion of a mesh using 2D video selection tools on the
current view.

Mesh selection  with 3D
polyline

To cut a portion of a mesh using an input mesh, a 3D polyline
and a viewpoint

Make single mesh… This dialog allows to lump together in a single mesh an arbitrary
set of triangle meshes

Convert to point cloud To create an unstructured point cloud from the vertexes of the
mesh using the color attribute of the mesh

Get mesh borders as polyline To create a new polyline containing the mesh's borders and add
it to the project

Compute normals To compute or update the triangles' normals for the mesh.
Invert winding This command inverts the ordering of the vertexes for each

triangle, so the surface is flipped to the opposite side and also
the normals are inverted.

Compute area This command returns the mesh area as sum of the areas of all
the mesh's triangles

Compute volume from Z=0 plane This command returns the volume resulting from integrating
the mesh on the XY plane of the current UCS. Mesh triangles
below the XY plane will result in zero volume 

Mesh Editor

This dialog is an environment designed for advanced mesh editing operations. It works on one mesh at a
time. It is accessible from Tools->Meshing->Mesh editor, from the corresponding button in the top toolbar,
or from the context menu of any mesh in the project window.
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From top to bottom, the dialog displays the mesh's full path, then a toolbar with groups of buttons, then a
navigable 3D view to show the mesh, and lastly information on triangles and vertices count.

Top toolbar

File
This button group provides the Save and Save as options. These are needed because the edits performed
in this dialog are not automatically transferred to the mesh in JRC 3D Reconstructor®'s project. In fact, if
you close the dialog you are asked if you want to save or discard the changes.

Geometry
This button group allows you to switch between the three visualization possibilities of a mesh: only
vertices, only triangle edges (wireframe), or the triangle's faces (flat). The button backface allows you to
show or hide the triangles' backface.

Coloring
The first two buttons here allow you to change how to color the mesh: using the colors associated to the
vertices, or using a gray color that changes only according to the triangles' inclination with respect to the
light source. The button boundaries highlights in bright red all the boundary edges of the mesh, and it is
particularly useful to quickly spot where the mesh has holes to fill or imperfect boundaries that should be
corrected.

Selection
Here you can use several selection modes. 
When the button None is checked, you can navigate the mesh. By clicking Triangles, you start selecting the
mesh triangles by drawing a rectangle on the viewport. Selected triangles are highlighted in yellow. The
button Invert enables you to invert the current triangles selection. When you are drawing the selection
rectangle, keeping pressed Shift will enable you to add triangles to the current selection by drawing
another selection rectangle. The button Boundary turns on another selection mode. In this mode you can
select one of the circular boundaries that the mesh has. Boundaries are polygons formed by those mesh
edges who belong to one and only one triangle. A closed mesh has no boundaries. Boundaries selected in
this mode may delimit a hole that you want to close. After selecting the hole's boundaries, you can click
on Close boundaries in the Editing button group.

Editing
Once you have selected some triangles with the button Triangles explained in the former paragraph, you
can delete the selected triangles with Delete triangles. The button Close boundaries allows you to close a
mesh hole whose boundaries have been selected. This function works best with small and with close-to-
planar holes.

Filter
This button group contains three functions:

· Decimation This tool allows you to simplify your mesh substituting
small triangles with bigger ones if the mean-square
error introduced in this way is smaller than a user-
customizable threshold.. Simplification is based on
conveniently collapsing edges among triangles.
For each edge shared by two triangles,  JRC 3D
Reconstructor® assesses whether collapsing it or not.
Collapsing an edge means assigning the edge's two
vertices to coincide in the edge's middle point, and
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adjusting all neighboring triangles consequently. If the
quadratic error between the surface before and the
surface after the collapsing is below the parameter Max
quadric error of the dialog, then the edge is collapsed.
The algorithm tries to collapse a percentage of edges as
specified by the parameter Edge collapses, where 0.1
stands for 10%.

· De-noise This algorithm allows you to de-noise your mesh,
meaning to iteratively eliminate spikes  from your mesh,
without changing the surface's volume.
A smoothing filter is run on the mesh for as many times
as the parameter Iterations says. This filter
has anisotropic properties: it eliminates the spikes
without changing the surface's volume. Along the
iterations, it distributes the volume from the spike to the
neighboring triangles.

· Ridges&Valleys In some workspaces, this can be called Crests&Toes. This
is a semi-automatic technique to detect Ridges
(prominent mesh edges) and Valleys (reentrant mesh
edges). When you open this dialog, the ridges and
valleys are calculated and drawn in the mesh editor.
Ridges are drawn as blue polylines, valleys are in red.
Ridges and valleys can be then saved as polylines.

The idea is that tool shows you an initial extraction of
ridges and valleys, successively you refine the
parameters of extraction and see the effects of your
changes in real time. You can refine the parameters
until you are not satisfied, and then save the ridges and
valleys as polylines in the project. The parameters of
ridges&valleys extraction you can modify regard the 
curvature, the horizontality, the length of the edges and
the gaps between them. While you modify the
parameters and recompute the ridges&valleys, you can
choose to turn on or off the visualization of the ridges,
the valleys and the mesh, via the three check-boxes in
the Draw groupbox at the bottom of the dialog.

Curvature filter
The topmost slider of the dialog allows you to modify a
treshold on the curvature of the ridges and valleys.
Ridges and valleys are edges shared by your mesh's
triangles. Each edge has a curvature associated,
depending on the angle between the two associated
triangles. A threshold on the curvature filters out the
smoother edges and leaves only the steeper ones,
which normally are the most important. Scroll the slider
to see the effect of the threshold in real time.
Orientation filter
Below the curvature filter, you can also activate
a orientation filter. This filter keeps only the edges
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whose angle with respect to the horizontal plane is close
to the angle you indicate with the slider. In this way, you
can choose to keep only the horizontal edges, or the
vertical ones, or the ones with a given inclination.
Close gaps in edges
Sometimes ridges and valleys come in many segments
with small gaps among them. In the groupbox Close gaps
in edges you find a tool to close those gaps and get the
ridges and valleys as continuous polylines. You can set
the maximum gap distance to close, and press Apply.
Reconstructor will start closing the gaps from the
smallest to the biggest, without creating loops or
bifurcations.
Delete short edges
In the Delete short edges a tool comes to filter out
polylines whose total length is less that the specified
parameter. Normally you want to discard short edges
because they are not the main ones. The main ones
should instead be found by closing the gaps among
them.
General procedure
As general procedure, we advice to use the described
filters in the order given above, and to close and open
the dialog if the result is not satisfactory. Once the
extracted ridges and valleys are good enough to
describe the important edges of your model, press Save
as polylines at the bottom of the dialog. New polylines
with the ridges and valleys will be added to your project.

Make single mesh
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This dialog allows to lump together in a single mesh an arbitrary
set of triangle meshes.

To activate this dialog, you can select a set of triangle meshes
from the project window and select Meshing ->Make single
mesh from the contextual menu or from the Tools menu.

To add more meshes to cluster together, click Add files on top
left to open point mesh files (.rtm).
By clicking Process on bottom left, you start the clustering. 
A new mesh is created that simply contains all the triangles of
the input meshes.

See also clustering tools and triangle meshes.

Photo & Color
JRC 3D Reconstructor® provides several coloring tools to effectively manage the colorization of point

clouds and meshes. 

These tools can be classified according to the objects you want to color and the procedures you need to

apply: 

· Some color information is item intrinsic of point clouds and saved as a color layer

Histogram To optimize the point clouds color's contrast by histogram

stretching

Colors mapping To create an artificial colorization for a given color layer of

a point cloud. Color information can be scalar (e.g. reflectance,

range, confidence) or vectorial (e.g. inclination). It's also

possible to add layers from external images.

Color with altitudes To add to the selected point cloud(s) an extra color layer,

representing the altitude of the points with respect to one of

the tree axes of the current UCS. 

Inclination from plane To add to the point selected cloud(s) an extra color layer,

representing the inclination of the points' normals with respect

to a given plane that exists in the project. Suggestion: use it to

classify points for a further vegetation removal.

· Some color information is due to enbedded cameras or external GEOtiff:
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Create Projector To create a Perspective, Orthographic, Spherical , Cylindrical

projector or from a calibration (by importing a JRC 3D

Reconstructor® camera calibration file) using a valid image.

Import georeferenced tif This function imports a geo-referenced TIFF as an orthographic

camera. 

The coloring tools are accessible from the Tools->Photo&Color  menu or from the point clouds' contextual

menu Photo&Color. See also Photo and Color in the Top Toolbar.

To look at point clouds' color layers, select the point
cloud from the project window and set the Color Mapped
option in the Property Browser. 

See also our video tutorials on point clouds coloring. 

Histogram dialog

Given a point cloud and one of its scalar color layers
(e.g. Reflectance), the histogram tool allows to optimize
the color's contrast by histogram stretching. The
histogram shown in the dialog represents how many
points belong to a given color value.

This tool is available only if the cloud is loaded in
memory and if the current color type is scalar,
therefore it doesn't work on Inclination for example). 
The two sliders allow you to decide the start and end of
the histogram interval to be rendered. 
The Auto Cut-off button allows you to automatically set
the histogram minimum and maximum bin so that a
certain percentage (2% in the figure above) of the
histogram energy is discarded starting from zero to the
minimum value and starting from the highest
histogram bin back to the maximum value.

See also Point clouds and Colors mapping dialog.

https://www.youtube.com/watch?v=aDrWCg9SoNk&index=12&list=PL3PJ9b9USDYR0kkBSWne8p1oBeodi4req
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Colors mapping

The purpose of this command is to manage and to create an artificial colorization for a
given color layer of a point cloud.
The command is achievable from the menu Photo&Color both on the Tools Menu bar and in the
Top toolbar.

The user can manage the rest of JRC 3D Reconstructor®'s GUI while keeping this dialog open.
When a point cloud is pre-processed, extra-information is added, and this is organized into color layers.
Information can be scalar (e.g. reflectance, range, error bound, confidence) or vectorial (e.g. inclination).
User can add color layers to a cloud via functions like Inspection or Color with altitudes by clicking Add color
layer tab or from the menu .
Only one color layer at a time is rendered in the 3D scene. User can change a cloud's current color from
the layers list on the left of the colors mapping dialog or by clicking on property browser. The change take
place after pressing the Apply button.
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When a color layer is rendered, a colorization is used to associate the points' color values to a drawable
color. Only scalar information can be mapped with colors through this dialog. The color layer Inclination is
an exception: it represents the normals of the points and it is colored automatically.

Map colors tab

Layers list
On the left there is a layers list that show which layers are associated to the current point cloud.

Predefined colors buttons
On the Center there is a set of buttons to apply a pre-defined colorizzation to the current selected layer.
Buttons used to map colors are:

- Measure values (continuous) : map the current layer to a continuous Rainbow Matlab style color.
- Measure values : map the current layer to a discrete Rainbow Matlab style color.
- Single thresholding: map the current layer to solid red and blue.
User can set a threshold moving up and down the central value label.
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- Double thresholding: map the current layer to solid red and blue.
User can set two thresholds moving up and down the values labels.
- Gray scale: map the current layer to a continuous gray gradient.
- Gray scale (discrete): map the current layer to a discrete gray gradient.

Color scale
On the right there is a color scale that shows the selected colors map in combination with labels. Labels
show maximum and minimum (bounding) values and also values between colors. User can choose among
several types of color scales via Predefined buttons or by clicking on Advanced button. User can also
disable colors by clicking on the color check box.

Advanced controls
The user can master colors and design or produce to meet his or someone's individual requirements.
Advanced commands are divided in three groups.

Legend properties:
- Max to set the max value and show it in the legend
- Min to set the min value and show it in the legend
- Colors spacing that give information about width of the color
- Number of colors that is useful to set the amount of colors to use
- Use gradient to switch between a discrete and a continuous colorization
- Decimals to set how many decimal digits use

Thresholding group:
- Keep points above max if selected keep points above "Max" value else points are hidden.
- Keep point below max if selected keep points below "Min" value else points are hidden.
- Keep point of disabled intervals if selected keep points in the deselected color else points are hidden.
- Minimum confidence to set manage confidence value.

Color group:
- Combo box to chose between six color styles:

1. Single thresholding
2. Double thresholding
3. Extended
4. Gray scale
5. Rainbow
6. Rainbow Matlab
7. HSV scale
8. Customize

- Use default color when out of range
If selected color with default (Gray color determined by reflectance value) is applied else the colors map is
applied.

Histogram tab
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A colored histogram shows a statistical distribution with colors chosen by user. In abscissa, the histogram
information about current measure (each color identifies a local radius of the measure) and in ordinate it
shows a measure of how many occurrences of points are mapped to a color. The mean value is also
shown.

Add color layer tab
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User can add color layers to a cloud via functions like Inspection or Color with altitudes by clicking buttons
in Add color layer tab.
Buttons to add layers are:

- Color with altitudes. that insert a layer to color distances along an axis direction.
- Inspection that insert a layer to color distances between point cloud and a reference model (e.g.
Mesh) .
- Compute point normals that insert a layer to colors normals of points coherent to a plane direction.
- Compute confidence that insert a layer to color confidence amplitudes.
- Inclination from plane that insert a layer to color inclination angles.
- Color with range that insert a layer to color distance from the observation point.
- Add layer from image that apply an image on the point cloud (e.g. a 2Dview after a color editing)
- Merge or split layers that combine RGB and scalar layers to obtain a customized new layer of color.
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Color with altitudes
This tool works on any set of point clouds. It allows to add to the selected cloud(s) an extra color layer,
representing the altitude of the points with respect to one of the tree axes of the current UCS.

Inclination from plane
This tool works on any set of point clouds. It allows you to add to the selected cloud(s) an extra color layer,
representing the inclination of the points' normals with respect to a given plane that exists in the project.
The inclination from plane ranges from -1 to 1 and is calculated as the scalar product between the points'
normals and the plane's normal.

It's possible to use this command, e.g., to distinguish points on vegetation to points on soil (with regular
inclination) and remove them is an useful application of vegetation removing.

Create Projector
This functions creates a projector.

Five different modes are available:
· From calibration: creates a projector (perspective or spherical) by importing a reconstructor

camera calibration file (.cal);
· Perspective: creates a prespective projector;
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· Orthographic: creates an orthographic projector;
· Spherical: creates a spherical projector;
· Cylindrical: creates a cylindrical projector.
·

Note that a valid image is needed in order to create a projector.

See also Cameras.

Edit (projector) image dialog
This dialog is available only for projectors. Here is possible to edit the transparent parts of the image in
order to optimize the blending of projectors.

The editing dialog of an image of a projector is accessible through the contextual menu of the loaded
image (Edit projector image).

Data kindly provided by CLAUSS

Zoom in/out the grid with Alt+mouse wheel.

Selection mode
· Rectangle: press Left Mouse Button (LMB) for the first point and keep it pressed while dragging

the mouse to the second point, then release the LMB
· Polygon: click LMB for each point of the polygon. Close the polygon by double clicking the LMB
· Lasso: press Left Mouse Button (LMB) to start the polyline and drag the mouse to draw, then

release the LMB to close the polyline

Edit operation
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· Cut: set transparent the selected region by zeroing the alpha channel
· Mirror: inverts the image along the width
· Flip: inverts the image along the height
· Set transparent black: all pixels that are black, i.e. (0,0,0), are set to transparent by zeroing their

alpha channel

Save is enabled only if a modification as been done and it's necessary otherwise the edits will be lost.
Save as allows to save a copy of the image to another file.

Import Georeferenced TIFF
This function imports a geo-referenced TIFF as an orthographic camera. 
The image to be imported must be accompained by a Tiff World File (TFW) indicating the coordinates of
the image. 

See also projectors. 
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Windows menu
The Windows manu in the Menu bar shows the permanents windows in the application.
All the dockable windows can be opened by right-clicking on the Top toolbar and upon.
 
· Project window
· Property window
· Readout window
· Point list window
· Log window
· Manual positioning (Adjust Pose)
· Flythrough window
· Recipe Window
· GUI options: opens a dialog to change GUI settings.

Project Window
This window provides a tree view on the current project items.

The Project window lists the items loaded in the project,
organized in a tree structure, where each data type is
grouped in a separate folder.
By hovering the mouse over the item name, a tool tip pop
ups with some information about the item, like file path, file
size, etc.

To enable the rendering of an item, click the checkbox on the left of the item. The checkbox of a folder
enables/disables all its sub-items.

Each item can be manipulated by its context menu (right mouse click) which displays its commands. Each
item has properties that can be viewed and edited in the Properties window when the item is highlighted.

Items such as point clouds or triangle meshes are models. Models can be loaded or unloaded, loaded
models are listed in bold in the project window. To rename a model, right-click on it and selectrename. To
rename all other items, double click on the item's name and edit the name.

To remove an item from the current project, in the Project window select the item and press DEL key. The
files are not lost, they are simply moved to the project's Trash folder inside the project directory, so they
can be recovered.
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Multi-selection of items is possible by using Shift and Ctrl keys. Then it's possible to
· delete the selection with DEL key
· set the common properties in the Property window
· open the context menu (right click on the selection) to display the commands that are applicable

to the selection.
·

Quick model distinction can be made by pressing the “Color by ID” button on the Project window toolbar.
Each model is colored by its color ID set in the Properties window. This color is randomly computed when
the model is inserted in the project.
 
See also dockable windows, and project items.

Recently used items dialog

This dialog allows you to quickly select for a certain
operation some of the project items you used most
recently.

Many important JRC 3D Reconstructor® functions need
to have project items as input. For example, the
function “Registration” needs two grid point clouds as
input. You can start these functions by taking care of
selecting the input items first, in the project window.
However, this dialog offers you an alternative and in
some cases more efficient way of starting your
functions.

If you start a function that needs items of a certain type
as input, and none of these items is selected, then the
dialog pictured above pops up to help you. The peculiar
feature of this dialog is that it shows you the candidate
items for your function, listing them from the most
recently used to the least. If you are working repeatedly
around few items, using this dialog might be more
efficient than scrolling each time the project window
that may easily contain hundreds of items.

See also project items, and project window.

Property Window
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This dockable window is situated by default on the left side of
JRC 3D Reconstructor®'s GUI. It allows to read and edit
the properties of the current selected item(s) in the project
window.
In JRC 3D Reconstructor® each project item has properties.
There are general properties, owned by all project items, and
there are specific properties that are peculiar to each type of
project items.

General properties
These properties are common to all JRC 3D Reconstructor®'s project items, and always displayed in the
property editor:

· Hyperlink: each project item can be linked to any URL: other project items, files on the PC, web
addresses.

· Color ID: each project item has a specific color to identify it from other items. You can edit the
color ID by clicking on the       value field of the color ID property. To render the items with their
color IDs, select Navigation->Color by ID.

· Comment: this comment will appear in the item's annotation if the above property is true.
· Draw annotation: a boolean property. Each project item has an annotation, that is rendered in the

3D scene if this property is true.
· Draw coordinate frame: this property is not owned by annotations. All other project items have

an object coordinate system. If this boolean property is true, Reconstructor will render an axes
triplet to show where the object coordinate system is. This is useful for examples to know in which
direction a plane's normal is oriented.

Readout window 

The readout window allows you to see the 3D coordinates of the
points you are hovering the mouse on in the 3D rendering window.
It's accessible by right clicking on the Top toolbar.

The readout window displays information about the 3D point hovered by the mouse at a certain instant:
· Pixel column, row:  refers to the mouse position inside the 3D window, in pixels (0, 0 is the top-left

corner) 
· Pixel color RGB: the three components of the point's RGB are shown
· Depht to point: distance beetwen selected point and current view point is displayed
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· UCS X,Y and Z the coordinates of the corresponding 3D point, expressed in the current UCS, are
displayed.

From the Change units of measure button the Select Units of Measure window will appear, permitting the
change of displayed units of measures (SI, imperial or U.S. customary units).

The readout window appears docked by default in the right area of the GUI.

Point List Window

The point list window is one of JRC 3D Reconstructor®r's dockable windows. It is situated by default on the
bottom left of the GUI. The point list window works as a collector of selected points, which can then be
used for various purposes: defining a polyline, a mesh, a video trajectory, creating a plane, calculating
distances, performing point-based georeferentiation, etc.

While navigating the 3D scene, with Alt+left mouse button double click you can select points of your 3D
models. The selected points appear annotated in the 3D scene and listed in the point list window.

The toolbar of the point list window
Once you have collected some points, you can perform several operations on them. These are accessible
through the point list window toolbar. Below, the toolbar buttons are described left to right:

· Clear: removes all the rows in the list.
· Add point: adds an empty row in the list, to input manually 3D coordinates.
· Remove point: removes the currently selected row in the list. With Shift and Ctrl keys multiple

rows can be selected, and deleted with the DEL key.
· Load point list: loads a list of points by parsing them from a text file via the parse point list tool.
· Save point list: saves the point list to a text file, writing one row per point in the format label, x, y,

z.
· Create triangle mesh: this options creates a triangle mesh using as vertices the points listed in

the window. Reconstructor asks you whether you want to mesh the points projecting them onto
the current view and using a Delaunay 2D meshing algorithm, or whether you want to create a “3D
hull”: a convex 3D polygon containing all the points.

· Make point cloud: the current list of points is saved as an Unstructured Point Cloud and added to
the current project, so it can be exported to other formats.

· Create polyline: this option will store all the points in a polygon and save it as a polyline in the
project.  JRC 3D Reconstructor® asks you whether you want to create an open or close polygon.

· Fit trajectory: creates a video trajectory that runs throughout the listed points. The trajectory is
created by interpolating a spline through the points. You can select the up vector of the video
camera that will run through the points. The created trajectory is saved in the project under the
name “flythrough from point list”.

· Fit plane, cylinder, sphere: if at least 3 points are defined a fit can be computed and added to
the project.

· Measure distance: if 2 rows are selected, the distance of the 3D points is computed, even if they
are very far apart.

· Measure angle: if 3 rows are selected, the angle of the 2nd point relative to the 1st and 3rd is
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computed, even if they are very far apart.
· Geo-referencing from point list: starts a registration procedure that registers the listed points

against other points that you consider to be reference points. This is mainly useful for geo-
referentiation. This procedure has the effect of moving all your project items,
including annotations, according to the resulting registration transform.

· Create UCS from point list registration: starts a procedure to create a coordinate system that is
based on the algorithm of the former procedure. It exploits the same concept of registering the
listed points against another point list that is considered as reference. However, the final result
does not consist in moving all the project items, but in creating a new UCS and to place it so that all
the other entities appear as if they were moved according to the found registration. For example,
if the registration implies a translation of (1000, 1000, 1000), then a new UCS is created placed (-
1000, -1000, -1000) away from the current one. Then, this new UCS is set as current. One benefit
of this procedure is that you can easily undo its effects, by simply setting the former UCS back as
current. The drawback is that ambiguities may rise if you work with other users that do not use
the same UCS and assume that you have geo-referenced the data, or ambiguities may rise if you
import Reconstructor models saved in earlier projects that were geo-referenced in the other way.

Parse point list dialog

This dialog implements a general-purpose tool for parsing a text file with a list of points.

The assumption is that each row of the text file contains one point. The dialog allows you to define how
you want to interpret the columns of the text file. In the example above, the first three columns contain
the 3D coordinates of the point, column four and five contain the X and Y coordinates of the point in the
range image (or in any image), and the sixth column contains the label of the points. Using the spin boxes
in the bottom half of the dialog, you can customize the role of each column of the file.

This tool is used to parse point files in the following procedures and windows: Camera calibration,
importing a polyline from .txt format, Geo-referentiation, Point list registration, and pre-registration.

Log Window
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Button clicks, status of algorithms, errors and warnings, result of procedures... everything that happens
inside  JRC 3D Reconstructor® is logged and shown in the text panel displayed in this window. Log
messages can be of four types: information, warning, critical and fatal. Log messages appear always with
their type and the time instant.
The log window is by default docked in the bottom right area of the GUI.

GUI Options dialog

This dialog allows the user to change some GUI
settings.
The first two checkboxes control how freely the
dockable widgets can be moved around and
detached.
There are also two buttons to reset widgets'
positions to a default. These defaults are decided
by the current workspace configuration, internally
known by JRC 3D Reconstructor®.
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Help
Through this menu you can access JRC 3D Reconstructor®'s Online Help system. Furthermore, you can
also access diagnostic information, useful when asking for support. Moreover, you can enter JRC 3D
Reconstructor®'s license manger, to browse the license features activated and activate new ones.

· Online help
· Video Tutorials
· About plugins
· About JRC 3D Reconstructor®

Online help
This menu voice opens the present online help (which can be invoked also by pressing F1). 
You can also open the contextual online help about the current window by just pressing F1.

Video Tutorials
Please click on the following links to browse a list of JRC 3D Reconstructor®'s video tutorials on the web.

> Watch YouTube videos 
> Watch YouKu videos

You can also find other tutorials on the relative pages of software's description.

About plugins

https://www.youtube.com/playlist?list=PL3PJ9b9USDYR0kkBSWne8p1oBeodi4req
http://i.youku.com/gexcel
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The menu option About
plugins shows you a list of
plugins. This is useful to know
which import/export formats
are currently available in JRC
3D Reconstructor®, and to
know if a particular algorithm
(e.g. LM-ICP bundle
adjustment) is installed or
not. When asking for support,
you can be requested to send
a screenshot of this window.

About JRC 3D Reconstructor®



Stonex Reconstructor 3

- 171 -

This menu option opens the About JRC
3D Reconstructor® 3 window. This
window displays JRC 3D
Reconstructor®'s complete version
number and other diagnostic
information. When asking for support
from Gexcel s.r.l, you may be asked to
produce a screenshot of this dialog, or
to report some information from this
window.
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Glossary
In this section you can find all the main definitions that you can encounter during the usage of JRC 3D
Reconstructor®.

Annotations

JRC 3D Reconstructor® allows you to place
annotations of your 3D models in the scene.
These annotations may appear as items in
your project. Annotations can be of three
types:

· Point annotations
· Distances
· Angles

You can create an annotation via the menu options in the Output->Measures & Notes -> Annotation  menu
or the corresponding buttons in the top toolbar. To create a punctual annotation, select the “annotation”
button from the aforementioned menu and double-click on any point of your 3D scene.

Distance annotations are used to measure the distance between two points in the 3D scene. Select 
Output->Measures & Notes ->Distance, then press the left mouse button on the first point of the segment
to measure, move the mouse and release the left button on the end point of the segment. JRC 3D
Reconstructor® shows you the distance measured and asks you whether you want to store it into the
project.
Selecting the Output->Measures & Notes ->Angle button, you have also the option to measure angles. You
define the angle you want to measure by left-clicking on three points of your 3D scene.
In the properties of any annotation, you can change its color ID, edit the displayed comment, define a
hyperlink for an annotation (interesting feature to add meta-information to your 3D scene from e.g. the
web) and choose whether to draw the annotation or not.

Annotations are stored in form of point collections. Therefore, they don't have a pose matrix like all the
other project entities and cannot be moved or rotated through adjust pose or the pose dialog.

Cameras
A camera is a project entity that defines a viewpoint in your virtual 3D world. A camera has a pose (like all
project entities) that defines the camera's position and orientation. A camera has also a projection that
defines how the camera sees the world.
There are four types of cameras, according to their different projections:

· Perspective cameras
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· Orthographic cameras
· Cylindrical cameras
· Spherical cameras

The editable properties of the cameras are:
· Comment: user comment
· Draw coordinate frame: draw the local coordinate frame of the frustum
· Clip far plane: distance of far clipping plane in meters. Specifies the maximum rendered depth.

Must be greater than Min depth
· Clip near plane: distance of near clipping plane in meters. Specifies the minimum rendered depth.

For perspective cameras, only values greater than zero are allowed
· Image size (Width, Height): size of the image in pixels (used only as a place holder for repetitive

virtual scanning)
· Shadow depth bias: This parameter concerns shadows calculation for a projector. Sometimes,

during shadow calculation, there can be some noise while assessing which object is in foreground
and which is in shadow. If you increase this parameter, the effect of noise is reduced, however the
shadows risk to be not realistic anymore. If you decrease it, you will get more precise shadows,
but you risk to get salt and pepper effects: as if the color projected fell also on the object in
shadow in small grains.

Furthermore, there are specific properties for each of the camera projection types:
· Perspective cameras:

o Vertical field of view (degrees)

· Orthographic cameras:
o Extent on X [m]
o Extent on Y [m]
o Keep aspect ratio for image size

· Cylindrical cameras:
o Length [m]
o Radius [m]
o Longitude begin [deg]
o Longitude end [deg]
o Slices

· Spherical cameras:
o Radius [m]
o Longitude begin [deg]
o Longitude end [deg]
o Latitude begin [deg]
o Latitude end [deg]
o Slices
o Stacks

These particular properties, that change with the camera type, define the frustum of the camera,
together with the near and far plane. The frustum of a camera is the 3D region of space that the camera
sees. It is a pyramid for perspective cameras, a 3D rectangle for orthocameras, a cylinder and a sphere
respectively for a cylindrical and spherical camera.

From the contextual menu of any camera, you can activate also the following commands:
· Go to: to jump to the camera view point.
· Invert direction: to invert the direction of the view of the camera
· Apply projection: to jump to the camera view point and apply the camera projection as the

current rendering projection (if perspective or ortho)
· Duplicate as: to create a new camera copying the transformation of the current one
· Fitting
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o Set optimal depth range: to automatically compute  the tightest near and far clip plane
positions

o Select projectors in this frustum controls which cameras meet these two conditions:
a) have a focal axis that forms an angle with the focal axis of the selected chamber lower than
"Maximun incident angle"
b) have a frustum that intersects the frustum of the selected camera

The projectors/cameras are so checked in the project window
o Select models in this frustum finds (and checks) the meshes intersecting the selected

camera (useful for texture mapping)
· Elevation&Plan->Virtual scan: uses the camera frustum to resample the scene and generate a

new grid point cloud or an image.

Warning: to optimize the depth accuracy of the virtual scanner, try to keep the clip near and far planes as
close as possible to the desired scene depth range.

Flythroughs (video trajectories)

A flythrough, or video trajectory, is a trajectory that runs in
your 3D scene, defining how a video camera will move around
in your scene to capture a movie. A flythrough is the
“backbone” of the movie you're creating of your 3D scene.
In the picture above, the red curve line is the trajectory that
the video camera does. The yellow segments are the optical
axes of the video camera for each video frame.

Flythrough creation
The easiest way to create a flythrough is by using the flythrough editor: you can define keys, or important
positions you want your video to pass through, and then interpolate the remaining frames. You can also
create a flythrough via the point list window. The difference is that with the point list window you can only
use points that belong to existing models to define your trajectory, meanwhile with the flythrough editor
you can choose your keys in total freedom.

Operations on flythroughs
If you right-click on any flythrough, you have access to some useful operations. You can play the
flythrough, to see a preview of the video associated with it. You can edit the flythrough, and then the
flythrough editor will appear to allow you to add or delete keys to your trajectory. You can make movie,
and then the movie dialog will enable you to specify the video encoding parameters to produce the final
video. These three options are also available through the top menu, via Outputs->Video record.

From the flythrough contextual menu you can access the submenu Tunnel survey with two functions
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designed for flythroughs:
· Cylinder virtual scan. This function will enable you to virtually scan your 3D scene by looking at it from a

cylindrical camera whose “backbone” is the flythrough. More concretely, JRC 3D Reconstructor ® will
split your trajectory in many segments, each segment running from point T(t) to point T(t + 1), where
T(t) indicates the point on trajectory T at time t. Out of each one of those segments, a cylindrical
camera will be created having as main axis the segment. JRC 3D Reconstructor® will pop up as many
virtual scan dialogs as the segments are, to allow you to do a virtual scan.

· Generate cross sections. This function provides you with a way to create cross sections of your models
along the trajectory. If you select this function, JRC 3D Reconstructor® asks you the spacing between
different cross sections along the trajectory. When the spacing is set, JRC 3D Reconstructor® creates
several planes, with the normal placed along the trajectory and placed according to the spacing
selected. These planes are added to the project and named Flythrough section n(N). It is left to you to
actually select one of these planes and calculate the desired cross section.

You can also convert the flythroughs into polylines by using the Convert to polyline command in the
contextual menu.

Groups
A group is a cluster of items composing the project.
You can create and manage the groups from the contextual menu.

To create a group you only have to open the contextual menu of
a data type folder by right-clicking on it and select the New
group… command.

To populate a group you have:
· to move a selection of items from a previous position (to a new one) with Move command from

the contextual menu of the selection
· to paste the selection of items in the new group, with Paste in group command from the

contextual menu of the new group.

A potential hyperlink is visible in the Property Browser of a group. 
Here is also possible to set a Registration role for all the scans inside the group:

· None
· Same as parent: to set as registration role the same role of a higher level (for example
· Children move together: if a single scan is moved in the 3D space, all the other scans move

together, as a rigid system
These roles are used to make a scans registration through groups.
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You can also create a group made up of different data
type objects. As is seen in the picture at its side this
possibility is useful to put together all the items of a
single sub-project, for example. 

 To move out by a group an object, the Ungroup command from the contextual menu of the object is the
way.

Planes

JRC 3D Reconstructor® allows you to define planes in your project. 
A plane has a width and a height that can be specified in the property editor window under Extent on X and
Extent on Y. A plane has also all the properties of a project entity: Color ID, comment, hyperlink, Draw
annotation, Draw coordinate frame. To enable the last one is particularly useful in order to visualize the
plane's normal direction.

From the contextual menu of a plane item, you can also start the following commands:
· Cross section: use this plane to compute a cross section of the models activated in the scene. The result

is a polyline
· Invert direction: inverts the plane's coordinate frame Z axis direction. The positive direction

determined by the plane has an influence for instance in cross sections, volume and cut and fill
calculations.

· Meshing->Create mesh from a plane: to create a mesh starting from the plane object. Useful for example
for inspection tool. 

· Set costrained draw: to pick points in the 3D scene and draw them as a projection on the plane.

See also Project items and Plane creator/editor.
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Point Clouds

There are two different kinds of point clouds in JRC 3D Reconstructor®: 
· Structured point clouds (also called grid point clouds, or range images, or scans): scan-based clouds,

"fixed-origin" or tripod scans. They include row/column info and the origin scan's position. 
· Unstructured point clouds 

Operations available for both unstructured and grid point clouds are:
· Recompute bounding box: useful sometimes when the bounding box is not updated (available

only if the model is loaded in memory)
· Histogram: the histogram tool allows to optimize the contrast by histogram stretching (available

only if the model is loaded in memory and if the current color type is 1f or 1d, i.e. a high-dynamic
single-channel point color)

· Colors mapping: point colors can be remapped to a pseudo colored scale to improve the
dynamic range, if the histogram stretching is not sufficient (available only if the model is loaded in
memory and if the current color type is 1f or 1d, i.e. a high-dynamic single-channel point color).
This tool can be also used for range segmentation and inspection.

· Inclination from plane: if the Inclination color type is available (the model must be pre-
processed) the dialog allows to select a plane whose normal is projected to the normals of the
model (dot product). The result is added as a 1f color type.

Operations available only for grid point clouds are:
· Edit 2D: edit the grid
· Extract edges: create a polyline from the computed orientation and depth discontinuity during

the pre-processing phase. The polylines are as contiguous as possible, adjust the max search
distance and minimum edge length to optimize the outcome.

· Cross Sections
· Multiresolution Mesh
· Simplify Points:  to determine the most relevant points from a point of view of shape

description, saving them into a new unstructured point cloud. 

The editable properties - for both of them - are:
· Color ID: you can edit the color ID by clicking

on the value field of the color ID property. To
render the items with their color IDs,

select Navigation->Color by ID.
· Draw coordinate frame: if true, draw the local

coordinate frame 
· Point size: size of drawn points
· Subsampling: subsampling rate of rendering

of the cloud of points
· Color mapped: select the color type to render

the point cloud

Advanced Options
A Grid cloud of point can be viewed as “image” where the number of pixels (pix) are equal to the number
of point the scanner has acquired (valid and invalid). 
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Point clouds data storage
Data is stored in an XML description file + pure binary vector files. The file extension of the binary data

specifies the format, where data.NT: N=num of components (1,2,3,4…), T=data type (byte, short, word,

half, float, double).

For point colors, a special 3bc (c stands for compressed dynamic range) file is created for rendering only,

for instance after histogram equalization.

For example, the unstructured point clouds myUnstruct will be saved in the following files in the project

folder:

· Unstructs/myUnstruct.rup, an XML file containing the cloud's properties

· Unstructs/myUnstruct_rup/points.3f

· Unstructs/myUnstruct_rup/status.1i

· Unstructs/myUnstruct_rup/Reflectance.1f

· Unstructs/myUnstruct_rup/Reflectance.3bc

· …

The grid point cloud myGrid will be saved in a similar way in the folder Grids inside the project folder. Grid

point cloud files have extension “.rgp”

Polylines
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Polylines are sets of open or closed polygons that appear in your 3D scene. You can create polylines in
several ways:

· From the points you have collected in the point list window.
· From the cross sections tool (the polylines created by this tool are saved in your project in

the Cross sections group).
· From the command Tools->Meshing->Get mesh borders as polylines, belonging to the contextual

menu of the triangle meshes.
· From the Mesh ridges&valleys tool.
· From the edge extractor of grid point clouds, available via Tools->filtering->extract edges...
·

The most important contextual command for polylines is the Export command, that allows you to export
the polyline in the DXF format, readable by AutoCAD®.
It is often useful to define polylines in order to delimit the region in which you want to calculate volume,
or cut and fill volume. Polylines can be also used to select points or to cut meshes.

Projectors
A projector is a camera view plus an image to project on the scene. It can colorize whatever geometry is
“lighted” by the projector allowing also to see occlusions if shadow mapping is supported.

The specific commands are:
Load projector: to load (light on) the image on the 3D model.
Set projector image: to set the desired image to project
Edit projector image: edit the projector's image to set the transparent pixels in order to produce better
blending among the projectors

The specific editable properties are:
Activate: the image is loaded and projected on the scene

Shadow mapping
This technique works only for triangle meshes. To compute the occlusions from the view point of the
projector, a depth buffer of the scene is created. Unfortunately the accuracy of the shadows depends on
the sampling of this depth buffer, thus its width and height and depth range. Ideally the size should be
infinite, but this cannot fit in the memory so the resolution must be tuned. It's recommended to use at
least the width and height of the projected image and to keep the clip near and far planes as close as
possible to the desired scene depth range. Because of this coarse resolution, the resulting depth buffer is
affected by quantization noise. To compensate for this, an epsilon term is used as a tolerance for the
depth comparisons. For each depth point, the epsilon formula (known as polygon offset) is:
ShadowScale∙Depth + ShadowBias. If some random black points are visible when casting the shadows, try
to increase the scale and bias, but pay attention that excessive values produce less shadows.
Shadow bias: additive term for polygon offset during the depth buffer generation (default is 16)
Shadow scale: multiplicative factor for polygon offset during the depth buffer generation (default is 2.5)
Shadow width/height: size of depth buffer used to compute the occlusions from the view point of the
projector. It's recommended to use at least the same size of the projected image, displayed in the tooltip
of the projector.

Triangle Meshes
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A triangle mesh is a 3D model represented by a set of triangles connected by common edges and
common vertices. If a point cloud includes a set of points, a mesh includes more information because it
stores how the points are connected.
A triangle mesh therefore defines a surface in the 3D space. The mesh's edges that are owned by only
one triangle are called mesh borders. A mesh is called closed if there are no borders. A mesh is
called manifold if all its edges are shared by at most two triangles, and a mesh is called non-manifold if
there are edges that belong to three or more triangles. A mesh is called watertight if it has no holes, or if
its borders are only one closed outer polygon.
To each vertex of the mesh, a color can be associated. Each mesh's triangle is rendered with a gradient of
the three colors of its vertices. The rendering color may depend also on the triangle's inclination with
respect to the light source.
JRC 3D Reconstructor® has various techniques for generating and editing meshes. Each triangle
mesh item can contain more than one submesh.

Actions available from meshes' context menu
· Meshing->Compute normals: computes or updates the triangles' normals for the mesh.
· Meshing->Invert winding: inverts the ordering of the vertexes for each triangle, so the surface is

flipped to the opposite side and also the normals are inverted.
· Meshing->Compute area: r eturns the mesh area as sum of the areas of all the mesh's triangles.
· Meshing->Compute volume from Z=0 plane: returns the volume resulting from integrating the

mesh on the XY plane of the current UCS. Mesh triangles below the XY plane will result in zero
volume.

· Meshing->Get mesh borders as polyline: creates a new polyline containing the mesh's borders,
and adds it to the project. 

· Meshing->Make single mesh: to cluster in a single mesh an arbitrary set of triangle meshes.
· Meshing->Convert to point cloud: create an unstructured point cloud from the vertexes of the

mesh using the color attribute of the mesh.
· Meshing->Mesh editor: opens the mesh editor dialog.
· Photo&Color->Sample texture at vertexes: sample the color of texture (if available) at the

vertexes of the mesh and store as the color attribute of the mesh.
· Photo&Color->Create texture map: compute a blended texture map for the mesh from the

projectors.
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Meshes' editable properties

· Color ID: False color that you can activate with Screen settings -> Color by ID command
· Draw coordinate frame: if true, draw the local coordinate frame
· Point size: if draw geometry is set to points, they are draw with this size
· Draw texture: if available, the texture is loaded and rendered
· Draw light: if the normals are valid, the triangles are rendered with smooth shading
· Cull face: if true, the triangles are rendered only if the normal faces the view direction, and

backface triangles are hidden. If False both sides of the mesh are visible
· Draw geometry: select flat, wireframe (only edges), or only  vertexes (points) to display them

Advanced Options
Triangle meshes data storage
Data is stored in an XML description file + pure binary vector files subdivided in folders for each submesh.
The file extension of the binary data specifies the format, where data.NT: N=num of components
(1,2,3,4…), T=data type (byte, short, word, half, float, double). If a mesh is called myMesh, a typical way of
storing it will use the following files in the project folder:

· Meshes/myMesh.rtm
· Meshes/myMesh_rtm/submesh/vertexes.3f
· Meshes/myMesh_rtm/submesh/triangles.3i
· Meshes/myMesh_rtm/submesh/...
·

See also Meshing techniques and Mesh editing.

Workspaces
A workspace is a particular configuration of JRC 3D Reconstructor®'s interface, aimed at satisfying a
particular workflow.
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Note: the access of each workspace is due to the available licenses.

See here for details.

User Coordinate System (UCS)
User coordinate systems are a central concept in JRC 3D Reconstructor®. In the same project, many
coordinate systems can exist. An empty project contains at least a default UCS, called Main. 

To create a new UCS, you can click on any project item and select Create UCS from this pose. The new UCS
is added to the User Coordinate Systems group in the project window.

The current UCS
The Figures 1, 2 and 3 below show the same scene with three different UCS's set as current. The current
UCS is visible from the long coordinate axes (the red is the X axis, green is the Y, blue is the Z axis).

Figure 1 Figure 2 Figure3

There is always one and only one current UCS. This is the UCS displayed in bold in the User Coordinate
Systems group in the project window. To change the current UCS, right-click on another UCS and select set
as current.
The current UCS is the current coordinate system for all the operations in JRC 3D Reconstructor®.
· Point coordinates in the Readout Window are displayed in the current UCS.
· Model position in the Adjust Pose window is displayed in the current UCS.
· Points in the Point List Window are displayed, imported and exported in the current UCS.
· All project data (point clouds, meshes, polylines, etc.) are imported interpreting their position in the

current UCS, and exported saving their position as in the current UCS.
· The pose matrix shown in the Pose Dialog is referred to the current UCS.
· The navigation system will perform “human” rotation movements assuming that the horizontal plane is

the XY plane of the current UCS (see the option Enable human movements while rotating in Navigation
Options for more information).

· Many JRC 3D Reconstructor® functions require a vertical direction and altitudes to be defined in your
3D scene. Cut and fill calculation is an example of these functions. The general assumption in JRC 3D
Reconstructor® is that the current UCS's Z axis defines the vertical direction, and the altitudes are the
distances of project items from the Z=0 plane of the current UCS.
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· The Create/Edit Plane command allows to make a plane horizontal or vertical. Horizontal and Vertical
directions, again, are always defined by the current UCS.

· Etc.

Therefore, if the user changes the current UCS, all the above-mentioned windows and functions will be
affected in the way they visualize the coordinates or compute the models' positions.

UCS can be also created from the registration between two point lists.

Create UCS from this pose
The contextual command Create UCS from this pose allows to create a new reference system – UCS
according to any item in the project.

It could be useful to create an UCS according to an object in order to help a particular visualization.

Here an example.
Use a vertical plane fitting a wall to create a point of view (and so an orthocamera, e.g.) in front of the
façade:

o define the plane 
o in the plane's contextual menu click on Create UCS from this pose: a new UCS is created and

stored in the folder User Coordinate Systems. 
o to set the new UCS as current,  select the new UCS and Set as current (the current UCS appears in

bold).
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